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Résumé

Le but de ce travail est de calculer les charges aérodynamiques dans les deux cas
statique et rotatif d’'une hélice par l'utilisation de plusieurs logiciels de CFD (ANSYS ICEM CFD
13, ANSYS CFX 13 ANSYS Fluent 13 ) et TecPlot avec Matlab . A partir de ces charges plus les
charges d’inertie, on a déterminé les charges structurales par l'utilisation des logiciels de la
CSM (MD Patran 2010 et MD Nastran 2010).

Mots-Clés : Aérodynamique d’hélice, Simulation et modélisation numérique, Mécanique des
fluides numérique, Mécanique des structures numérique, Maillage mobile, Analyse structurale,
CAO, CFD, CSM.

Abstract

The purpose of this work is to calculate the aerodynamic loads in the both: static and
rotating cases of an aircraft propeller, using a multiple CFD softwares (ANSYS CFD 13, ANSYS
CFX 13 and ANSYS Fluent 13), TecPlot and Matlab, based on these loads and by the add of the
inertial loads acting on each case we were determined the structural loads using some CSM
softwares (MD Patran 2010 and MD Nastran 2010).

Key Words: Propeller aerodynamics, Numerical modeling, Structural analysis, Moving mesh,
CAD, Computational Fluid Dynamics CFD, Computational Structural Mechanics CSM.
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A force de croire en ses réves,
I’'Homme en fait une réalité.

Georges Rémi



Introduction

L’hélice aérienne est le mode propulsion qui a accompagné le développement de
I'aéronautique des sa naissance. Aujourd’hui encore, bien que concurrencée par d’autres
concepts, elle est largement utilisée sur les avions évoluant a des vitesses subsoniques.
L’hélice est aujourd’hui un équipement toujours moderne, qui profite des dernieres
avancées technologiques réalisées dans de nombreuses disciplines.

Le procédé de conception de I'’hélice commence par un compromis entre
I'aérodynamique et l'efficacité structurale. La forme aérodynamique choisie donne
naissance a des charges qui sont intégrées dans le procédé de conception structurale ;
tout probleme identifié a ce stade peut alors étre utilisé pour modifier la forme et
recalculer la performance aérodynamique.

Dans notre travail nous avons fait une étude aérodynamique et structurale d’une
hélice aérienne, dans le cas statique mis en mouvement d’air relatif (freinage d’hélice) et
dans le cas rotatif par l'utilisation des techniques de maillage mobiles en phase de
simulation.

Vu qu’on ne dispose pas d'une vraie géométrie d’hélice on a opté a concevoir une
fictive avec un logiciel de la CAO SolidWorks 2010, puis on a maillé notre géométrie
correspondante aux deux cas test (statique, rotatif) avec le générateur de maillage
ANSYS ICEM CFD 13 pour la simuler numériquement par les codes de calcul ANSYS CFX
13 et ANSYS FLUENT 13 qui sont basés sur la méthode des volumes finis. A partie des
résultats de simulation et a 'aide du logiciel TecPlot 360 et d'un programme fait en
MATLAB on a déterminé les charges aérodynamiques sur une pale d’hélice, ensuite par
I'addition des charges d’inerties, on a fait I'étude structurale pour déterminer les
contraintes, les déformations, ainsi que les déplacements le long de la pale a I'aide des
codes de calcul des structures MD Nastran 2010 et MD Patran 2010 Student Editions,
qui sont basés sur la méthode des éléments finis.



Introduction

Le travail présenté est subdivisé en cinq chapitres :

Chapitre I: Est une généralité sur les hélices de l'aérodynamique a la conception
mécanique.

Chapitre II : Est consacré pour définir les différents modeles mathématiques utilisés dans
les codes de calcul CFD et CSM.

Chapitre III : On a prouvé qu’on peut compter sur les codes de calculs utilisés dans notre
travail.

Chapitre IV : Concerne la détermination des charges aérodynamiques dans le cas statique
et rotatif de I’hélice a partir de la CFD.

Chapitre V: Pour la détermination des charges structurales dans les deux cas test de
I'hélice.

Ce travail s’achéve par une conclusion générale.
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Chapitre -I-

L’hélice - de I'aérodynamique
a la conception mécanique

Dans ce chapitre seront exposés des généralités sur les hélices aériennes,
les problemes essentiels que doit maitriser I'hélicier, afin de concevoir le
meilleur produit. Bien que non exhaustif, il permettra également a tout non-
spécialiste de disposer d’une vue synthétique de la démarche qui conduit a la
réalisation d’un tel équipement.

Les sujets abordés concernent aussi bien les performances
aérodynamiques que les méthodes de calcul, le dimensionnement structural ou
les différentes technologies de construction.

Bien que détaillée pour les hélices aériennes de forte puissance,
I'approche ici présentée peut aussi bien s’appliquer a des produits voisins tels
que les éoliennes, les hélices marines ou les ventilateurs par exemple.



Chapitre I L’hélice - de I'aérodynamique a la conception mécanique

1.1 Evolution technologique

L’hélice a toujours profité des progres technologiques engendrés par l'essor de
I'aéronautique ; elle a, en particulier, continuellement adopté les meilleurs matériaux
proposés du moment : d’abord le bois, puis le métal (acier mécanosoudé, alliage
d’aluminium massif) et, enfin, les matériaux composites (I’hélice est, de ce point de vue,
I'une des rares applications qui utilise ces matériaux pour des équipements
structuralement vitaux pour l'avion).

Concernant I’évolution des technologies relatives au moyeu, on peut noter que celui-
ci a d’abord été inexistant (I'hélice, monobloc, étant directement fixée sur I'arbre moteur)
ou n’a assuré qu’'une fonction d’encastrement pour les pales ; par la suite, un changement
de pas pneumatique a deux positions (ne pouvant étre actionné qu'une fois en vol) fut
inventé. Ce principe, consistant a changer le calage des pales au cours du vol, a ensuite été
repris par tous les dispositifs de régulation jusqu'a aujourd’hui. Seules les différentes
sources de puissance impliquées dans cette fonction ont évolué : d’abord pneumatique,
puis hydromécanique ou mécanique seule (régulateur de Watt avec des masselottes et des
ressorts de rappel).

L’hélice simple a également été reprise pour imaginer d’autres concepts parmi
lesquels on peut citer : I'hélice carénée, les hélices contrarotatives, ’hélice propulsive (alors
que le cas le plus courant est I'hélice tractive).

1.2 Définitions et principe de fonctionnement

I.2.1 Notion de rendement propulsif

L’objectif, pour une hélice, consiste a créer une force propulsive par variation de la
quantité de mouvement de I'air qui la traverse (avec le meilleur rendement possible) et a la
transmettre a la structure de I'avion. Il faut analyser la définition du rendement propulsif
(différent du rendement d’hélice défini ultérieurement) pour mettre en relief I'intérét de
I’hélice (figure I.1, associée a la théorie de Froude).
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Disque hélice
(de surface S),
Vv de régime
| .0 Po
\ Veine de flux
| 20
—
v
0 Vy+dv, =V, Vo +dv, =V,
Po P | P Py =Py
L~ |
E—
VO

Figure 1.1 - Théorie de Froude.

Considérons que l'avion évolue a la vitesse Vp. Le débit massique d’air D qui traverse
le disque hélice est accéléré a la vitesse Vz en arriére de celui-ci. La force propulsive vaut,
par application du théoréme de la quantité de mouvement :

D (V, — Vo) (1.1)
et la puissance propulsive :

Pp=VyD (V, —Vy) (I.2)

La puissance fournie au fluide vaut (théoréme de I'énergie cinétique) :
1 2 2
Pf=ED(V2_V0) (I.3)

Le rendement propulsif est donc égal a :
n="Pp/Pr=2Vy/ (Vo + V) (1.4)
Avec V2> V.

Celui-ci sera d’autant meilleur que V: sera proche de Vp. Ainsi, pour une traction
requise, devant compenser la trainée de 'avion, on cherchera a peu accélérer un grand
volume d’air si un avion évolue a faible vitesse (et inversement, on cherchera a beaucoup
accélérer un petit volume pour un avion a grande vitesse, d’ou 'essor des turboréacteurs).
Du seul point de vue du rendement propulsif, 'hélice est donc meilleure aux basses
vitesses.
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1.2.2 Définition d’'une hélice et d’'un profil

L’hélice est un ensemble de pales montées sur leur moyeu, lui méme étant confiné
dans un capot appelé « casserole » (figure 1.2).

L’axe de rotation étant OX, on choisit alors une des pales comme axe O0Y
(généralement confondu avec 'axe de changement de pas de celle-ci, figure 1.2) ; L’axe OZ
compléte le triedre. On appelle « profil » toute section de pale réalisée dans un plan normal
a I'axe de pale OY (figures L2 et I.3) : celui-ci est défini par sa corde, son épaisseur
maximale, sa cambrure et son calage (angle mesuré dans le plan XOZ, entre la corde et |'axe
0Z, figure 1.5a).

Généralement, la position angulaire d’un profil est donnée par rapport a la corde
d’un profil de référence (souvent choisi a 0,7R ou 0,75R : cet angle est appelé le vrillage),
lui-méme tant calé par rapport a I'axe OZ. Par extension, lorsque l'on parle du calage d'une
pale, il agit du calage du profil de référence souvent noté f#3/4 ou B 75 % (figure 1.6a).

Une fois les diametres d’hélice et du capot choisis, la pale est entierement définie
lorsqu’ont déterminées la famille des profils, les évolutions de corde, d’épaisseur, de
cambrure, de vrillage, de déport (décalage des profils hors du plan de rotation passant par
I'axe de rangement de pas et de fleche des profils en envergure.

On parle d’hélice « a droite », lorsqu'un observateur, situé en arriére et sur 'axe de
celle-ci, la voit tourner dans le sens anti trigonométrique (et une hélice a gauche dans le
sens trigonométrique, dans les mémes conditions).

1.2.3 Différents types d’hélice

- Hélice a pas fixe : si le pas géométrique est constant tout le long de la pale.

- Hélice a pas variable : si le pas géométrique varie tout le long de la pale (variation
possible qu’au moment de la construction).

- Hélice a calage fixe : si le calage f ne peut étre modifié par rapport au moyeu.

- Hélice a calage réglable : si le calage f peut étre modifié au sol.

- Hélice a calage variable : si le calage 8 peut étre modifié en vol.

1.2.4 Caractéristiques géométriques et vocabulaire

Une hélice peut étre caractérisée par quelques grandeurs dont les plus courantes
sont (en posant &= r/R) définies ci-apres.
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Y i Trajectoire d'un point de la pale
Envergure totale R
Neécessité du vrillage
Profil 1 Opposé de |la vitesse
. d'avancement
) Profil 2 de 'avion, —Vo
R|= ™. AT Combinaison des |
™~ z | | v vitesses relatives |
o [ | t'\ par rapport au profil 2 |
| | |
i Pelo SO || N2 |
X ‘ |
Capotou-"| | o
casserole | | ‘ a
\ ‘ Vitesse tangentielle
"-\ L/ _ derotation
LY du profil 2, v,, = er
‘ Combinaison des
Axe de vitesses relatives
changement d” par rapport au profil 1
de pas Vitesse tangentielle de rotation
du profil 1, Viq = r1£2
Figure 1.2 - Notions géométriques d’une hélice.
Epaisseur Extrados Ligne de cambrure
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du profil d’épaisseur)
o — e T e — - .
75:;:_?'_1'_'—'—'—'—'—'—_;-,_<
Bord Bord
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Foyer aérodynamique
(généralement situé au quart avant de la corde)
Corde
Figure 1.3 - Grandeurs caractéristiques d’un profil.
Cz i CxetCmi
> 2
1,5 —0
rmmm— X !
——Cm 1 ~-0,02
05 ~-0,04
-25 -20-15 —W 5 10 15120 25
[ D L/ L 006
/ incidence a
Czo, non nul —-0,08
si le profil
est cambré —=0,1
—-0,12

Figure 1.4 - Polaires types d’un profil aérodynamique.
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calage

Pas géométrique

p

@ pas geometrique d’un profil situé a I'envergure r

(b) facteurs d’activité de pales différents pour deux hélices
ayant la méme solidité

Figure 1.5 - Caractéristiques géométriques d’'une hélice : pas, calage
et facteur d’activité.

Calage du profil de référence
(aussi appelé calage de la pale) | . ___. > — i

Profil de référence

Corde du profil
de référence
X 40,75 R

Profil de : o |
référence Vrillage du profil A |

situe a 0,75 R

— Profil A R
quelconque

- Corde du profil A

Profil A

Figure 1.6 - Caractéristique géométrique d’une hélice : Vrillage.

Fleche de

/Lieu des milieux
des cordes

Pale en fleche Pale droite

Figure 1.7 - Caractéristiques géométriques d’'une hélice : Fleche.
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= Envergure (figure 1.2)

Position radiale rle long de la pale, mesurée par rapport a '’axe de rotation. L’envergure
totale de la pale vaut R.

= (Calage d'un profil g (figure 1.5a)
Angle, mesuré dans le plan XOZ, entre la corde et 'axe OZ.
= Pas d’un profil et pas de I'hélice (figure I.5a)

Pour un profil aérodynamique placé au rayon r et calé a un angle B par rapport a I'axe
0Z, le pas du profil est la projection sur I'axe OX de la longueur curviligne de I'hélice d’angle
B portée par le cylindre de rayon r, lorsque I'angle polaire parcourt 2m. Le pas du profil de
référence (0,75R) est aussi appelé « pas de I'hélice ».

= Vrillage

C’est le décalage angulaire relatif en envergure des cordes des profils. Il permet a tous
les profils d’avoir une incidence optimisée par rapport a I'écoulement (figures 1.6, 1.2 et
1.10).

= Fléche

Pour une pale, c’est I'écart entre la courbe des milieux des cordes avec la droite qui
passe par le milieu de la corde du pied (figure L1.7).

=  Solidité
Elle s’exprime par la formule :

1

L[ L©a (1.5)

TR? Jp R
et mesure la proportion du disque hélice de diameétre 2R occupée par les pales.

= Facteur d’activité d’'une pale

1©

1
FA - (100000/16) l

] &’ 8¢ (1.6)

Il indique si les cordes les plus importantes de la pale sont plutét en pied (facteur
d’activité faible) ou en extrémité (facteur d’activite élevé) (figure L.5b).
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1.2.5 Coefficients de similitude
Les coefficients de similitude permettent de comparer simplement le comportement
d’hélices de tailles différentes mais géométriquement semblables (deux hélices semblables

fonctionnent aux mémes parametres de similitude) ; ceux-ci sont au nombre de quatre :

— le parametre d’avancement :

" L7
— le parametre de traction produite :
T
© = ovienr] (8)
— le parametre de puissance fournie par la motorisation :
= P 1.9
* = VIR ] (:9)
— le rendement de I'hélice :
p==x (1.10)

1.3 Aérodynamique des hélices
I.3.1 Classification des méthodes de calcul

Les différentes méthodes sont comparées dans le tableau I.1.

Selon le type de résultat recherché (qui dépend du niveau d’avancement d’un projet
industriel de développement d’hélice), on utilisera successivement plusieurs méthodes de
calcul :

— en phase de début de projet, on utilisera des méthodes simples et rapides qui
donneront les performances globales de 'hélice et permettront de choisir sa géométrie
(méthode des singularités) ;

— en phase avancée de conception, on utilisera des méthodes plus lourdes d’utilisation
pour caractériser dans le détail le comportement de I'hélice choisie, dans son

environnement (Euler ou Navier-Stokes).

Dans la suite de ce paragraphe sera brievement exposé I'ensemble des différentes
méthodes de calcul existantes. Une attention particuliere sera portée sur les méthodes
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simplifiées (Froude, Glauert et élément de pale), la méthode de la ligne portante et la
méthode basée sur les équations d’Euler.

1.3.2 Théorie monodimensionnelle (Froude)

Cette théorie considere que I'hélice est un disque de discontinuité de pression au
sein de I'’écoulement qui le traverse librement (mais il y a continuité de vitesse) ; les
vitesses sont axiales uniquement et le fluide est supposé parfait et incompressible (cf.
figure I.1).

La traction vaut:

dU1
T = pSVO <1+T> dvz (111)
0

Avec:dv; =2 dvq

Et la puissance fournie au fluide vaut :
1
5P S (Vo +dv)[(2V¢ + dv,)dv, ] (1.12)

On retrouve le rendement propulsif :

n=1/ (1;—‘;2”2) (1.13)

Cette théorie peut étre appliquée a chaque volume annulaire situé entre deux
rayons du disque hélice ; on montre alors que le rendement optimal est atteint pour dv:/Vp
= Cte, sur tout le disque.

1.3.3 Théorie de I'’écoulement moyen (Glauert)

Cette théorie reprend I'’hypothése du fluide parfait et incompressible mais considere
I'existence de vitesses axiales en amont du disque, axiales et tangentielles en aval. Le fluide
reste irrotationnel en dehors de la veine de flux qui traverse le disque hélice (figure 1.8). Le
disque hélice est une discontinuité de pression et de vitesse tangentielle. Cette théorie
considere I'hélice comme un disque infiniment mince a nombre infini de pales. L’ordre de
grandeur des vitesses induites moyennes peut étre respectivement de Vo pour dvz et 0,5Vp
pour la vitesse induite tangentielle. La figure 1.8 reprend quelques éléments théoriques. La
démarche suivie pour ce type de calcul est la suivante.
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Temps de calcul
Méthode Temps de numérique sur Domaine
modélisation station de d’application
travail
Froude ou | Quelques minutes | Quelques Performances globales
Glauert et secondes de I'hélice.
méthode des
singularités
Phénomenes liés a la
Euler Plusieurs jours Quelques heures | compressibilité et
études locales.
Etude d’installation sur
avion
Plusieurs dizaines | Idem Euler,avec
Navier- Plusieurs jours d’heures si calcul | phénomeénes liés a la
Stokes non parallele viscosité.

Calcul en instationnaire

Tableau I.1- Comparaison entre les différentes méthodes de calcul.

Disque hélice
Vv de régime Q
| 0 Po
\ Veine de flux vV
0
N |
d’% —— V +dv,
o | Vo o [pr Vordvi=Y+aVy 1py=p
1 1 t_2m
wy = cu]' =2a'Q Wy = 1
L —
_/ VO
—
VO

Figure 1.8 - Théorie de Glauert.

I.3.3.1 Théorie de Glauert

r
R )

_ dv1

= ) "= w} (20
aVO a = w; (2Q)

Soit & =

Dans un repere relatif 1lié a 'hélice, on montre que la conservation de la pression
d’arrét relative conduit a expliquer l'accroissement de pression pj — p7 par la déviation
tangentielle wj . Dans le cas particulier des hélices peu chargées (cas général pour
I'optimisation en croisiére), on obtient les expressions suivantes pour un volume

élémentaire délimité par deux surfaces de courant :
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dt=ny?a(1+a)édé = 3 (1- a)d & dé (I.14)
dx=mdy=(1+a)a &£3d¢ (I1.15)

Le rendement local vaut alors :

(. 16)

1.3.3.2 Recherche de I'optimum

Pour les hélices peu chargées, la condition d’optimum est obtenue lorsque
(€) = Cte pour tout & On montre également que chaque profil doit travailler au voisinage de
sa finesse maximale (finesse = Cz/Cx). La recherche de a et de a’ se fait par un processus
itératif en minimisant les pertes de puissance :

d(Pert) = QdQ -VodT = 4mp Q2 Vyd'(a+a)r3dr (1.17)

Avec dQ et dT respectivement le couple résistant et la traction résultants sur
I'anneau élémentaire situé au rayon r du disque que hélice.

Tube compris entre ret r+dr

r+dr

Elément de pale compris entre ret r+dr

Figure 1.9 - Méthode de I'élément de pale (ou méthode des anneaux).

On applique un calcul basé sur I'approche monodimensionnelle de Froude ou la
théorie moyennée de Glauert sur I'’élément de pale et le tube compris entre r et r + dr pour
déterminer les vitesses induites (et ce indépendamment du reste des pales et du sillage).
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I.3.4 Méthode de I'élément de pale

Contrairement a la méthode de la ligne portante décrite dans la suite, on considére,

par cette approche, que le champ de vitesses au niveau de chaque profil ne dépend que de
ce dernier (figure 1.9). On calcule les vitesses locales et les efforts correspondants (figure
1.10) en utilisant 'une des deux théories de Prandtl ou de Glauert par itérations selon la
méthode suivante.

Et

Et

Avec

dfz = % CzLp[(rQ-u)?+ [Vy+v)?]dr (1.18)
dfx = % CxLp[(rQ-uw)?+Vy+v)?]dr (1.19)
dT =dfzcos(f - a) - dfx sin(fB - a) (1.20)
dC =[dfx cos(B-a)- dfz sin(B-a)]r (I.21)

Cz et Cx dépendant de @, du nombre de Mach et de la nature du profil,
p étant la masse volumique de I'air.

Le profil est al’envergure r de ’axe de rotation.

de portance i I
et de trainée ! 0 .
~au couple \ . ! gg?;e |
résistant dC \ Calage du | vitesse |
(par projection | profil B | z avion !
de dfz et dfx) \ I Yo
| _
Foyer } rQ ° I
dix Ne .y e
Bord de fai Contribution de la trainée o
ord de fuite de profil a la trainée d’hélice Composition des vitesses
(par projection de dfx) locales de rotation

Vitesse relative d’attaque
du profil W

Contribution de la portance Vitesses induites

alatractiondT
- /(par projectiondedfz) . | [TTTTTTTOTTTTTTT !

Y, Incidence
| 90° Bord dattaque \locale

Contribution
des efforts

Corde du profil L et d'avancement

Figure 1.10 - Vitesses relatives et efforts locaux sur un profil.
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1.3.5 Théories tourbillonnaires ou des singularités
1.3.5.1 Méthode de la ligne portante

On considere dans cette approche que chaque pale se réduit a une ligne de
tourbillon (appelé tourbillon lié) d’intensité I' variable en envergure d’ou s’échappe une
nappe tourbillonnaire (laniére de tourbillons libres) qui constitue le sillage (figure 1.11).
L’intensité de chaque laniere qui s’échappe du tourbillon lié est égale a la variation
d’intensité de ce dernier au point d’échappement. Par analogie avec I'électromagnétisme,
on considere que la vitesse induite (figure .10) en tout point M de I'espace par un morceau
de tourbillon, situé en I, de longueur d# et d’intensité drI’, vaut (figure 1.12) (Biot et Savart) :

dv = ~(dr/(4m)) (M a(@0)/||M]|") (1.22)

Cela est, en particulier, vrai en tout point M situé sur la pale. On évalue ainsi la
vitesse induite en tout point du profil de la pale par intégration de chaque contribution
élémentaire apportée par toutes les pales et tout le sillage. La vitesse induite se décompose
alors en une composante axiale v et une composante tangentielle u qui met le sillage en
rotation (figure 1.10).

Dans la pratique, on considere que chaque profil aérodynamique travaille dans un
écoulement localement plan ; I'intensité locale du tourbillon lié vaut :

r=-CzLW (1.23)

Avec: Cz  coefficient de portance,
L corde du profil,
W  vitesse relative locale d’attaque du profil.

Pour une hélice non carénée, I' est nulle en extrémité et au pied de la pale. La
procédure de calcul stabilise d’abord le champ des vitesses de facon itérative (figure 1.13),
puis évalue la puissance et la traction par intégration le long de la pale des efforts locaux
(figure 1.10).

Pour le calcul automatique, on discrétise généralement la pale en un nombre de
profils judicieusement choisis (par exemple, 10 rayon appelés « points de Gauss ».
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Tourbillon

Hé,SuNant L Smage
la lighe du quart L.al |
avant de la pale | 5] Zone de

|
I
(lieu des foyers ﬁl i ﬁ:_e_ tourbillons
|
I
r ‘
|

aérodynamiques) 'oqr libres
R
> L
'm Pale—¢ | 1 |
|
L P
Roi

Tourbillons libres
s'échappant de la pale
entre les rayons de Gauss

Figure .11 - Modélisation d’une pale et de son sillage par une
nappe tourbillonnaire.

Contraction du sillage

Rio

X

/

/

\ !
f
|
|

Longueur de contraction,
environ égale au diameétre de |"hélice

Figure 1.12 - Sillage tourbillonnaire.
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| u=v=_0 Initialisation

et de I'incidence

¢ =arctan [(Vy+ /( Qr-ul;a=p-¢ | Calcul du calage

Cz=Cz (cx) s Cx=Cx (x) Calcul de la vitesse locale
W=(Qr-uw? + (Vy+ )12

relative et des coefficients
aérodynamiques

I'=LCzW/2 Calcul de la circulation
u=ul(l) , V=V (r) et des vitesses induites
(Biot et Savart)

Variation des vitesses
| Erreur =% (u - Ui)l' Qr+ % (v- V,J/VO induites par rapport
au pas antérieur

Non .
Nouveaux u et v }—-— Erreur < valeur fixée ?

Qui

Calculs des caractéristiques de I'hélice
(rendement, traction, puissance...)

Figure 1.13 - Organigramme type pour le calcul des vitesses induites stabilisées.

Remarques

Les modeles les plus simples considérent que chaque lanieére tourbillonnaire est
portée par un cylindre de diametre constant (correspondant au rayon d’échappement de la
laniére) ; pour plus de précision, on peut considérer que le tube de la veine de flux se
contracte légerement au niveau du disque (sur une longueur environ égale a une fois le
diametre d’hélice, en aval du disque, figure 1.12) ; dans une premiere approche, on peut
considérer une contraction totale de 'ordre de 15 %, en aval, en phase de décollage et de 2
a 4 % en croisiere. Enfin, si les caractéristiques aérodynamiques des profils sont bien
connues, on peut attendre de cette méthode des résultats tout a fait satisfaisants pour la
majorité des applications classiques (erreur de prédiction de I'ordre de 1 %).

Les limites de cette méthode résident dans le fait qu’elle réduit tout profil en son
foyer ; on ne peut donc pas observer le comportement du fluide localement a la surface.
Aussi, la description des phénomeénes transsoniques n’est pas adaptée a cette méthode
(blocage sonique en pied de pale...). Bien qu’étant particulierement adaptée aux calculs
dans le domaine incompressible, elle peut toutefois prendre en compte la compressibilité
par le biais des fichiers de polaires mesurées des profils, jusqu’au nombre de Mach égal 0,9
environ (courbes représentant €z, Cx ou Cm en fonction de l'incidence : cf. figure 1.4).
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1.3.5.2 Méthode de la surface portante

Cette méthode reprend 'approche précédente mais modélise la pale par une grille
de singularités au lieu d'une simple ligne tourbillonnaire : la pale est représentée par une
distribution de sources (effet d’épaisseur) et de doublets (effets de cambrure), tandis que le
sillage ne comporte que des doublets. Cela permet de décrire, en fonction de la finesse des
mailles, 1'écoulement le long des profils et remédie donc partiellement aux limites
imposées par la ligne portante. Par contre, les pertes de trainée de profil ne sont pas prises
en compte dans les calculs.

1.3.6 Théorie du potentiel
1.3.6.1 Potentiel complet

Cette théorie est issue des développements plus complexes que sont les théories de
Navier-Stokes et d’Euler. Par rapport a ce dernier, sont faites les hypotheéses que
I’écoulement est irrotationnel, permanent et isoénergétique (pas de choc). Dans ces
conditions, la vitesse de I'’écoulement dépend d’'un potentiel des vitesses.
1.3.6.2 Potentiel de perturbation

Cette méthode de calcul reprend la démarche de la précédente, tout en considérant
le fluide comme incompressible. Les pertes de trainée de profil ne sont pas prises en
compte.

1.3.7 Equations d’Euler en repére relatif

Pour I'écriture de ces équations, on considere que le comportement d'une particule
fluide qui évolue le long d'une ligne de courant obéit aux trois équations suivantes :

— I'équation de continuité qui traduit la conservation de la masse ;

— I’équation du mouvement ;
— I'équation de I'énergie (on néglige I'accélération due a la pesanteur).
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lI ‘I f/ !
f // : !
PR i N , A
{ = ; N

1" |
N RN N ’ N
/ /-—- AR \ L,
I _

Sens des nombres Sens des nombres
de Mach croissants de Mach croissants
Plage de Mach a la surface Lignes d‘isoMach sur le cylindre
extrados d'une pale développé de rayon r

Figure 1.14 - Résultats types fournis par un calcul 3D d’Euler.

Equations d’Euler en repére relatif (a I’hélice), a 'envergure r
6/48t est le symbole de la dérivée partielle par rapport au temps dans un repere relatif.

Equation de continuité :

Sp/5t +div(pW) =0 (1. 24)
Equation du mouvement :
SW /st +grad (W2/2) = Wa(rot W +20) + Q*#-grad p/p (1.25)
Equation de I'énergie :
1 —
5 W/t -dt + W dt grad (h+W?/2-0%72/2) =0 (1.26)

en écoulement adiabatique
avec

h enthalpie,

P pression statique,

t temps.

Pour la résolution de ces équations, les conditions aux limites doivent étre précisées
telles que le glissement relatif sur la casserole, la vitesse amont axiale et uniforme.
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Dans le cas particulier de la méthode d’Euler, on suppose que le fluide est non
visqueux (pas de frottement). Les méthodes de calcul basées sur cette approche
permettent d’analyser I'écoulement en tout point de la pale et du volume environnant
(obtention des nombres de Mach, pressions et vitesse locaux) et de caractériser les
phénomenes liés a la compressibilité du fluide (figure 1.14). Il n’est, par contre, pas possible
de décrire le comportement visqueux du fluide a la paroi ; il faut alors coupler le calcul avec
un calcul de couche limite si 'on veut obtenir une meilleure estimation des performances
globales de I'hélice que par une méthode du type ligne portante.

1.3.8 Théorie des fluides réels (Navier-Stokes)

Cette théorie reprend les mémes conditions de base qui ont servi pour les équations
d’Euler, mais I'hypothese du fluide non visqueux n’est pas conservée. L’équation d’état du
fluide est alors introduite, en complément des équations générales. Lorsque les moyens de
calculs numériques le permettent, c’est sans aucun doute la théorie qui décrit le mieux les
écoulements puisque aucune hypothese simplificatrice n’est faite (elle nécessite toutefois
d’étre alimentée par différents modeles de turbulences). Ce type de calcul permet
notamment d’aborder la résolution des phénomenes instationnaires (disque hélice en
incidence par rapport a la vitesse avion, passage d’une pale devant une aile...).

1.3.9 Démarches pratiques
I.3.9.1 Cahier des charges

Généralement, c’est l'avionneur qui fixe le nombre d’hélices (imposé par
'architecture de l'avion, les considérations de sécurité en vol...) et le diamétre maximal de
celles-ci (imposé par la garde au sol et la distance de la nacelle qui supporte le moteur au
fuselage).

Il indique également la traction ou le rendement qu’il désire (au décollage, en
montée et en croisiere), le niveau acoustique maximal a garantir, I'inertie polaire et la
masse maximale de I'hélice. L’hélicier propose alors le nombre de pales et le régime de
I'hélice optimaux (le régime est parfois imposé par le motoriste), puis réalise I'étude de
détails.

1.3.9.2 Recherche du compromis optimal

Pour les hélices classiques, on a presque toujours intérét a choisir le diametre
maximal admissible, le plus grand nombre de pales possible (attention toutefois a la masse,
aux blocages soniques en pieds et a la possibilité de passer en calage négatif sans
interférence des pales entre elles) et a augmenter la vitesse périphérique des pales jusqu’a
un nombre de Mach voisin de 0,93 (pour les prop-fans (ou hélices rapides), les vitesses
peuvent étre voisines de Mach 1,3 ; des ondes de chocs apparaissent et il faut utiliser des
profils spécifiques). Au-dela, on dépasse trop fortement le nombre de Mach de divergence
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de trainée des profils (au voisinage de Mach 1, la trainée due aux ondes de choc s’accroit
subitement) et les émissions acoustiques sont fortement amplifiées. Pour chaque nombre
de pale choisi et en association avec une famille de profils donnée, on fera varier les
facteurs d’activité et le coefficient de cambrure intégré de facon a répondre a toutes les
exigences imposées (masse, niveau de bruit, performances aérodynamiques, marge vis-a-
vis du flottement structural). On peut construire des tables d’évolutions paramétriques
pour rechercher plus rapidement la configuration optimale.

I.3.9.3 Calcul direct

L’allure générale « dévrillée » de la pale étant alors connue, I'optimisation plus fine
sera réalisée (débouchant sur les lois de corde, d’épaisseur, de cambrure, de fleche, de
déport et de vrillage). C'est pour ce stade de la conception que I'on utilisera des méthodes
de calculs aérodynamiques dérivées de la théorie tourbillonnaire (aboutissant a la forme
de la pale). Depuis plusieurs années, des calculs utilisant la théorie d’Euler (parfois couplés
avec un calcul de couche limite) ou de Navier-Stokes vérifient ensuite que les phénomenes
liés a la compressibilité (ondes de chocs, blocage sonique en pied de pale) et a la viscosité
du fluide ne pénalisent pas les performances précédemment estimées.

1.3.9.4 Quelques ordres de grandeurs

Les rendements u des hélices sont voisins de 72 % a la vitesse de décollage et de 90
% en croisiere. Les pertes de rendement, pour une hélice classique, sont dues pour moitié
au souffle (vitesse induite tangentielle), tandis que les trainées de frottement et d’'onde
(chocs soniques) contribuent pour 'autre moitié a égalité.

Au point fixe (I'avion est a l'arrét prét a décoller, le moteur donnant sa pleine
puissance), on obtient une valeur approximative de la traction développée par I'hélice (en
Ibs) en multipliant la puissance maximale du moteur (en shp) par deux.

Exemple : si la puissance vaut 2 000 shp, on peut s’attendre a une traction de I'ordre de 4
000 lbs.

Nota: 1 lbs (pound force) = 4,45 N
1 shp (shaft horse power) = 747,7 W

Pour les hélices de forte puissance (au-dela de 1 500 shp), on peut considérer une
charge au disque de l'ordre de 50 shp/m2/pale (on parle ainsi d’hélice plus ou moins
chargée ou de charge au disque). Cette charge au disque peut étre également exprimée par
la valeur de proche de 0,02 pour une hélice tres peu chargée, 0,3 pour une hélice
moyennement chargée (commuter), voire 1,5 a 2 pour une hélice treés chargée d'un prop-
fan.
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Pour les pales, le vrillage total est souvent voisin de 25° (entre le pied et la téte);
quant a I'épaisseur relative des profils (épaisseur maximale d'un profil divisée par sa
corde), celle-ci varie de 20 % en pied (pour des raisons essentiellement structurales) a 4 %
en extrémité de pale.

La masse de toutes les pales (en matériaux composites) peut représenter environ 50
a 60 % de la masse totale de I'hélice.

1.3.10 Perspectives

Les récents progres des matériels informatiques, des connaissances et des
algorithmes (calcul avec processeurs paralleles) permettront a terme de prédire
directement les performances de I'hélice installée sur l'avion, ainsi que les influences
réciproques cellule/nacelle/hélice. Ces dernieres sont particulierement intéressantes pour
I'estimation des charges cycliques imposées a I'hélice.

L’objectif recherché, par 'amélioration des moyens de simulation, réside dans la
réduction des colits de développement nécessitant de nombreux essais onéreux (essais en
soufflerie ou en vol) et parfois dangereux (essais en vol, en dehors de I'enveloppe usuelle
d’utilisation).

1.4 Conception mécanique
1.4.1 Efforts extérieurs stationnaires sur la pale
En régime stationnaire (avion en palier a vitesse constante, axe de rotation d’hélice
parallele a la vitesse de 'avion, régime de I'hélice constant et écoulement non perturbé par
'avion), une pale est soumise a des efforts indépendants du temps (figure 1.15) qui sont :
— l'effort centrifuge ;

— les efforts aérodynamiques ;
— un couple autour de son axe de variation de pas.
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___ O Effort de torsion
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Contribution a I'effort centrifuge
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Figure 1.15 - Orientation des efforts.

1.4.1.1 Effort centrifuge

Celui-ci dépend directement bien slir de la masse, du régime de rotation et de la
position en envergure du centre de gravité de la pale. Dans la pratique, on déporte la pale,
donc son centre de gravité, du plan de rotation qui contient I'axe de variation de pas pour
que le moment de rappel centrifuge (qui a tendance a ramener le centre de gravité sur ce
plan) compense et annule le moment de flexion engendré par les efforts aérodynamiques
(figure 1.16) ; pour le cas de vol particulier (un cas de croisiére généralement) ou cela se
produit, seul l'effort centrifuge demeure.

1.4.1.2 Moments de flexion et efforts tranchants aérodynamiques

En premiere approximation, on obtient un ordre de grandeur des efforts
aérodynamiques en considérant que seul « travaille » le profil qui se trouve a 75 % du
rayon de I'hélice (et produit la portance et la trainée, elles-mémes engendrant la traction et
le couple sur arbre). En effet, la figure 1.17 montre bien que c’est vers cette envergure que
la pale est la plus efficace (c’est la raison essentielle qui justifie le choix de 0,75R comme
profil de référence pour une pale).

Pour une évaluation plus précise, il faudra sommer le long de la pale vrillée tous les
efforts de portance et de trainée (figure .10 pour les efforts locaux sur chaque tranche de
pale de hauteur dr). En pied de pale notamment, les efforts aérodynamiques engendrent
ainsi un effort tranchant (égal a la résultante aérodynamique globale agissant sur la pale :
traction et trainée) et un moment de flexion appelé moment de flexion aérodynamique
statique.
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« Tranche » de pale
de masse dm,
située a I'envergure r

A
—

Toute section situé au rayon r doit supporter
la somme des efforts centrifuges générés par
toutes les « tranches » de pale situées entre
le rayon T et R ; en d'autres termes,

sur la section située en r_ s'exerce I'effort :

(R
Fo= rQ%dm

Reésultante
aérodynamique
// Fﬁ

[ __— Centre de gravité

o de la pale

Dans une configuration particuliére de vol,
on ajuste le déport de la pale de fagcon que
FC£ = FaL ; ainsi sur la section d'encastrement
de la pale, les moments s’annulent et seul

demeure Fc

irg

Figure 1.16 — Effort centrifuge et déport de la pale.

traction en décollage
—==traction en croisiere

couple au décollage
=== couple en croisiére

Traction et couple

T | T T T T T T T
o 010203040506 07 08 09 1
R

Figure .17 - Répartition typique du chargement aérodynamique
en envergure pour une hélice.

1.4.1.3 Couple autour de I'axe de variation de pas

Le couple qui s’exerce sur la pale autour de son axe de variation de pas (figure 1.18)
est dii a trois causes principales qui forcent globalement la pale a se placer dans le plan de

rotation (petit pas) :
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— la premiere est le moment piqueur de chaque profil aérodynamique cambré : pour une
tranche dr d'un profil cambré de coefficient de moment Cm (mesuré au foyer), de corde L,
évoluant dans l'air de masse volumique p a la vitesse relative W, le moment
aérodynamique appliqué au foyer vaut :

1
EpLCmWZLdr (1.27)

— la deuxiéme est le couple inertiel qui a tendance a ramener tout profil dans le plan de
rotation: toute masse m, excentrée de r; de 'axe de changement de pas, va exercer un
moment de rappel par rapport a cet axe égal a:

1
3 rZ2 O%sin(28) (figurel.19) (1.28)

— la troisiéme, présente sur les pales modernes en fleche, est due a I'excentration des
résultantes aérodynamiques par rapport a I'axe de changement de pas d'une part et au
centre de torsion de chaque profil d‘autre part.

La pale étant une structure qui se déforme, ces couples de torsion vont modifier le vrillage
que celle-ci possede au repos. Pour compenser ces déformations, on ajoutera un prévrillage
le long de la pale et celle-ci retrouvera son vrillage optimal au régime choisi.

1.4.2 Efforts extérieurs instationnaires sur la pale
= Nature des efforts

Généralement, la durée de vie structurale d’'une pale est essentiellement pilotée par
les efforts instationnaires. En effet, ceux-ci créent des contraintes de fatigue qui limitent
rapidement son intégrité si I'on ne les quantifie pas correctement (figures 1.20 et .21 :
exemple de tenue en fatigue d’un alliage d’aluminium) ; ces efforts sont de deux natures
principales différentes.

* Pour les grands nombres de cycles en fatigue (plusieurs dizaines de millions de
cycles), on trouve les excitations de la structure a des fréquences correspondant aux
fréquences propres de la pale d’'une part (figure 1.22 : diagramme de Campbell) et des
moments de flexion rencontrés lors de manceuvres de décollage ou de virages usuels
d’autre part (moment dit 1P).

* Pour les faibles nombres de cycles (quelques centaines a quelques milliers), mais
d’intensité plus importante, on trouve essentiellement les cas de manceuvres accidentelles
telles que le dérapage a tres forte incidence, ou brutales, telles que les virages serrés, les
manceuvres d’appontage... (qui engendrent des moments de flexion sur les pales).
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= Niveau des efforts instationnaires

Selon les applications, ces efforts peuvent varier. Généralement, pour les avions
commerciaux, le moment 1P est du méme ordre de grandeur que le moment de flexion

aérodynamique statique.

Par contre, les avions militaires effectuant des manceuvres plus serrées que les
avions de transport civils, celles-ci imposent a I’hélice des efforts instationnaires nettement
plus importants (un facteur 3 n’est pas rare par rapport au moment statique).

! Couple inertiel tendant

~ Résultante a amener le profil dans
aérodynamique . le plan de rotation
locale .

// Axe de \‘
_ _ | " changement ™\
Moment piqueur si / de pas ’
le profil est cambré ‘ /
|/

~ Plan de
rotation

Figure 1.18 - Couples s’exercant sur un profil autour de

I'axe de changement de pas.

Effort de
rappel

/ PAxe de changement

X | de pas de la pale
Ve
i _~—Axe de rotation de I'hélice
| z
Q2 |
e
x »~

Figure .19 - Couple de rappel inertiel.
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Figure 1.20 - Courbe de Wohler : contraintes alternées admissibles.
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Figure 1.21 - Diagramme de Goodman (domaine admissible : zone colorée).
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Figure 1.22 - Diagramme type de Campbell.
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Remarque : Tout régime stabilisé, correspondant au croisement d’'un mode propre avec un
harmonique nP du régime, doit étre évité
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Figure 1.23 - Polaire d’un profil : décrochage statique et dynamique.

1.4.3 Flottement de la pale
* Flottement de décrochage (figure 1.23)

Ce phénomene engendre des vibrations forcées en torsion de la pale lorsque
I’écoulement aérodynamique excite la structure. Ce cas se rencontre essentiellement au
décollage, lorsque les profils travaillent a de fortes incidences ; il se produit un couplage,
entre I'écoulement et la structure de la pale, qui crée un décrochage cyclique de celle-ci. Ce
phénomene est a proscrire car il crée des contraintes de fatigue importantes. Des criteres,
souvent empiriques, existent pour guider le concepteur d’hélice vers une structure qui
évitera de rencontrer ce phénomene.

= Flottement de sillage (figure 1.24)

Dans le cas ou I'hélice ne fonctionne en petit pas, la pale peut étre excitée par son
passage devant le tourbillon marginal de la pale précédente.
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Pale n° 3

Pale n° 2

Pale n®1——

Tourbillon margiﬁal de la pale n® 1
perturbant la pale n® 2

Figure 1.24 — Flottement de pale dil au sillage.

1.4.4 Modes globaux de vibration de I'hélice

On a déja vu les conséquences structurales négatives du fonctionnement de I’hélice a
un régime qui excite les pales sur leurs modes propres. En plus de cela, ces mémes modes
propres de pale interagissent avec la structure environnante, en particulier le bloc-moteur
monté sur son berceau. Selon les modes et le nombre de pales, les pales vont vibrer
individuellement, en phase ou en opposition de phase entre elles. Cette combinaison de
vibrations des pales peut engendrer un mouvement d’ensemble cyclique du bloc-moteur de
deux natures différentes (figure .25 et tableau 1.2) : le mode de whirl et le mode de
pompage. De la méme facon que pour les pales, il faut éviter que ce mouvement d’ensemble
corresponde a un mode propre de la structure (en particulier I'attache du moteur).

Mode propre des Nombre de pales
places 3 4 5 6 8 10
Ier w w w w w w
2¢éme w S S S S S
3éme P w S S S S
4éme w P w S S S
5¢me w w P w S S
6éme P S w P S S
7¢éme w w S w w S
8éme w P S S P S
(1) P:pompage; S:sans réaction globale; W : whirl

Tableau 1.2 - Modes globaux de vibration de I’hélice.
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e Mode de whirl

Le centre de I'hélice décrit un cercle autour de I'axe moyen de rotation de I'hélice.
Selon les cas, ce mouvement peut étre stable (le centre de I'hélice décrit une spirale
convergente qui le rameéne sur I'axe de rotation), ou instable (le centre de 'hélice décrit une
spirale divergente qui 1'éloigne de l'axe de rotation jusqu'a rupture des attaches du
moteur).

(@ mode de pompage (b) mode de whirl (€) mode symétrique sans réaction globale

Figure 1.25 - Modes vibratoires globaux.
e Mode de pompage

Le bloc-moteur est entrainé dans un mouvement de translation paralléle a 'axe de
rotation de I'hélice.

e Un troisiéme cas qui peut se présenter, c’est la combinaison vibratoire des pales
qui n'engendre aucun effort global sur le bloc-moteur. C’est paradoxalement le cas le plus
dangereux car si, dans les autres cas, le pilote ressent les mouvements du moteur qui sont
transmis au fuselage (lui permettant ainsi de réagir en éteignant le moteur incriminé par
exemple), dans cette situation, aucune sensation physique ne le préviendra que les pales
vibrent sur un mode dangereux pour leur intégrité structurale.

I.5 Technologie de mise en ceuvre
I.5.1 Avantages de I'usage des matériaux composites dans la fabrication des pales
Ces avantages sont les suivants :
— gain de masse (figure 1.26) ;
— possibilité d’optimiser le matériau en fonction des contraintes mécaniques a
supporter (les matériaux et leurs caractéristiques sont élaborés en méme temps que la
piece) ;

— pas de corrosion (attention toutefois aux couples galvaniques lorsqu’il y a contact
direct avec d’autres matériaux) ;
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— raideur spécifique plus importante (module d’Young/densité du matériau), d’ou la
possibilité de concevoir des formes en fleche impossibles a obtenir avec les matériaux
métalliques ;

— dispersions de fabrication plus faibles, ce qui facilite I'équilibrage final de I'hélice;

— possibilité de moduler la constitution du matériau pour piloter le placement en
fréquences propres (cf. figure .22) ;

— possibilité facilitée de réparation ;
— inertie polaire de I'hélice plus faible pour améliorer la finesse du synchrophasage;

— efforts inertiels plus faibles, ce qui contribue a diminuer la puissance (donc la masse)
du dispositif de changement de pas.

I.5.2 Différentes technologies de construction de pale

Les concepteurs de pales ont élaboré différentes familles d’architecture interne
(figure 1.27). Le choix est un compromis réalisé entre des considérations de résistance
mécanique, de colt de fabrication (et des moyens disponibles), de faculté de réparation, de
démontage ou d’accessibilité pour controler la qualité du produit.

600

500

Masse (kg)

400

300

200

100

Diametre (m)

Figure 1.26 - Masse d’une hélice a 4 pales en fonction du diamétre
et de la technologie.
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Mousse
C I T —
Structure pleine Tube de force interne a la coque
(bois, alliage d’aluminium ...)
Mousse
<l I - l)
Coque métallique ou Longeron de renfort en extrados
composite nervurée et intrados de la coque

Figure 1.27 - Concepts de section de pale.
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« Tulipe » Mousse
métallique du
longeron

Tressage Mousses Tresse en Pale t .
de fibres en bord Kevlar, ale terminee
en carbone d’attaque puis injection avec son dégivreur
dulongeron et bord (RTM) et ses protections
de fuite de résine

o o> &>

Figure 1.28 - Exemple de procédé de fabrication d’une pale en composites.

1.5.3 Exemple de procédé de mise en ceuvre

On peut voir sur la figure 1.28 un exemple de chronologie de fabrication d’'une pale
en matériaux composites utilisant le procédé RTM (Resin Transfer Molding) : ce procédé
utilise d’abord de la fibre seche qui sera imprégnée une fois la pale mise en forme).
L’utilisation de plis de renfort préimprégnés permet également I'obtention d'un taux
volumique de fibre optimal.
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1.5.4 Conception modulaire de I'hélice

Ce type d’approche consiste a dissocier physiquement les fonctions remplies par
I’hélice et a les assembler comme un jeu de construction. Cela permet de bénéficier des
avantages suivants :

— possibilité de remédier rapidement a la défaillance d’une fonction en remplagant le
module correspondant, sans toucher ni dérégler les autres sous-systémes ;

— facilité pour concevoir ou améliorer I'une des fonctions, puis mettre a niveau toute la
flotte.

Spécifications du client : contraintes de masse
Approche préliminaire : facteur d’activite, | et d'inertie, niveaux de bruit et de performances,
nombre de pales, diamétre ... environnement extérieur, profil des missions,
\ niveau de fiabilité, durée de vie ...

FrTe
[
[
!
Conception de la forme aérodynamique de la pale [«--+ | ! |
= | 1
P |
Dol
Conception structurale de I'hélice : pale, e K ! |
moyeu, dispositif de changement de pas ... Lol
o
[
[
\ : 1
ol Fabrication de prototypes, | _ | |
Industrlalisation = "|  essais et certification | !
I
1
|
s L - I
Fabrication en série et support client [+------—----- -

- ----Bouclage avec les désirs du client

-<—Processus séquentiel

Figure 1.29 - Exemple de procédure de conception d’'une hélice.
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La Modélisation Numérique - CFD & CSM

La mécanique des fluides numérique (ou CFD pour Computational Fluid
Dynamics en anglais), intégrant les équations d’Euler ou de Navier-Stokes, s’est
imposée au cours des dernieres décennies en aérodynamique grdce a
I'accroissement de la puissance des ordinateurs.

Le calcul de structures numérique (ou CSM pour Computational
Structural Mechanics en anglais) est ainsi apparue comme une discipline a part
entiere : pour notre travail, le calcul comprend dans la plupart des cas une
chaine de logiciels CFD et CSM, la CFD fournissant les efforts aérodynamique
pour le CSM.

Nous faisons ici une présentation des modeles, équations et méthodes
utilisés en mécanique des fluides et des solides, présentation qui est
volontairement breve.
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I.1 Mécanique des fluides numérique (ou CFD)

L’essor des capacités de calculs au cours des dernieres décennies a permis le
développement d’'une nouvelle branche de I'aérodynamique : la dynamique des fluides
numériques (CFD pour Computational Fluid Dynamics en anglais). Ce domaine permet de
développer et de tester de nouvelles technologies en s’affranchissant des lourdes
contraintes de temps et d’argent que demande la mise en place d’essais en soufflerie.

II.1.1 La simulation des écoulements de fluides

La mécanique des fluides repose maintenant depuis plus de 150 ans sur le modele
des équations de Navier-Stokes. Les propriétés de ce systeme d’équations limitent les
possibilités d’obtention d'une solution analytique dans la majorité des écoulements. Ainsi,
cette discipline a utilisé plusieurs approches afin de pouvoir analyser diverses catégories
d’écoulements :

- 'approche théorique qui consiste en I’élaboration de modeles simplifiés des équations de
Navier- Stokes afin de permettre leur résolution de maniére analytique a I'image du cas de
la couche limite incompressible sur plaque plane de Blasius.

- l'approche expérimentale permet de mettre a I'épreuve les résultats de I'approche
théorique tout en apportant des contributions sur la compréhension de certains
phénomenes a I'image des essais en soufflerie sur des avions par exemple.

- l'approche numérique est utilisée pour résoudre de maniére numérique le systéeme
d’équation de Naviers-Stokes ou bien les différents modeles simplifiés issus de 'approche
théorique (équations moyennées de Reynolds par exemple).

Le développement de la simulation des écoulements est étroitement relié aux
progres réalisés dans le domaine du calcul scientifique assisté par ordinateur. Les premiers
calculs numériques sur I'écoulement d’un fluide apparaissent dés les années 1950 et
depuis, la progression fulgurante de la puissance et des capacités de stockage des serveurs
de calcul a permis I'essor de la simulation numérique en mécanique des fluides. En effet,
son attractivité provient, sans étre exhaustif, de la réduction du temps nécessaire pour
effectuer une analyse d'un écoulement, de la possibilité de controler précisément les
différents parametres physiques de I'expérience numérique et de son caractere
économique par rapport aux colts des essais notamment en soufflerie. Ainsi, son
intégration dans des processus de développement de type industriel est de plus en plus
importante de nos jours.

Toutefois, les progrés de la simulation numeérique sont aussi dépendants des
avancées théoriques et expérimentales. Les contraintes de résolution numérique étant
importantes sur certaines classes d’écoulements, il est nécessaire d’'utiliser des modeles
simplifiés afin d’étre capable par exemple de simuler des écoulements turbulents sur des
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applications industrielles. Ainsi, les approches théoriques et expérimentales permettent
d’améliorer les capacités de prédiction des outils de simulation en apportant des modeles
des équations de Navier-Stokes de plus en plus précis et en permettant de confronter les
résultats numériques avec la réalité.

Nous en présentons brievement quelques concepts dans les pages qui suivent. Les
livres de Candel [6] ou de Huerre [11] peuvent étre consultés pour approfondir ce sujet.

Les codes de calcul ANSYS Fluent et ANSYS CFX, permet la simulation numérique de
ces écoulements. Ce sont des logiciels tres complet, et nous n’en utiliserons dans cette
mémoire qu'une petite partie. Nous renvoyons a 'annexe A, ainsi qu’aux références qui y
sont indiquées pour une description approfondie de ces logiciels.

I1.1.2 Les équations de Navier-Stokes

Les équations de Navier-Stokes sont a la base du mouvement fluide et du transfert
de chaleur par conduction en régime laminaire. Elles expriment le principe de conservation
pour les différentes grandeurs caractérisant I'écoulement. Elles traduisent la conservation
de trois quantités : masse, quantité de mouvement et énergie :

I1.1.2.1 Notations

Soient q une fonction scalaire, v et w des fonctions vectorielles et A et B des tenseurs
de deuxiéme ordre (matrices).

Nous pouvons définir maintenant les objets mathématiques utiles :

3 _Ov
tv_ atl
Iv = v
jv_ax]"

Vq = gradient de q (vecteur),

Vv = tenseur de 2°™ ordre (Vv); = div;,

V.v =divergencedev: V.v = Z d0;v;,
i
V.A = vecteur dont la j*™ composante est Z d;A;j,
i

u.v = produit scalaire,
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vWv = v;0;v,
A:B-= ZAUBU’
ij

v@w = tenseur de 2°™¢ ordre (v® w)ij = vw;.

I1.1.2.2 Les équations instantanées

Considérons un fluide contenu dans un ouvert 2 borne connexe de IRk (k=2 ou
k = 3) pendant un intervalle de temps [0, T’].

On notera par x un pointde £ et t serauninstant (i.e. un élément de IR *).

I.1.2.2.1 Conservation de la masse

Soit A un sous-domaine régulier de £. Le principe de conservation de la masse dit
que la variation de masse dans A est égale au flux de masse a travers la frontiere dA de A.
Il en résulte :

d f R
— pdx = — f pu.nds
at J 4 dA(D)

Ou n = (nq, ny) estun vecteur normal unitaire défini localement sur 94 et dirigé
vers 'extérieur de A.

Comme A est régulier, la formule de Stokes donne :

f V.(pu) dx =f pu.nds
A(D) DA(L)

Donc nous avons :

d
—f pdx +f V.(jpu)dx =0
dt J ) A(®)

Comme A est défini arbitrairement, le principe de conservation de la masse conduit

Z—’Z + V.(pu) =0 (I1. 1)

Remarque : Cette équation est nommée équation de continuité.
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I1.1.2.2.2 Conservation de la quantité de mouvement

L’équation de la conservation de mouvement provient de la loi de Newton :
Y Forces = accélération suivant le mouvement du fluide.

Soit une particule de fluide en x a l'instant ¢; par définition de la vitesse, cette
particule sera x + u(x,t) 8t alinstant t+ 6t et son accélération est:

1 ou
é%m) 5 (u(x + u(x, t)8t, t + 6t) — ul(x, t)) = 3 + u.Vu

Maintenant, nous devons exprémer les forces qui agissent sur A :

e Les forces extérieurs fA © f ou f estlaforce extérieure par unité de volume.

e La force de pression et la force visqueuse due a la nature du fluide
f (t—pDndx = .[ (V.pl = V.1)dx
dA(t) A(t)

Ou t estle tenseur des efforts. L’équation précédente vient de la formule de Stokes.

En conséquence, nous avons :

9]
f p(—u+ u.Vu)z f—=V.pl+ V.t
Ay N0t A(D)

Comme A est défini arbitrairement :

ou
p(a+ u.\7u>+l7.pl— V.t=f

Notons que :

Ju

d Ju
P = a(ﬂu)—<—

0 d
2 p) =5 (o) + V. (o = = (o) + V. (pu ® ) - pul

Il en résulte I’équation de conservation de la quantité de mouvement suivante :

d
5% (W) +V.(pu@uW+ V.(pl-1)=f (11.2)
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I1.1.2.2.3 Conservation de I'énergie

Considérons un élément de volume A bougeant avec le fluide. L'énergie totale
massique E dans un élément de volume provient de :

L’énergie interne massique e,

)z . e s u?
L’énergie cinétique —- .

2
Donc, E=e+ u? et 'énergie dans un volume A est jA(t) p E . De plus, I'énergie E

est la somme des travaux des forces et de la quantité de chaleur recue. Le travail des forces
est IA(t) u.(f +T-phn. Notons q la densité de flux d’énergie transporté par conduction

thermique.

Nous obtenons donc:
d 0 .
d—f pE= f ETa (pE) + V.(puE) | = f u f+ f (u(t —pl) —qn
tJaw A \ 0t A(D) AA()

Al'aide de la formule de Stokes et comme la relation précédente est vraie pour tout
A, nous arrivons a I’équation de I'énergie :

% (pE) + V.(u(pE +pD) = V.(ut+q) + u.f (11.3)

I1.1.2.3 Les systéme des équations de Navier-Stokes

Nous supposons enfin le systeme dynamique n’est soumis a aucune force extérieure

(f=0). Nous obtenons le systeme des équations de Navier-Stokes :

%+ 7.(pu) = 0 (11.4)

0
a(pu) +V.(pu®@u="V.o (I1.5)
%(pE) + V.(puE) = V.(u.0) - Vgq (IL.6)

Ou: o= -pl+r.

Tel qu’il a été établi, le systéme précédent est ouvert avec plus d’'inconnues que
d’équations. Pour le fermer, des relations supplémentaires sont donc nécessaires et relient
les inconnues intermédiaires ¢ et q aux inconnues principales. Il nous faut alors préciser
maintenant les lois de comportement et la loi du modéle fluide.
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I.1.3 La Turbulence

II.1.3.1 Tentative d’'une définition de la turbulence

Donner une définition générale et précise de la turbulence reste encore, en I'état
actuel des connaissances une question ouverte. La proposition suivante ne cherche donc
pas a clore définitivement le sujet, mais plus simplement a rassembler synthétiquement les
éléments essentiels sur la turbulence. Ainsi on peut retenir que :

Définition (Qu’est-ce-qu'un écoulement turbulent ?). L’écoulement turbulent est un état
naturel de mouvement de fluides visqueux ou les mécanismes internes d’échanges d’énergétiques
assurent, au sein méme de l'écoulement, la création et le maintien de toute une hiérarchie de
mouvements chaotiques répartis continument sur une large gamme d’échelles macroscopiques.

I1.1.3.2 Modéles de turbulence

I1.1.3.2.1 Modéles k- de Launder-Sharma et de Chien

Deux modeles faisant intervenir les équations de transport pour I'énergie cinétique
de turbulence k et son taux de dissipation isotrope & = € — D/p sont disponibles : le
modele (k- & ) de Launder-Sharma [13, 14], et le modéle (k - & ) de Chien [16]. Si €
représente le vrai taux de dissipation, I'utilisation de &€ présente I'avantage de simplifier les
conditions a la paroi (k et & y sont nuls).

L’énergie cinétique et le taux de dissipation sont régis par les équations de transport

suivantes :
Dk p - p d ( ut) ok L7
— = -pf-D+ — +—|— .
P Dt kT PE 0x; # o/ 0%; (I1.7)
DE e pf c polipsl ( ’“‘t)a~ I.8
— = — - —+E+— +—|— .
th &1 kk EZfzp k a ] M O-g axjg ( )

La viscosité turbulente est évaluée en fonction des deux grandeurs turbulentes
pondérées par une fonction d’amortissement :

kz
ko= Cufups (11.9)

Dans ces équations, Py est le taux de production d’énergie cinétique de turbulence,
CnCe, Cg,, 0 et o, des constantes dépendant du modele, f. et f2 des fonctions
d’amortissement prenant en compte des effets de paroi et/ou de faibles nombres de
Reynolds de turbulence ; le terme D résulte de la définition de la variable & comme partie
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isotrope du taux de dissipation de k, et E est un terme dit “bas Reynolds” introduit pour
reproduire le comportement de € au voisinage de la paroi.

Le modele k-8 de Launder-Sharma présente l'avantage pour le numéricien de
déterminer les fonctions d’amortissement non pas comme des fonctions des distances a la
paroi (comme c’est le cas pour le modéle de Chien), mais comme des fonctions du nombre
de Reynolds turbulent Re, toutefois au prix d’'un coliteux calcul de E.

Rappelons que :

Re,=— et y'= (II.10)

Le tableau 3.2 présente les valeurs des différentes fonctions et constantes
employées pour les modeles k-& de Launder-Sharma et de Chien.

Modele Launder-Sharma Chien
Cy 0,9 0,9
Ceq 1,44 1,35
Cez 1,92 0,8
O 1,0 1,0
O 1,3 1,3
L (0VE\ (9VK\ (_Re? 24k
D K axl axl 36 yZ
o HH 0%U; 02U; _2ué ox B
p \0x;0x; ) \0x;0xy y? p 2
—-3,4
exp —Re > N
= 1—exp(—0,0115
fu (1 + 50) p( y )
- —Re? 2 Re?
f, 1-0,3 exp (-Ref) 1—Zexp( — %
9 36

Tableau I1.1 - Valeurs des constantes et fonctions utilisées par les modeéles
Launder-Sharma et Chien
11.1.3.2.2 Modele k-w de Wilcox
Le modele (k - w) de Wilcox [15] (1988) est une nouvelle formulation du modeéle

établi par Kolmogorov en 1942 qui était constitué d’'une équation de transport pour
'énergie cinétique de turbulence k et pour le taux de dissipation spécifique w défini par
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(IL.11)

ou f* estune constante identique a celle notée €, dans les modeles (k - ¢€).

Ce modele présente l'avantage de ne pas faire intervenir de fonction
d’amortissement. Les deux équations de transport sont écrites pour I'énergie cinétique de
turbulence k et pour le taux spécifique de dissipation w.

Dk _ g, O (so" )ak 12
e - +— + -— .
Pof =P Fpw ox, p+ou ox, (11.12)
bo _o2p 2 2 (v opp) 22 .13
Ppf = @5 P Ppw 0%, W+ o 0%, (I1.13)
\ _3 el _5 e _ Pk
ot B=yr B7=009, a=5, 0=0"=05 et p =" (II. 14)

Un des inconvénients de ce modele réside dans le fait que la variable w présente un
comportement singulier au voisinage de la paroi. De plus, la solution numérique est tres
sensible a la valeur donnée au taux de dissipation spécifique aux frontieres du domaine de
calcul ww ainsi qu’a certains parametres numériques tels que ceux contrélant la diffusion
numérique (densité du maillage, viscosité artificielle ou correction de Harten. . .).

I1.1.3.2.3 Modéle k-w de Menter

Le principal défaut du modele k-w de Wilcox est sa sensibilité a la condition aux
limites a imposer sur w aux frontiéres des couches limites et des sillages. Pour éviter ce
probléme, Menter a développé un modele [17, 18, 19] dans l'espoir de conserver le bon
comportement du modeéle de Wilcox dans les couches limites et d’obtenir une condition aux
limites insensible au niveau de wcw.

Pour cela, il remplace le modele de Wilcox dans les régions externes des couches
limites et des sillages par le modéle k-¢ de Launder-Sharma écrit en variables k-w. Ceci
nécessite 'introduction d’une fonction de raccord F; entre les modeéles. Cette fonction est
un senseur qui a pour but de séparer les régions internes des couches limites, ou s’applique
le modele de Wilcox, des régions externes (au-dela de y/6 -« 0.7) ou le modele de Launder-
Sharma est utilisé. Le modele de Wilcox est aussi remplacé par le modele de Launder-
Sharma dans les sillages.

Les constantes s’obtiennent par pondération des constantes de chacun des modeles
en utilisant la fonction de raccord Fy :

Cste = FiCsper + (1 = F1)Cyte (1.15)
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En faisant F1 = 1, on retrouve les constantes (indicées "1") du modele original de
Wilcox. F1 = 0 permet d’obtenir le modele k- € de Launder-Sharma, dans une formulation
k-w apres changement de variable.

Les constantes de ce modele sont les suivantes :

07=05 ¢,=05 p,=05 0, =0 (11. 16)
03=10 0,=0856 f,=00828 0,;=0856 (11.17)
B; =0.09 k=041 (11.18)

. k2
Vi=ﬁ_0"_ ; i=1.2 (11.19)

B B

11.1.3.2.4 Modele de Spalart-Allmaras [S-A]

Le modele de Spalart-Allmaras [20, 21] utilise une seule équation de transport pour
la quantité v qui, loin des parois, se confond avec v:= uy/p.

L’équation pour V¥ résulte d'une construction pas a pas par adjonction de
termes destinés a prendre en compte de plus en plus de phénomenes physiques. Partant
d’'une forme “convection = production + diffusion” pour les écoulements libres, Spalart et
Allmaras ont ajouté les termes nécessaires pour une région logarithmique dans les profils
de vitesse, puis ceux de correction de faible Reynolds dans la région de proche paroi.

Dv, . Cp, 0V OpV ( Cpy ) ¥ 10 v
—=(p1(1— Sv+—————|(C - — —+—= V) —
P p: p1(1 = fr2)pSV+ o Ox; 0x; wifw 12 ft2 p772 + 5 ox; (n+pV) ox,
(II. 20)
Avec:
(6 _ ~, V X pv
S=w+ , =1—-——— , X =—
© T ke oo L+ Xfun G
1
\ 1+C8\'° v (I1. 21)
=g|\—/—— , =r+C 6—7), = =
fo =49 <g6 + Ca6)3 g=r w2(T r) r Sk
\ fiz = Cez exp(=Ceax?)
La viscosité turbulente est évaluée par les relations suivantes :
— Ny = X—3 t — '0_~ (11. 22)
He=pifo avec fu=—"w et x=7 .
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Les constantes du modeéle sont les suivantes (ce sont celles de la référence [21]) :

— Cp, = 0,1355 — Cp, = 0,622
_Z k=041
o=3 =0,
Cpr 1+ Cyy
—Cyp, = e > Co, =03 = Cy, =2
_Cvl = 7,1 - Ctg = 1,2 - Ct4 = 0,5
I1.1.4 Méthodologie de la CFD

De maniere générale, la résolution d'un probleme de mécanique des fluides

numérique (MFN) passe par trois grandes phases :

a.

I1.1.5

la préparation du probléme : ceci passe par la définition d'une géométrie, d'un
maillage discrétisant le domaine de calcul, du choix des modeles et méthodes
numériques employés ;

la résolution numérique du probléeme qui passe par l'exécution d'un programme
informatique. Bien des problémes suscitant un minimum d'intérét nécessitent des
ordinateurs aux tres grandes capacités ;

I'exploitation des résultats: ces derniers sont vérifiés afin de vérifier leur
cohérence, puis examinés afin d'apporter des réponses aux questions posées par le
probléeme de MFN de départ. Cette exploitation passe le plus souvent par des
logiciels de post-traitement scientifique utilisés dans de nombreuses branches de la
physique, ou bien par les modules de post-traitement disponibles dans certains
logiciels de MFN commerciaux.

Modeles physique

Dans le cas général il faut passer par la résolution numérique des équations de

Navier-Stokes ou des équations d'Euler. Selon le probleme il est important de choisir les
bonnes hypothéses pour prendre en compte tous les aspects de 1'écoulement.

I1.1.6

Meéthodes de discrétisation

Les équations de Navier-Stokes peuvent etre numériquement abordées de diverses

manieres : différences finies, volumes finis ou éléments finis par exemple.
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II.1.6.1 Méthode des différences finies

En analyse numérique, la méthode des différences finies est une technique courante
de recherche de solutions approchées d'équations aux dérivées partielles qui consiste a
résoudre un systéme de relations (schéma numérique) liant les valeurs des fonctions
inconnues en certains points suffisamment proches les uns des autres.

Y

En apparence, cette méthode apparait comme étant la plus simple a mettre en
ceuvre car elle procede en deux étapes : d'une part la discrétisation par différences finies
des opérateurs de dérivation/différentiation, d'autre part la convergence du schéma
numeérique ainsi obtenu lorsque la distance entre les points diminue.

Toutefois, il convient de rester vigilant et critique sur les résultats obtenus tant que
la seconde étape n’a pas été montrée en toute rigueur.

II.1.6.2 Méthode des volumes finis

En analyse numérique, la méthode des volumes finis est utilisée pour résoudre
numériquement des équations aux dérivées partielles, comme la méthode des différences
finies et celle des éléments finis.

Contrairement a la méthode des différences finies qui met en jeu des
approximations des dérivées, les méthodes des volumes finis et des éléments finis
exploitent des approximations d'intégrales. Toutefois, la méthode des volumes finis se base
directement sur la forme dite forte de 1'équation a résoudre, alors que la méthode des
éléments finis se fonde sur une formulation variationnelle de 1'équation (on parle aussi de

formulation faible)

L'équation aux dérivées partielles est résolue de maniere approchée a l'aide d'un
maillage constitué de volumes finis qui sont des petits volumes disjoints (en 3D, des
surfaces en 2D, des segments en 1D) dont la réunion constitue le domaine d'étude. Les
volumes finis peuvent étre construits autour de points d'un maillage initial, mais ce n’est
pas une nécessité.

Les méthodes de volumes finis ont été initialement mises au point pour des lois de
conservation hyperboliques, mais des développements récents permettent a présent de les
utiliser pour des équations elliptiques et paraboliques.

Ces équations aux dérivées partielles contiennent des termes de divergence. En
utilisant le théoreme de flux-divergence, les intégrales de volume d'un terme de divergence
sont transformées en intégrales de surface et ces termes de flux sont ensuite évalués aux
interfaces entre les volumes finis. On utilise une fonction de flux numérique pour élaborer
une approximation des flux aux interfaces. Puisque le flux entrant dans un volume donné
est égal au flux sortant du volume adjacent, ces méthodes sont conservatives, donc
parfaitement adaptées a la résolution de lois de conservation.
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Un autre avantage de la méthode des volumes finis est qu'elle est facilement
utilisable avec des maillages non-structurés car, en matiére de discrétisation des lois de
conservation, sa formulation ne tient aucun compte de la complexité du maillage. En
revanche, les caractéristiques géométriques du maillage peuvent jouer un rdle
prépondérant lorsque des flux diffusifs entrent en jeu.

I1.1.6.3 Méthode des éléments finis

La méthode des éléments finis fait partie des outils de mathématiques appliquées. Il
s'agit de mettre en place, a l'aide des principes hérités de la formulation variationnelle ou
formulation faible, un algorithme discret mathématique permettant de rechercher une
solution approchée d’'une équation aux dérivées partielles (ou EDP) sur un domaine
compact avec conditions aux bords et/ou dans l'intérieur du compact. On parle
couramment de conditions de type Dirichlet (valeurs aux bords) ou Neumann (gradients
aux bords) ou de Robin (relation gradient/valeurs sur le bord).

Il s'agit donc avant tout de la résolution approchée d'un probleme, ou, grace a la
formulation variationnelle, les solutions du probleme vérifient des conditions d'existence
plus faibles que celles des solutions du probleme de départ et ou une discrétisation permet
de trouver une solution approchée. Comme de nombreuses autres méthodes numériques,
outre l'algorithme de résolution en soi, se posent les questions de qualité de la
discrétisation :

» existence de solutions,

e unicité de la solution,

e stabilité,

e convergence,

e et bien siir: mesure d'erreur entre une solution discrete et une solution unique
du probléme initial.

I1.1.7 Le maillage

Le maillage est une discrétisation de I'espace a étudier. Support des calculs CFD, il
est constitué d’'un ensemble de mailles (ou cellules) dans lesquelles les équations du
probléme seront résolues. Le pas d’espace est ici défini comme la taille caractéristique
d’'une maille. Aussi, faut-il veiller a ce que deux mailles adjacentes n’aient pas de
dimensions trop différentes sans qu’il y ait recouvrement d’'une maille sur l'autre. Il est
souhaitable pour cela que la variation de tailles entre deux cellules adjacentes n’excede pas
a 20% .le maillage doit étre réalisé de sorte a minimiser la diffusion de I’erreur numérique.
Dans une approche de CFD, il faut aussi définir des directives de création de maillage,
d’autant que le maillage est la piece maitresse en terme de gain de temps de calcul
différents type de cellules existent : tétraedre, hexaedre, pentaedre,...la facon dont les
cellules sont assemblées donne lieu a des maillages conformes ou non conforme, structurés
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ou non, orthogonaux ou non. Lors d’'une étude CFD, I'étape de création du maillage est
cruciale pour assurer la cohérence des résultats et prendre en compte les considérations
physiques du cas a étudier, numériques du code utilisé (convergence) et pratiques du
contexte de l'étude effectuée (délais, puissance des ordinateurs, volume de données a
traité). En plus la notion de raffinement de maillage est liée a la taille du pas d’espace aux
endroits a fort gradients : il faut mailler petit dans une zone de fort gradient.

I.1.7.1 Qu’est-ce qu'un maillage ?

Un maillage est un mécanisme pour 'organisation et la structuration d’'un domaine
dans I'espace pour fins de calculs. Il s’agit un partitionnement des frontieres et du domaine
qu’elles renferment en éléments géométriques discrets. Ces entités possédent des
propriétés géométriques (les coordonnées, tailles) et des informations topologiques
(connectivité, voisinage). Ces entités s’impliquent hiérarchiquement selon leur dimension
ou étendue : zéro pour les nceuds, un pour les segments, deux pour les faces et trois pour
les volumes.

Noeud |=>»| Segment | =">| Face |=»| Volume

Ensemble, ces éléments forment un recouvrement de 'espace avec les propriétés
suivantes :

- Les éléments couvrent completement le domaine ;
- Il n’y a pas de chevauchement (ni de vide) entre les éléments.

De plus, ils sont ordonnés, c’est-a-dire numérotés ou identifiés de sorte qu'ils
peuvent étre facilement récupérés pour fins de traitement numérique.

Par les propriétés géométriques et topologiques, ils peuvent étre localisés dans

I'espace et vis-a-vis leur voisinage, ainsi qu’entre eux-mémes par une structure
hiérarchique.
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(a) Repére cartésien

(b) Repére polaire

Figure 1.1 — Maillages construits avec des systéemes de coordonnées réguliers

I1.1.7.2 Buts d’'un maillage

La simulation numérique de phénomenes physiques que l'on retrouve dans des
applications en ingénierie est réalisée par la résolution d’équations dans des applications
en ingénierie est réalisée par la résolution d'équations aux dérivées partielles sur des

domaines a géométrie complexe. Quelle que soit la méthode retenue, éléments finis,
volumes finis ou différences finie, toutes nécessitent une discrétisation du domaine.

Comme support a la discrétisation des équations différentielles, les maillages
doivent rencontrer un certain nombre d’exigences :

e Représenter une discrétisation fidele de I'espace et des frontieres du domaine de
calcul,

e Discrétiser l'intérieur du domaine en fonction des équations et du phénomene
simulé,

e Permettre un contrdle sur la répartition, la forme et la taille des éléments.

Un maillage se défini comme un ensemble d’éléments discrets qui recouvrent au
complet un domaine sans chevauchement ni vide. Ces éléments ont des propriétés spatiales
telles qu’une position et une dimension, et sont construits par une hiérarchie de nceuds,
segments et faces. Une autre propriété d’'un maillage est la connectivité qui traite de la
relation des éléments entre eux. Le procédé de génération de maillage doit créer ces deux
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niveaux d’information, c’est-a-dire calculer les positions des nceuds et leur imbrication en
structure d’élément (géométrie), et établir le voisinage de chaque élément (la topologie).
Dépendant de la méthode utilisée, ces deux niveaux peuvent se faire séquentiellement ou
en parallele. Les entrants dans ce procédé sont la représentation géométrique des
frontieres du domaine, avec d’autres fonctions décrivant la répartition des nceuds.

I1.1.7.3 Classification des maillages

Les maillages sont caractérisés selon leurs caractéristiques ou bien selon la méthode
utilisée pour les générer.

Les maillages sont caractérisés selon leurs propriétés :

e Réguliers structurés ;

e (Curvilignes ou adaptés ;

e Non-structurés ;

e Hybrides;

e Etleur forme géométrique.

Ou bien selon la méthode utilisée pour les générer :

¢ Interpolation transfinie ou techniques algébriques ;

e Equations différentielles ou transformations conformes ;
e Triangulation de Delaunay ;

e Avance de font;

e Décomposition par blocs ;

e Décomposition hiérarchique ;

e Etc..

Le type de classement le plus fréquemment utilisé est basé sur la propriété structuré
ou non structuré des maillages qui se rapportent a la nature de la connectivité entre les
éléments. La connectivité peut étre implicite (comme c’est le cas dans un treilli) ou explicite
pour les maillages non structuré. Un niveau de raffinement de ce procédé est obtenu en
utilisant la forme des éléments. En dimension 2, les formes les plus répandues et les plus
pratiques sont le triangle ou le quadrangle. Les formes équivalentes en dimension 3 sont
les tétraeédres ou les hexaedres, avec 'autre possibilité comme le prisme ou la pyramide.
Dans un maillage structuré chaque nceud est entouré d’exactement du méme nombre de
neceuds. Une différence entre les maillages structurés ou curvilignes et les maillages non
structurés réside dans la présence de lignes (surfaces) ou des directions clairement
identifiables a l'intérieur du maillage. Ces dernieres peuvent ou non coincider avec les
frontieres du domaine selon la technique de génération utilisée. La propriété globale de tels
maillages est qu’ils sont des applications vers un carrée (cube) logique ou un triangle
logique en dimension 2.
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STRUCTURE

Triangle

Quadrangle

NONSTRUCTURE

Quadrangle

[Reguiiér] [Cu}viligne] [ Régﬁuer] (Cunviligne )

Figure 11.2 — Classification des maillages

Il est évident qu'’il ne sera pas toujours possible de réaliser de telles applications

pour des domaines complétement quelconques, comme par exemple des topologies non-
simplement connexes. Dans ces cas 1a, ces difficultés peuvent étre contournées par une
décomposition ou zonage du domaine qui donne une combinaison de plusieurs blocs ou
sous-domaines, chacun pouvant s’appliquer a un carré (cube) logique. On obtient alors des

maillages dits composites.

Par contre, dans un maillage non structuré chaque nceud est entouré d’'un nombre
variable de voisins. LA forme des éléments est un polygone quelconque mais en pratique
on retrouve des quadrangles et surtout des triangles, qui peuvent étre mélangés.
Contrairement aux maillages structurés, il n'y a aucun patron (absence de lignes ou
surfaces de maillage) et aucune restriction sur la topologie du domaine.
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Figure 11.3 — Classification des maillages structurés

Figure 11.4 — Maillage non structuré

I1.1.7.4 Classification des techniques de génération de mailles

Il existe de nombreuses techniques pour la génération de maillages structurés et non
structurés :

Structurés :
= Méthodes algébriques et interpolation transfinie ;

* Transformations conformes ou analytiques ;
» Méthodes différentielles.

-55-



Chapitre 11 La Modélisation Numérique - CFD et CSM

Non structurés :

Delaunay triangulation ;
Avance de font;
Adaptation methods
Hierarchical methods

La génération d’'un maillage structuré peut se présenter comme une application
d’un maillage régulier cartésien par une transformation d’'un espace paramétrique vers un
espace physique. Ce qui distingue les diverses méthodes dans cette catégorie générale, c’est
la forme ou le type de transformation utilisée. Strictement parlant, le maillage (la position
des nceuds et la connectivité) est généré dans l'espace paramétrique (qui est une tache
triviale) et en suite appliqué vers l'espace physique par une transformation qui préserve
les nceuds et leur connectivité. La forme des frontieres et le type de transformation
déterminent les caractéristiques et limitations du maillage résultant.

Les techniques de maillages non structurés travaillent seulement dans l'espace
physique et sont classées en méthodes directes (avance de font) ou itératives (Delaunay ou
adaptatives). Dans les premieres, les positions et connectivités sont engendrées
simultanément lors de la propagation du font dans le domaine. Dans les méthodes
itératives, un maillage est adapté aux frontieres du domaine et a une carte de tailles pour la
répartition des nceuds par un processus adaptatif ou un maillage initial est modifié
successivement par l'ajout, le retrait et la relocalisation des nceuds, opérations
accompagnées d’'une modification de la connectivité.

Afin d’obtenir des simulations numériques donnant des résultats les plus fideles a
la physique du probleme, la discrétisation doit tenir compte de plusieurs criteres portant
sur la forme des éléments st la distribution des sommets, sur la géométrie du domaine ainsi
que sur les caractéristiques du phénomene étudié. Les contraintes portant sur les
propriétés topologiques, physiques et géométriques du maillage :

- La fidélité du maillage par rapport a la géométrie du probleme.
- La densité des sommets en fonction des zones d’intéréts.
- La forme des éléments.

Le tout afin de permettre l'écriture de codes de calculs généralisés, c-a-d
indépendant du domaine et ou les frontieres sont des données du probléme.

Les attentes vis-a-vis un maillage sont nombreuses :

- Une représentation précise de la géométrie :
¢ Alignement avec les frontieres
e Orthogonalité des lignes du maillage

- Une organisation et un stockage efficace des éléments
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- La possibilité d’adaptabilité selon la physique du phénomene :

e Concentration
e Etirement des mailles
e Régularité

Les exigences vis-a-vis un logiciel de maillage comprennent les éléments suivants :

e Intégration avec les modeleurs géométriques ;
e Structure de données efficace ;

e Rapidité de calcul ;

¢ Minimise les interventions, c-a-d automatique.

I.2 Mécanique des structures numérique (ou CSM)

I1.2.1 Mécanique des solides déformables

Les équations de la mécanique du solides et des structures reposent sur la
mécanique des milieux continu [23, 30]. Elles s’écrivent en formulation Lagrangienne, c’est-
a-dire dans un repére attaché au solide, et suivant les déplacements de ses particules.

L’équation fondamentale est déduite du principe de conservation de la quantité de
mouvement et se traduit par 'équation :

p%—divcr: pf (I1.23)

ou p estladensité du matériau, u le champ de déplacements, o le tenseur des contraintes
d’ordre 2, et f une force volumique externe, par exemple la gravité.

Nous nous intéresserons par la suite a des problemes quasi-statiques, c’est-a-dire
des problemes mécaniques pour lesquels les effets d'inertie ou d’accélération du solide
sont négligeable, L’équation précédente se réduit donc a :

~dive=pf (11.24)

L’expression de ¢ en terme des autres parametres et variables de calcul se fait au
travers des lois de comportement [23, 24]. Celles-ci feront en particulier intervenir le
tenseur des déformations :

E() = % (gradu + (grad W) + (grad w)" (grad w)) (11. 25)
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Dans I'hypothése des petites déformations, le terme quadratique et négligeable et le
tenseur des déformations de réduit a:

e(uw) = % (grad u + (grad w)T) (11.26)

Cette relation contraintes-déformations, aussi appelée loi de comportement, est
dépendante de nombreux facteurs: nature du matériau, nature et amplitude des
déformations, parametres extérieurs, etc. . . Elle pourra etre linéaire, par exemple dans le
cas de petites déformations élastiques, ou non linnéaire. Dans ce dernier cas, on distinguera
principalement deux sources de non-linéarités :

- Géométriques, dans le cas de grandes déformations ;

- Matériaux, pour des déformations irréversibles plastiques par exemple.

I1.2.2 Lois de comportement

Elasticité linéaire isotrope

Dans le cas de l'élasticité linéaire isotrope, la relation contraintes-déformations
dépend simplement de deux parametres, le module d’Young E et le coefficient de Poisson v:

(€11 _l Ly v 0 0 0 (011
E E

€22 1E,' 1 v 0 0 0 022

€33 E E E 0 0 0 033
{ V= v v 1 149y 0 3 > (I1.27)

€ T T % 0 023

= OE OE 0 E 1+v
€31 0 0 031
0 0 0 E 14+v
\€1,/ Lo 0 0 0 0 I \0,/

Cette relation, nommée loi de Hooke, peut aussi se résumer sous la forme :

1+v v
e=So0= B J—ETr(a)Id (1. 28)

Le tenseur § d’ordre 4 apparaissant dans cette relation est le tenseur de souplesse : son
inverse, noté K, est appelé tenseur de rigidité.
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II.2.3 Discrétisation et résolution

La méthode de discrétisation par éléments finis est celle la plus couramment
utilisée pour la résolution des problémes de mécanique du solide. Nous renvoyons aux
livres de Ern [22] et Gmur [24] pour une présentation générale de la méthode des éléments
finis.

A l'exception des matériaux élastiques en petites déformations, le systeme
d’équations obtenu par la discrétisation par éléments finis est non-linéaire. Il est dans ce
cas résolu par une méthode itérative, de type Newton. Ainsi, a partir d’'une situation
d’équilibre, les équations sont écrites par perturbation, de maniere incrémentale.

Dans les situations quasi-statiques et élastiques, la variable temps ne joue aucun
role. La discrétisation temporelle pourra donc y étre choisie de maniere arbitraire,
éventuellement de maniere a bien représenter les évolutions de conditions aux limites.

Par contre, dans la situation quasi-statique, le temps intervient dans la loi de

comportement. C’est le cas par exemple des déformations par fluagel.

II.2.4 Les éléments Finis en calcul des structures

Tout ingénieur débutant apprend a calculer les surfaces et volumes de corps de
forme quelconque en les décomposant en un ensemble de corps élémentaires de formes
connues. Plus tard, il applique la méme méthode au calcul de moments d’inertie, de centres
de pression, etc.

Ce mode de pensée est celui qui a donné naissance a la méthode des éléments finis.
Appliquée tres largement au début pour I'étude des structures, elle conquiert sans cesse de
nouveaux domaines : distribution des potentiels électriques, des vitesses des écoulements
de fluides, échanges de chaleur, infiltrations dans les milieux poreux, répartition des
niveaux de bruit, etc.

I1.2.4.1 Présentation générale de la méthode
I1.2.4.1.1 Maillage

Le solide est décomposé en éléments de forme géométrique simple ayant des cotés
communs et dont les sommets ou nceuds sont les points d’articulation de plusieurs

éléments entre eux. Ces nceuds seront les points d’application des forces intérieures ou
extérieures (figure IL.5).

1 Le Fluage est le phénoméne de déformation irréversible di a l'application d’une pression pendant une
longue période ; un exemple de la vie courante est la déformation progressive d'une étagére chargée de livres
pendant plusieurs années.
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L’opération de décomposition est le maillage. Un bon maillage doit faciliter les
opérations prévues par un programme d’ordinateur. Il faut donc adopter une méthode
systématique de numérotation des éléments et des nceuds.

7

/ ~ s

i/ ] '/ o
;’ v —j ¢ \ ! :“ i
5 \J :y,_“; N, ., Ckment
2 .

7 V.. \ V

Y Y Mewd

Z

%

Figure 11.5 — Décomposition d’'un élément de structure en éléments finis

11.2.4.1.2 Méthodes

Deux méthodes sont en usage. Il en existe d’autres mais celles-ci sont les plus
répandues. On en donnera un exemple pour un probleme a deux dimensions.

11.2.4.1.2.1 Premiére méthode

Les nceuds sont numérotés a la suite, de gauche a droite (ou de bas en haut) dans un
systéeme dextrogyre. Une numérotation distincte est utilisée pour les éléments. Elle est de
méme nature que la précédente (figure I1.6). On peut établir des tableaux donnant les
numeéros des nceuds appartenant a un élément (par exemple : élément 3 ; nceuds 3, 4, 8, 9).
Ce systeme est le plus répandu.

@ G @ ®
G | & | & | E
@ G @ ©
0| & | &38| M ™
@ & ® 6

noeud O  éément

Q@ 6

Figure 11.6 — Numérotation des éléments et des nceuds
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11.2.4.1.2.2 Seconde méthode

Chaque nceud et chaque élément sont identifiés par une paire ordonnée de nombres
entiers ou indices (figure I1.7).

- Noeuds : le premier nombre désigne la ligne, le second celui de la colonne.
- Eléments : I'affectation des numéros se fait de la méme maniére.

Chaque numéro a la méme valeur que son nceud sud-ouest, soit le plus pres de
'origine. Exemple : élément 12, nceud sud-ouest (1.2).

Ay

(3.1) (3.2) (3.3) (3.4) (3.5)

[21] [22] | [23] [ 24]
(2.1) (2.2) (2.3) (2.4) (2.5)

[11] [12] [13] [14]

—P X
(1.1) (1.2) (1.3) (1.4) (1.5)
{n. m) nosud 0O élément

Figure I1.7— Autre méthode de numérotation des éléments et des nceuds

I1.2.4.2 Influence de la largeur de bande d’'une matrice

La méthode des éléments finis aboutit a la résolution d’importants systémes
d’équations linéaires.

La méthode la plus commode est la méthode d’élimination de Gauss. Elle consiste a
transformer une matrice carrée en matrice triangulaire qui donne directement les
inconnues.

En outre, les matrices de raideur sont tres généralement symétriques et comportent

de nombreux zéros. Par exemple, sur la figure I1.8, seule la partie hachurée de cette matrice
N x N comporte des éléments non nuls.
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|28

BI
_L — ;},ﬁ.

Figure 11.8 — Largeur de bande d’'une matrice

st cmm—

On note 2B la largeur de bande de la matrice, B est la demi-bande de la matrice.

La largeur de bande du systéme final d’équations est fonction des dimensions de la
matrice des raideurs de chaque élément et du systeme de notation des nceuds. S'il est
possible de réduire la largeur de la bande, on réduit en méme temps le temps de résolution
et la place occupée dans la mémoire de I'ordinateur par la matrice générale des raideurs.

Une des méthodes consiste a adopter une subdivision systématique et un systeme
approprié de numérotation des nceuds. Si ces numéros forment la base de la numérotation
des déplacements nodaux, la largeur de bande de la matrice générale dépend de la plus

grande différence entre deux numéros des nceuds externes pour un seul élément.

Soit D la différence maximale constatée pour tous les éléments de 'assemblage. La
demi-largeur de bande B est alors donnée par :

B=(D+1)f (11.29)

Avec f nombre de degrés de liberté a chaque nceud.
Cette équation montre que le systeme de numérotation doit minimaliser D. Elle fait
aussi ressortir I'importance d’'une variation aussi faible que possible des numéros des

nceuds d’élément a élément.

Un exemple est donné figure I1.9.
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9 10 n 12 13 14 15 16
1 2 3 4 5 6 7 8
@ D=9
5 10 15 20
4 9 14 19
3 8 13 18
2 7 12 17
1 6 " 16
® Do=6

Figure I11.9 — Numérotation des noeuds

Il existe de nombreux programmes d’ordinateur qui assurent l'exécution du

maillage. Un

point essentiel est la numérotation des éléments et des nceuds qui doit

s’'intégrer a la logique du programme de calcul (figure I1.6).

E

VAV

N A A A A A A A A A AV AT A A A AT
A A AT A A AT AT/ A AN A AN AT A AW

o

DASA AT A AT ST AT ASAT
AT AT

AP ATAVAN A A A AT AT AT AT AT A

55

C charge

E  encastrament

Figure 11.10 — Exécution d’un maillage par ordinateur

Vient ensuite le choix du type d’élément. Il doit évidemment satisfaire a plusieurs

conditions :

— bien remplir le solide a étudier ;

— ne pas entralner a des expressions algébriques trop compliquées (calculs longs, donc

coliteux) ;
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— respecter les conditions fondamentales de la théorie de I'élasticité :

e équations d’équilibre ; on doit pouvoir appliquer le théoreme des travaux virtuels ou celui
du minimum de I'énergie potentielle,

e équations de compatibilité ; si I'on emploie la méthode des déplacements, ces équations
sont satisfaites si le champ des déplacements est continu dans le milieu ; il ne doit y avoir ni
trou ni chevauchement.

Le dernier choix est celui du nombre d’éléments. Il est guidé par une connaissance
sommaire du probléme : un maillage serré est tout indiqué dans les zones d’application de
charges, de concentrations de contraintes (variations rapides de section), aux
encastrements, etc.

Il n’est pas interdit de varier la densité du maillage a I'intérieur d’'un méme solide, ni
d’associer des éléments de géométrie différente, a condition que l'on respecte les
conditions qui viennent d’étre indiquées. Dans ce cas, il faut décomposer la structure en
sous-structures.

La figure I.11 donne les éléments le plus fréquemment employés. Dans les
problemes d’élasticité plane le triangle est commode. On le prendra comme base de cet

exposeé.
3
2 4 3
6 2
13 2 - : y
® “ ® ®

3 (@ Elément a une dimension
4, 4 < 3 (® Elément triangulaire
(© Elément rectangulaire
/ 2 @ Quadrilatére
! 1 (® Quadrilataire = 4 triangles

@ 2 @ 2 @ @® Quadrilataire = 4 triangles

Anneau axisymétrique a section triangulaire
4 ® Tétraédre

@® Prisme rectangulaire
3 @ Hexaédre

@ Héxaeédre formé de tétraedres : 3857, 1325, 3825, 3482, 5268.

N

Figure 11.11 — Eléments le plus fréquemment employés
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I.2.4.3 Calculs

Le résultat dont vont découler tous les autres est la matrice des rigidités ou
raideurs du systéme [k ].

Si {Q} désigne le vecteur colonne des charges, u; celui des déplacements :
{Q} = [K] {ui} (11.30)
Le calcul de [k] se fait en deux étapes :
1- détermination de la matrice des raideurs d’'un élément ;
2- détermination de la matrice globale des raideurs du systeme.
11.2.4.3.1 Matrice de raideur d’'un élément

Soit un élément tétraédrique IJKL et, a I'intérieur, un point M de coordonnées
(x,y, z) (figure I1.12).

Comment évaluer les déplacements de ce point M a I'intérieur de I’élément ?
11.2.4.3.2 Choix de la fonction déplacement

Il se fait, évidemment, a ’aide de ses coordonnées.

Mais quelle fonction choisir ?

— Cette fonction doit constituer une approximation raisonnable de la réalité. Elle doit donc
assurer la continuité des déplacements entre deux éléments voisins qui ne doivent ni se
chevaucher, ni laisser de vide entre eux.

— Il existe un grand nombre de fonctions de déplacement possibles.

Toutefois, on préféere les polyndmes, trés maniables sur les ordinateurs et faciles a
dériver ou a intégrer. Ces polynomes devront comporter autant de coefficients que de
points définissant I’élément.

Sil'on veut affiner, ils peuvent méme en comporter davantage.

Exemple :

Probléme a trois dimensions. Elément tétraédrique. Les trois composantes du
déplacement u (x,y, z), v (x,y, z) et w(x, y, z) seront données par les trois équations :
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u(x,y,z) =a; + a,x + asy + a,z
v(x,y,2) = By + fox + f3y + faz (I.31)
w(x,y,z) =y1 +V2X +V3Y +Vaz

Soit, dans un probléeme plan avec élément triangulaire :

u(x,y) = ay + azx + azy
{v(x, y) = By + Box + B3y (1. 32)

Si I'élément est rectangulaire (cotés paralleles aux axes de coordonnées), nous
avons :

u(x,y) = ay + ayx + azy + a,xy

v(x,y) = By + Box + B3y + Paxy (I1.33)

Si 'on veut augmenter le degré du polyndéme, il faut prendre garde aux conditions
d’isotropie géométrique, ou isotropie spatiale ou invariance géométrique.

Cela veut dire que le modele doit étre indépendant de I'orientation du systeme local
de coordonnées. On peut utiliser le triangle de Pascal pour obtenir ce résultat :

1 termes constants
X | Y termes de degré 1
x? xy v* termes de degré 2
x? x? y|xy® v? termes de degré 3

x*x?yx® v xy? v* termes de degré 4

Axe de symétrie

Si 'on prend un terme d’'un c6té de I'axe de symétrie, il faut aussi inclure le terme
correspondant de l'autre coté.

Les coefficients a;, B;,¥; sont dits coordonnées généralisées.

Comme on les ignore, on les calcule en donnant a x, y, z les valeurs que ces variables
prennent aux nceuds.

Pour un probléme a deux dimensions (figure 11.13) :
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Soit, sous forme matricielle :

r U
Uj

( UI = 0(1 + ale + 0(3y1
Vi = b1+ Bax1 + B3y;
U] = 0(1 + azx] + a3y]
V= B1 + Box; + B3y
UK =aq + A Xk + asyg

\ Vg /

\ Vg = B1 + Baxx + B3y

'1 xI )7100 0

1 x500 0

1 x¢y¢0 0 0 _
a0 0 0 ) = Al (@)
00 01xy

0 0 0 1 x¢ yk

Soit, {q} étant le vecteur colonne des déplacements nodaux :

{q} = [A]l {a}

(1. 34)

(11 35)

(11 36)

D’ou les a, vecteur colonne de six coefficients du polynéme: a;, i € (1,3); B; ,i € (1,3):

{a} =147 {q}

X

Z [

0 Y

Figure 11.12 — Déplacement de M en fonction des coordonnées des nceuds

IJKL d’un tétraedre
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11.2.4.3.3 Passage des déplacements aux déformations

On utilise les équations de I'élasticité donnant allongements et glissements :

(. Ou _0v 4 Ju
T ox’ Yo Ty dy
ov ow dv
2. -4 II. 38
1 & 3y’ Yyz 6y+62 ( )
_ow _Ou 4 aw
2 =977 YT 5, ok
Dans le cas d’un probleme plan, I’équation (II. 34) donne :
ou ~ ov_ 6v+6u_ N
Ox_az' ay_'BZ' ox ay—ﬁz as
Onadonc:
()
Ex 010000 |a3|
& ¢=10 00001 B, (1. 39)
Exy 001010 i
2
Bs
ou
{e} = [B] {a} (11.40)

11.2.4.3.4 Passage des déformations aux contraintes

Si la matiére constituant la structure a étudier est homogene et uniformément
distribuée, on a dans le cas de déformations planes :

{o =I[C]{e} (11. 41)

[C] étant la matrice caractéristique des propriétés de la matiere utilisée :

1—-v v 0
E
[C]=(1+V)(1_2v)= v 1-v 0 (11. 42)
0 0 1-2v/2

Avec

E: Module de Young,
v: Coefficient de Poisson.
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En continuant I’étude du probleme plan, pour simplifier :

{0} =0y 0y 1] (11. 43)
D’ou, en remplagant {€} par sa valeur tirée de I'équation (II. 40) :

{o} =[C][B]{a} (1L 44)
Et, d’'apres I'équation (1. 37):

{o} =[C1[B1[A7"]{q} (1. 45)

0 X

Figure I1.13 - Probleme a deux dimensions

I1.2.4.3.5 Matrice de raideur du systéeme

La matrice globale du systéme s’obtient en faisant la somme des forces a chaque
nceud. On relie ainsi entre eux les déplacements des nceuds adjacents.

Lorsqu'on arrive a un nceud ou un déplacement est donné, par exemple
déplacement nul sur un support ou point d’application d’'une force extérieure, on introduit
la valeur correspondante dans la matrice concernée.

Exemple : une matrice simple d’élément étant de taille 6x6, on comprendra que 'on ait
recours a I'exemple de la figure I1.14, assemblage de deux éléments triangulaires a trois
nceuds chacun.

On a vu que la matrice de raideur de I'élément triangulaire le plus simple est une

matrice 6x6 dont les termes sont fonction des coordonnées des sommets de 1'élément et
des caractéristiques E et v de la matiere.
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Figure I1.14 - Assemblage de deux éléments triangulaires

Les notations que I'on va utiliser obéissent aux regles de numérotation ci-dessus :

— les éléments sont notés I et 11 ;
— les nceuds du systéme sont caractérisés par les chiffres 1, 2, 3, 4 ;
— les nceuds de chaque élément sont désignés par i, j, k.

Pour I'élémentlona:

((Q1x ) k11 Kiz ki3 ks kis Kie] (uq
Quy ko1 kay kaz koa kos kog U1
Q2x | — k31 ks k33 ks kss kse i £
QZy kar kay kaz kas kas kue |
Q3x ksy  ksz ksz kss kss kse Lu3)
\ Q3y) Llker kez Koz kes kes kes

(1L 46)
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Chapitre -III-

Validation de bon fonctionnement

des outils de travail

Pour valider le bon fonctionnement de nos outils de travail, on a proposé
pour la partie aérodynamique de simuler numériquement a l'aide de ANSYS
ICEM CFD 13, ANSYS Fluent 13 et ANSYS CFX 13 un cas test de profil NACA
0012 qu’est déja examiné a la soufflerie au sein de centre de recherche Ames de
la NASA.

Nous avons comparé le résultat obtenu par le calcul CFD a un résultat
obtenu en soufflerie par la NASA (Ames Research Center).

Pour la partie structurale, on a proposé de calculer le déplacement d'une
poutre cantilever soumis a une force a son extrémité libre par les codes de

calcul de structures MD Nastran 2010 et MD Patran 2010.

Nous avons vérifié les résultats en calculant la solution analytique par
élément finis.
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III.1 Validation de bon fonctionnement des outils CFD

Notre choix sur le profil a étudier s’est logiquement porté sur le NACA 0012, souvent
considéré comme le profil référence de I'aérodynamique. La série des NACA a quatre
chiffres a été créée par la NACA (National Advisory Committee for Aeronautics, soit
comité consultatif national pour I'aéronautique), 'ancétre de la NASA, dans les années
1930. Les 4 chiffres décrivent la géométrie du profil. Ils utilisent la longueur de la corde de
'aile comme unité. Le premier chiffre donne la cambrure du profil en pourcentage de la
longueur de corde, le second donne la position de la cambrure maximale en dixiéme de
corde, et les deux derniers donnent I’épaisseur maximale du profil en pourcentage de
corde. Le NACA 0012 est donc un profil symétrique d’épaisseur maximale 12% de la taille
de la corde.

Nous avons essayé, certes avec difficultés, de mailler notre profil a 'aide du logiciel
de génération de maillage ANSYS ICEM CFD 13, puis d’utiliser les codes de calcul ANSYS
Fluent 13 et ANSYS CFX 13 pour modéliser le méme probleme et comparer le résultat
obtenu avec I'expérimental fait a la NASA [3].

Les coordonnées du profil est données par une série de points calculée avec un
programme Matlab (voire Annexe B) d’apres la formule du NACA 0012 :

12
y(x) = %( 0.2969 vx - 0.126x - 0.3516 x% + 0.2843 x3 - 0.1015x%) (1. 1)

Les conditions de test :

P0=101325 [Pa] :la pression totale

TO0=311 K: la température totale

M= 0.7 : Le nombre de Mach.

a =1.53°:T'angle d'incidence.

On assimile le gaz a un gaz idéal (y=1.4, R=287 J/Kg K).

Calculs des autres parametres appliqués au simulation numérique :

P _ ¥
?0 = [1+ (Vz_l) MAr-1 (IIL 2)

D’ou : P =73048 Pa : pression statique
To _ Y=1y 3 s2
T - 1+ (T)M (III. 3)

D’ou: T=283.24 K.
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C=./y RT =337.35[m/s].
U=Mc= 0.7 337.35= 236.14584 [m/s]

U=(u=236.0616 [m/s], v=6.3051 [m/s], w=0[m/s]).

III.1.1 Création de maillage structuré autour de profil NACA 0012

On commence notre travail par la préparation des fichiers de coordonnées de profil
NACA d’extension (*.dat) ou (*.txt), c’est-a-dire on met deux fichiers, le premier représente
I'extrados et le deuxieme représente l'intrados. On ajoute en téte de chaque fichier le
nombre des lignes et des colonnes pour que ANSYS ICEM CFD 13 construit directement la
courbe qui lie les points des coordonnées.

.

mj * extrados.txt - Motepad2 = S| —S—
File Edit View Settings 7
D E R EH| D & @A B Q| @ R
.
4 1.0000 0 0
L 0.9984 0.0015 Q0 = I
6 0.9935 0.0022 0
7 0.9855 0.003232 0
8 0.9743 0.0048 0
3 0.9600 0. 0067 0
10 0.9427 0. 0090 Q0
11 0.9226 0.0116 0
12 0. 8997 0.0145 0
13 0.8743 0.0176 0
14 0. 8464 0.0210 0
15 0.8162 0.0244 0
16 0.7840 0.0280 o]
17 0.7300 0.0316 0
1s 0.7143 0.0352 0
19 0.6773 0.0388 0 A
. M S04 M AATD Cat
« [T »
Ln2:44 Coll 5el0 143 Ko AMSEI CR+LF IN5 Default Text

Figure II.1 - Préparation de fichier des coordonnées de profil NACA 0012

Pour importer les fichiers on clique sur FILE > Imoprt Geometry > Formated Point
Data, on spécifier chaque courbe et points par des noms convenables (Ex:
Courbe_Extrados, Point_Intrados).
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Fle| Edt View Info Seftings ‘Windows Help

&

ook 0k 1 Do |

Mew Project...
T Pl;‘w K3 (X | Geomelty | Mesh | Blocking | EditMesh | Propeties | Constraints | Loads | Selve Optians | Outout | CatdD | Pastprocessing |
wordes.  R@ VP HEBSERXRBEX |
Save Praject As...
Close Project.
Change Warking Dir.. AN S \/g
Geomelry r LS LS
Mesh 13
Blocking 4
Adtibutes v
Parameters v
Cattesian v
Fresults v
4 ICEM CFD Mesh
Import Mesh b Mastran
Export Geomelry b Patian
Export Mesh ¥ooSTL
‘wiorkbench Readers WRML
Plot3d
Feplay Scripts » ° 1
Exit Fihino 30M -
P! Adis 2
dat:
ata CATIAVA | ¥
Input File g =
I— COMAE [+]
FantPart [P Dyug
CuvePart [T GEMS
2]
Surace Part [51] P
Poirt Prefix [or|  sTEPAGES )
BYMCIN P Formaited poit dete 3
Reference geometry || -
Sutscs P [ 38 praserbed s
ProE Curent Conrdinate system is global
¥ Import Paints Solidworks EI
¥ Import £ UG -
pe v o I” Log Save| Clear

Figure 111.2 - Importation de fichiers des coordonnées de I’extrados et

I'intrados de profil NACA 0012

On créé des points par Geometry > Create Point > Explicite Cordinate sur
lesquels on construit les points de Farfield, puis on les raccorde et on construit une

surface a partir des courbes de Farfiled on le nome FLUID.

File Edt “iew Info  Settngs ‘Windows Help

= B EEEE|
B oA E R

CIESSEX XA X

Gecmety | Mesh | Blacking | EdtMesh | Propetties | Constiaints | Loads | Salve Options | Output | CaitaD | Postprocessing |

s

& Geometry
0 Subsets

W Curves
O Sufaces
W Parts

Create Point /

Part [GEOM

Explidit Locations

Method [Create 1 point

®[le /

vio B

89 prescribed points

-l

aits
| | Cunent Coordinate system s giobal

21 e s o

app [0k | Dismiss |

Figure II1.3 - Création de domaine de calcul (Far Filed)

Pour la création des blocks on clique Blocking et on choisit FLUID dans la case Part
et sous Initialize Blockson choisit le de type 2D Planar. Pour associer le block au Far
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Field, on clique sur Association > Association Edge To Curve, puis on clique les cotes de
block, puis on sélectionnant Edge(s) et les courbes de Far Field, on sélectionnant Curve(s),
puis on clique sur Snap Project Vertices , puis sur OK.

Fie Edt Wiew Info Selings ‘windows Help I
[ﬁ| e Eenmetly | Mesh EditMesh | Propertis | Conshaints | Loads | Solve Opfions | Dutput | Cat3D | Postprocessing |

-mgwmae ElbAgasoxoaaen |

ﬂ’ Geometry
1 Subzets

L& Sufsces

B Blocking

o Parts

|- COURBEEXTRADOS
|- COURBEINTRADOS
| FARFILEDENTREE

& FARFILED-SORTIE

& FLUD

& GEOM

=

o F‘UINTS INTRADOS

Create Block

Pait [FLUID

|- Create Block

ke

Initialize Blocks

Type |20 Planar | =] - &
Tniialios blocking
¥ Initalize wih settings iaes Hagking ghne j

| e e

Apply Disis |

Figure I11.4 - Création du block sur le Far Filed

File Edit Yiew Info  Seftings ‘Windows Help o

=B o~
o CEMENTT )

Bl Model
i Geomely
01 Subsets
W Points
W Curves
0 Sulfaces

Geomelyy | Mesh EdtMesh | Prapeties | Constiairts | Loads | Soive Options | Output | Car3D | Postprocessing |

FoiHalr oxsaae® |

Blocking Associations

2
?ﬁ@?@’% J’ =
FOK W :
iate Edge -> Curve
Edgels]l—vﬁs ‘ ‘ o
et [ & b
I~ Project verices
™ Project to surface intersection
I Praject ends to curve intersection
Undloof prject_te_sulace complte =]
Hlready in select edge mods]

" Log Save| Clear

(£l

oy || 0k | piemiss |
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Fie Edt View Info Selings ‘wWindows Help

= BEEE o | Geoney |Mesh EditMesh | Propeties | Constiainte | Loads | Salve Options | Qulput | CaniD | Pestprocessing |
BOREE Q@ ¢ bLHa oXeeaes

Blocking Associations ]

e
:}Jaiﬁlyeg .

Edge > Curve
Edgels) 'fs .. [+
Curvels) @

™ Project vertices

™ Project to surface intersection

™ Project ends to curve intersection

s

LT Already in select edge mode! |
Fledo of project_to_surface complets

=l rLugﬁlﬂl

ok | Dismiss |

Figure IIL.5 - Association de block avec le Far Filed

Pour la spécification des tailles des mailles on clique sur Menu > Mesh > Part Mesh
Setup, on entre les tailles Voulus.

Fie Edt View Info Selngs windows Help =
=2 ﬂ[&@| £ O | Geomety Blocking | EditMesh | Fropertes | Constaints | Loads | Save Options | Duput | CandD | Postprocessing |
o ALE QR Mt o\ @ |

e ‘ T Part Mesh Setup — | ANS\,S

COURBE-EXTRADOS |

COURBE-INTRADOS ]

FARFILED-ENTREE (] 01
]
]

FARFILED-SORTIE
FLUID
GEOM

POINTS-EXTRADOS

POINTSIMTRADOS -
<« | »

¥ Show size params using scale factor

[~ pply inflation parameters to curves

[~ Femove inflation parameters from curves

Highiighted parts have at least one blank field because not all entiies in that part have identical parameters
I Apply Il Dismiss |

Already in select edge mode! =l
Redo of pioject_to_suface complete

I Loa Save| Clear

Figure I11.6 - Spécification des tailles des mailles pour chaque famille (Parts)

Pour créer un autre block similaire au premier, on clique sur Split Block > Ogrid
Block > Select Bloks(s) +, et pour la prolongation de ce block jusqu’a la sortie de Far Field,
on clique sur Select Edge(s)+, puis sur la cote de sortie de 1¢r block.
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File Edit Miew Info Setngs Windows Help

= El@| £ (A | Goomely | Mesh EditMesh | Piapetliss | Conslraints | Loads | Solve Options | Output | Cat3D | Postprocsssing |
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\

Figure I11.7 - Création d’'un nouveau block dans le Farfiled

Pour décomposer le block, on clique Spilite Block, On choisit Split Method >
Prescribed Point, apreés on clique sur Edge et on sélectionne la cote de 2¢me block, ensuite
on sélectionne le bord de fuite puis en cliquant sur Point.
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ICEMCFD130: - —— X - (= [ s
Fle Edi View Info Sefings ‘Windows Help e

== ggﬁ‘ ¥ 0| Geomety | Mach Edi Mesh | Froperties | Conshaints | Loads | Schve Options | Duiput | Cat3D | Postprocsssing |
BOLRE Q@ JERAISOXPVEEH |

CHid Model

i Geomely
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' Curves
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i Blocking
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—Split
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" os Save] coal

ooy || 0k || Diswiss |

Figure 111.8 - Décomposition des blocks

On supprime le block qui contient le profil pour qu’on puisse rendre notre profil
vide, c'est-a-dire on enleve une portion de surface (FLUID) qui appartient le profil on utilise
I'option Blocking > Delete Block, puis on clique sur le block voulu.

Fle Edt View Info Seitings ‘Windows Help =

=& ﬂl@‘ ¥ (A | Geomely | Mesh EdiMesh | Propetties | Constiaints | Loads | Solve Dptions | Output | Cat3D | Pastprocessing |
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Figure I11.9 - Suppression de block

Pour associer le profil avec le Block, on clique sur Association > Association Edge
To Curve, on clique sur Edge(s) et on sélectionne les cotes de block, puis on clique sur
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Curve(s ) et on sélectionne les courbes de profil, apres on clique sur Snap Project Vertices,
puis sur OK.

Fle Edt View Info  Setings ‘Windaws Help =

= B | o o
BOAEE|RR
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Figure 111.10 - Association des cotes de block avec les courbes de profil

On fait la translation des points par 'option Move Vertex, et on bouge les points du
block comme l'indique aux figures.

- - I NSRS S S - . - = "
Fle Edt View Info Seltngs Windows Help &
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— Move
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I~ Fix 1
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=] " Leg Save| Clear
Apply D‘SW‘SSI

Figure 1111 - Translation des points convenablement au profil
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On utilise le menu Blocking > Collaps Blocks pour qu’on rend les deux cotes des
Block unis, on sélectionne la cote intermédiaire des deux cotes de block puis la surface
formée entre eux, d’ou elle devient comme le montre la figure IV.11.

Fle Edt View Info Seflings ‘Windows Help
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¥
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Undo of mark_blocks complete:
Undo of mark_blocks complete: j

M Log sare] o]

ooty || ok | Dismiss

Figure I11.12 - Union des deux cotes de block
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Pour spécifier le nombre des nceuds sur la cote et la distance entre chaqu’'une, on
choisit le menu Pre-Mesh Params > Edge Params, et on sélectionne la cote puis en regle
les autres parametres.

Wy ICEM CFD 130

Fle Edit View Info Selings Windows Help

=0 gg[ﬁ\ £ CX | Geomety | Mesh |Bluckmg| Edi Mesh | Propeniies | Constisints | Loads | Solve Options | Duput | CandD | Pastprocessing |
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’,E by |1 Tde ot aliapse._blocks complete =]
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Method [To Ml ParsllslEdges == =) Unda of mark_blacks complete
™ Log Save| Clear

oy |0k ] pismiss |

Figure 111.13 - Spécification de nombre de nceuds pour chaque cote des blocks

On créé un autre block pour le but de raffiné le maillage au tour du profil. Pour cela
on utilise 'option : Blocking > Split Block, puis on sélectionane la cote (Edge).
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=

&

Fle Edt View Info Sefings ‘windows Help

== ﬂmﬁ‘ ) OA | Geometry | Mesh EditMesh | Propetiss | Constraints | Loads | Solve Options | Output | Cat30 | Post-pracessing |

BOREE Q@ dEHparoxsaaeR
|J¢owxfa&

Split Block 7]

— Spiit Block -

[
Oy

Split Block

Block Select
’7"‘- Allvisble  © Selected

Block. &

(Eetzp S Max:BED |
Copy distibution om nearest

I Garalel ecige Split value: -1 j

I™ Project vertices

— Split Method || T Loa Save| Clear

|App|y || ok | Dismiss |

Figure 111.14 - Décomposition de block pour le but de raffinage des
mailles au tour de profil

Pour spécifier le nombre des nceuds sur la cote et la distance entre chaqu’'une, on
choisit le menu Pre-Mesh Params > Edge Params, on sélectionne la cote puis en regle les
autres parametres.

ADOL
Fie Edt View Info Selings ‘Windaws Help

= B EEE 5~
el CEA =] 2}

Geometly Mesl’\ IB|ﬂDk‘nQ|EdllMesh Propemes Eur\stlamls Loads SD\veUptmns Uutput]tertaD Postprocessmg

@@&@@?@ﬂ:!ﬂ@@

Pre-Mesh Params Ll
—Meshing F 5

L4 NS

Edge =
Length

Hodss El
Meshlaw [BiGeometic ]
spacngl [ |
I Sp1 Linked Select| Fleverse N
Raicl 2| I
spacna2 [ | | °
I Sp2Linked Select | Reverse
Raicz 2 |
MaxSpace [ |
I~ Spacing Relative
I Modes Locked Max: 660 =
I~ Parameters Lacked Spit vale: 1 j

¥ Copy Parameters
—Copy || T Loo Save| Clear
spp [0k | pismiss |

Figure 11115 - Spécification de nombre des nceuds

Maintenant on convertie le Pre-Mesh en Mesh, on clique par le bouton droit de la
souris sur Pre-Mesh et on sélectionne Cenvert To Unstruct Mesh.
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Concernant I'orthogonalité du maillage sur les courbes d’extrados et d’intrados, on
utilise le menu Edit Mesh > Smooth Hexahedral Mesh Orthogonal, puis sous l'option
Release Orthogonality > Initial Height Option, on sélectionne les courbes d’intrados et
d’extrados, apres on entre la tolérance d’orthogonalité (ici : 0.005).
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Figure 11116 - La discrétisation du domaine de calcul

ICEM CFD 12.0: NACADO
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Figure I11.17 - L’'orthogonalité de maillage sur le profil

Pour l'enregistrement de maillage sous l'extension (*.msh), on utilise I'option
Write Imput trouvant dans le menu Output, un fenétre Save apparait et on clique sur
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Yes, puis on ouvre le fichier (*.UNS) a partir du projet, une autre fenétre apparait et on
choisit 2D, puis on clique sur Done, le nom de fichier enregistra par défaut sous le nom
(Fluent.msh) et on le trouve enregistré dans le méme lieu que le projet.
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Figure 111.18 - L’enregistrement de travaille.

II.2 Simulation numérique de profil NACA 0012 avec ANSYS CFX 13
II1.2.1 Pré-Processing et Importation du maillage

a- Onlance le Workbench de ANSYS 13 et on sauvegarde le projet sous un nom choisit.

b- Onlance le CFX-pre e ton double clique sur configuration.

c- On clique par le bouton droit de la souris sur Mesh et on sélectionne Import Mesh
> FLUENT.

d- On appelle au fichier du maillage généré par ANSYS ICEM CFD 13 de profil
NACAO0012, apres on clique OK.
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Figure I11.20 - Importation de maillage dans ANSYS CFX13

Remarque : ANSYS CFX 13 ne travail pas avec les maillages 2D, pour cela il ajoute un
élément d’épaisseur pour ces types de maillage par défaut pour les rendre en 3D.
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II1.2. 2 Modification des propriétés de fluide

On double clique sur Default Fluid puis dans I'onglet Basic Setting on choisit Air
Ideal Gas sous Material et on fixe la pression de référence (Reference Pressure ) a
73048 [Pa]. On clique sur 'onglet Fluid Models et on choisit Total Energy sous Heat
Transfer > Option, apres on active Incl.Viscous Work .Term et pour le modeéle de
turbulence on choisit Shear Stress Transport sous |'option Turbulence > Option, puis on
clique OK.
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Figure 111.21 - Modification des propriétés de fluide

I11.2.3 Les conditions aux limites

I11.2.3.1 La condition d’entrée

On insert une novelle condition aux limites appelée (entree) en utilisant Insert >
Boundary > puis on entre le nom (entré) et on clique OK.

Dans 'onglet Basic Setting, on spécifie le type de condition aux limites Boundary
Type a Inlet, puis Location a Farfiled entree. On passe a 'onglet Boundary Details et on
entre les composantes de vecteur vitesse (u= 236.061 [m/s], v=6.3051[m/s], w= 0[m/s])
sous Mass and Moentum > Option > Cart.Vel. Components, et on entre les parametres de
la turbulence sous Tubulence > Option > Inensity and length Scale 0.01% pour
Fractional Intensity et 0.02 pour Eddy Length Scale, puis la valeur de la température
statique 283.24 [K].
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Figure I11.22 - Spécification de la condition d’entrée

I11.2.3.2 Condition de sortie

On insert une novelle condition aux limites appelée (sortie) en utilisant I'option
Insert > Boundary > , puis on entre le nom (sortie) et on clique sur OK.

Sans 'onglet Basic Setting, on spécifie le type de condition aux limites Boundary
Type a Outlet, puis Location a Farfiled sortie, puis on passe a 'onglet Boundary Details
et on entre la pression relative 0 [Pa] sous Mass and Moentum > Option > Average

Static Pressure.

P absolu =P référence + P relative
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Figure 111.23 - Spécification de la condition de sortie

I11.2.3.3 La condition a la paroi (profil)

On insert une novelle condition aux limites appelée (Airfoil), en utilisant Insert >
Boundary puis on entre le nom (Airfoil) et on clique sur OK.

Dans 'onglet Basic Setting, on spécifie le type de condition aux limites Boundary
Type a Wall puis Location a Courbe extrados (ici, ANSYS CFX 13 a pris tout le profil sous
le nom courbe extrados), puis on clique sur OK.
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Figure 111.24 - Spécification de la condition a la paroi
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I11.2.3.4 La condition aux faces

On insert une novelle condition aux limites appelée (Symetriel), en utilisant
I'option Insert > Boundary, puis on entre le nom (Symetriel ) et on clique sur OK.

Dans 'onglet Basic Setting, on spécifie le type de condition aux limites Boundary
Type a Semmetry puis Location a Premetive 2D, puis on clique sur OK.

File FEdit Sesson Insert Tools Help

FEhwm o Lo XEMLs OF Sk eapil, hARE

Boundary: symetrie 1
Detals of symetriel in fluid in Flow Analysis 1

Basic Settings ‘

Boundary Type Symmetry
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10.000 (m)

Lo [ wov |[ oo

Specify a value or pick from the viewer

Figure I11.25 - Spécification de la condition aux faces

On refait la méme chose pour Premetive 2D B maison le nome Symetrie2.

II1.2.4 Solver control
1. Ondouble clique sur Solver Control trouvant dans I'arbre d’ensemble Outline Tree
2. On fixe Residual Target a 1e-4.

3. Onclique sur OK.
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Figure I11.26 - Réglage des commandes des résidus

II.2.5 Solver Manager

1. On ferme CFX-Pre et on passe a la fenétre de projet Workbench

2. On sauvegarde le projet.

3. Maintenant on double clique sur Solution dans le schéma de projet pour démarrer
le Solver Manager.

4. Quantle Solver Manager ouvre, on clique sur Start Run

5. Quant la solution converge, on ferme le Solver Manager et on retourne a la fenétre

de projet.

6. On enregistre le projet.
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Figure 111.27 - L’évolution des résidus

I11.2.6 CFD-Post

On visualise les résultats en CFD-Post par le double cliquage sur Resultats trouvé
dans le schéma de projet dans le Workbensh.

1. pour insérer le contour de pression statique on clique sur et on le nomme

Contourl.

2. onclique sur [Z] , apres on sélectionne Symetriel .
on fixe Variable a Pressure.
4. onclique sur Apply.

w
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Figure 111.28 - Insertion de contour de pression statique

Pour dessiner la courbe qui représente la distribution de coefficient de
pression autour de profil alors on est obligé de créer des variables Cp, alors qu’on suit les
étapes suivantes.

On crée une Polyline en utilisant Insert > Location > Polyline et on laisse
son nom par defaut Polylinel, puis on choisit Boundary Intersection sous Method et on
fixe Boundary a Airfoil et Intersect With a Symetriel.
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Figure I11.29 - Insertion d’'une POLYLINE
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On crée maintenant les expressions, on clique sur Expression et on le nomme
U (vitesse uniforme) et on entre 236.1458 [m s”*-1] sous l'option Definition, puis on
clique Apply, ensuite par la méme procédure on crée une nouvelle expression appelée cP
et on entre Pressure/(0.5*massFlowAve(Density) @entree*U”2) sous Definition et on

clique Apply.

File Edit Sesson Insert Tools Help

BERDE@ 96 Buem - AREF 5 N0 y[HEEES Oms / AOHE D
Outine | Variables | Expressions | Calculators | Turbo |
4 (] Expressions

[fe] Accumuilated Tme Step 29

Current Time Step 2
Reference Pressure 73048 [Pa]

Sequence Step 2

Time 0fs]

u 236,1458 [m s~-1]

atstep Accumulated Time Step

- massF

cistep Current Time Step

sstep Sequence Step

t Time
4 i, ]
Detsils of cP

| Definiton | [ Piot | Evaluate
[ oenired |

Value <variable >

]

3D Viewer | Table Viewer Chart Viewer Comment Viewer | Report Viewer

Figure I11.30 - Insertion d’une expression

On insert un nouveau variable appelé CP en utilisant Inset > Variable, et on
fixe Method a Expression et on sélectionne cP, puis on clique Ok.
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Figure I11.31 - Insertion de variable

-96 -



Chapitre III

Validation de bon fonctionnement des outils de travail

Et pour régler les parametres de graphique on utilise 'option Insert > Chart,
sous l'onglet General, on fixe XY sous Type, puis sous l'onglet Data Series on ouvre une
nouvelle Serie, on fixe location a Polyline1, sous I'onglet X Axis on change Variable a X, et

sous l'onglet Y Axis on change le variable a CP et on clique Apply.
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Figure 111.32 - Procédure a suivre pour le dessin de la courbe

des coefficients de pression

-97 -




Chapitre III Validation de bon fonctionnement des outils de travail

CFX - CFD-Post.
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Figure 111.33 - La courbe des coefficients de pression

Et pour exporter les coordonnées de coefficient de pression en fonction de x
(x(m), Cp) on clique sur Export et on choisit text (*.dat) sous Files of Type.
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Figure 111.34 - Exportation de fichier des coordonnées (x(m), Cp)
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VI1.2.7 Validation du travail réalisé avec ANSYS CFX 13

Pour valider notre travail, on compare la courbe de coefficient de pression obtenue
par ANSYS CFX 13 avec celle de 'expérimentale faite au centre de recherche Ames de la
NASA.

On trouve que les courbes sont presque confondues, alors on peut dire que notre

installation de I'outil (ANSYS CFX 13) est validé et on peut compte sur notre ANSYS CFX 13
installé sur nos matériels informatiques dans les futures calculs.

I

Cp-Profil-CFX
#  Cp-Extrados-Expremental
+  Cp-Intrados-Expremental

. 08
K(corde) [m]

Figure 111.35 - Comparaison entre la simulation numérique avec ANYS CFX 13
du profil NACA 0012 avec 'expérimental faite au centre de recherche AMES NASA

II.3 Simulation numérique de profil NACA 0012 avec ANSYS FLUENT 13

II1.3.1 Lancement du Fluent sous Workbench :

1) Onlance le Workbench de ANSYS 13 et on sauvegarde le projet sous un nom

2) Dans la boite d’outil on choisit le menu systéme de composants apres on double
clique sur FLUENT pour qu’il s’ouvre au schéma de projet, deux choix vont
apparaitre :

a- Configuration
b- Solution

3) Onlance le FLUENT et on double clique sur configuration.

4) On choisit 2D sous Dimension et on clique OK.
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Figure 111.36 - Lancement d’ANSYS FLUENT13 dans le Workbensh.

I11.3.2 Importation du maillage :

1. Sous le menu File de Fluent on sélectionne Import > Mesh

2. Onappelle au fichier de maillage généré par ANSYS ICEM CFD 13 eton clique OK.

3. Apres la lecture de maillage

on le contréle par Mesh>Check option Ou par

l'utilisation de Check sous Problem Setup > General. Ceci permet de vérifier si le
maillage importé ne contient pas d’erreurs ou de volumes négatifs.

4. On sélectionne Density-Based (compressible) et Steady (permanent)

dans Problem Setup > General > Solver.
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AFLUENT FLUENT [2d, dl 0
Fie] Mesh Define Solve Adapt Surface Display Report Parallel View Help
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Save Project

Read >

Write 3

S T Y|

Tmport ] | L_Mesh... |
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Interpolate... Cose & Data..
EM Mapping » ABAQUS »
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FIDAP...
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e
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PTC Mechanica Design... AMSYS FLUENT 13.0 (2d, pbns, lam)
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Figure 111.37 - Importation de maillage dans 'ANSYS FLUENT 13

I11.3.3 Choix du Models

On spécifie 'écoulement turbulent de model Sparlart-Allmaras (leqn) utilisant
Problem Setup > Models > Viscous On double clique sur la derniere et on sélectionne
Sparlart-Allmaras (1leqn) puis on choisit 'option Strain/Vorticity Based et on clique OK.

On active I'équation d’énergie car I'écoulement est compressible cliquant sur Energy > On

0% AFLUENT FLUENT [2d, dbns imp, S-A] [Al e —— [STa =
File Mesh Define Solve Adopt Surface Disply Report Parallel View Help

E-A-@e|cFaa e pE-o-]
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Boundary Conditions Heat Exchanger - Off ode! Model Constants
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Reference Values Acaustcs -0 ol 0.1355

St [© Spolart Almaras (1 eqn
o ethods TEEmE @
Solution Controk () k-omega (2 eqn) ’05227

clution Cantrols ) Transition k-+-omega (3 eqn)
?:I:fn,;slnmahzanun 8 ;’:;ﬁ:: ssjls(:éq::n) B
Calelation Actiiti 71
alculation Activities () Seale-Adaptive Simulation (SAS)

Run Caleulation

Results Spalart-Almaras Production G

0.3
Graphics and Animations ) Vartidty-Based r -
Plots © Stan/Vortity Based
Reports User-Defined Functions
palart-Almaras Options.
Turbulent Viscosity
ptions
=1

Mesh May 30 2011
ANSYS FLUENT 13.0 (2d, pbns, lam)

Domain Extents:
%x-coordinate: min (m) = -5.999799e+06, max (m) = 6.060600e+00
y-coordinate: min (m} - -6.008080e+08, max (n) - 6.008680e+00
Uolume statistics: u
minimum volume (m3): 1.444426e-06

Figure 111.38 - Fixation de modéle de la turbulence
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II1.3.4 La matiere (Materials)

On définie la matiere en utilisant Problem Setup > Materials
1. Onclique sur Air pour ouvrir la fenétre Create/Edit Materials

2.

On change Density a Ideal-Gas et Viscosity a Sutherland veut dire que le gaz est
obéie alaloi dela température.

On clique sur Change/Create.

&= A:FLUENT FLUENT [2d, d

Y
File Mesh Define Solve Adapt Surface Display Report Parallel View Help
ErE @O S[FAaa s e E-0-
Problem Setup Materials
General Mmaterials
Flud
Soid
Cell Zone Conditions aluminum
Eoundary Conditions
Mesh Interfaces Create/Edit Materials
Dynamic Mesh
Reference Values HName Material Type
Solution air [ﬁwd
Solution Methods
Solution Controls Gizoz Fronn FLUENT Fluid Materials
Monitars = ) [ FuETDstebese ..
Solution Initialization o [UserDefined Datebase... |
Calculation Activities
Run Calculation [none 5|
Results roperties
Graphics and Arimations Density (ka/m3) [ e, | S
Fots Jseates | ][ ede..
Reports ‘
Cp (SpedificHeat) (A0 [constant =) (Edt.. ]
i ‘lﬂﬂﬁ.43
! Thermal Conductty (WM [constont ) Ceae.. |
‘u.nzu
Viscosty (o) ] - CEdte. May 30 2011
‘ ANSYS FLUENT 13.0(2d, phns, lam)
[chengefcreate] [ Delete | [ close | [ Hep ] -000060e+00
= —— = .8000080e+00 -
minimum volume (n3): 1.h44426e-86
v

Figure 111.39 - Définition de la nature de fluide

II1.3.5 La condition de zone (Cell Zone Conditions)

Sous Problem Setup > Cell Zone Conditions on clique sur Operating Conditions...
et on fixe Operating Pressure (Pascal) a 0

Pression absolut = Pression gaug + Pression operating

% Operating Conditions [Z]

Pressure Gravity

Operating Pressure (pascal) | | [] Gravity

° |

Reference Pressure Location ]
s |
s |
o |

[Lox | [cancel] [Hel |

Figure 111.40 - Operating pressure
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II1.3.6 Les conditions aux limites (Boundary Conditions)

II.3.6.1 La condition d’entrée

Pour Farfield-entrée on choisit le type de condition aux limites Pressure-Far-Field
et on clique sur Edit, puis on entre les valeurs indiquées dans les figures.

AFLUENT FLUENT [2d, dbns imp, S
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Graphics and Animations
Plots
Reports
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Figure 111.41 - Spécification de la condition d’entrée
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II11.3.6.2 Condition de sortie

Pour la condition de sortie c’est semblable avec la condition d’entrée. On refait le
méme travail.

Et pour les autres Zones, on laisse les autre parameétres (courbe-extrados, courbe-
intrados) par défaut (sont définies comme Wall).

II1.3.7 Reference values

On prend les parameétres d’entrée comme des valeurs de références Problem
Setup > Reference values et on choisit Farfiled-entrée sous Compute From.

Y AFLUENT FLUENT [2d, dbns imp, S-A] [A
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.
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¥
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created new zone courbe-extrados:003 from courbe-extrados
created new zone courbe-extrades:882 from courbe-extrados
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nerged zones into courbe-extrados:@e2.

Figure 111.42 - Spécification des valeurs de référence

I11.3.6.8 Commande de la solution (Monitors)

Pour la commande des résidus on utilise Solution > Monitors
a. Ondouble clique sur Residuals.
b. Onactive Plot sous Options.

c. On spécifie le critere de convergence absolu (Absolute Criteria ) a 1e-3.
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Figure 111.43 - Commande des résidus

I11.3.6.9 Initialisation de la solution (initialization)

On utilise Solution > Monitors > Solution Initialization

1) On sélectionne Farfield-entree sous Compute From
2) On clique sur Initialize pour initialiser la solution.
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Figure 111.44 - Initialisation de la solution
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I11.3.6.10 Lancement de calcul

a. Pour démarrer la solution on utilise Solution >Run Calculation

b. On entre 1000 pour le nombre maximal d’itérations ( Number of Iterations ) et
on active Solution Steering et on choisit Transonic sous Flow Type et on clique
sur Calculate.
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Figure 111.45 - Lancement de calcul de la solution

II1.3.6.11 Visualisation des résultats

Pour la visualisation de contour de pression statique sur le profile on utilise Display
> Graphics and Animations et on double clique sur Contours une nouvelle fenétre s’ouvre
on sélectionne Pressure sous Contours of et Static Pressure en suite on clique sur
Desplay.
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Figure 111.46 - Procédure a suivre pour la visualisation de contour de pression

Figure 111.47 - Contour de pression statique autour de profil

Et pour la visualisation des courbes de coefficient de pression sur l'extrados et

I'intrados de profil NACA 0012, on clique sur Plots > XY Plot et on sélectionne Pressure
sous Y Axis Function et Pressure Coefficient , puis on sélectionne “Courbe-extrados” et
“Courbe-intrados”, aprés on clique sur Plot.
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Figure 111.48 - Procédure a suivre pour visualiser courbe de coefficient de
pression dans ANSYS Fluent 13
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Figure 111.49 - Courbe de coefficient de pression dans ANSYS Fluent 13

Et pour exporter le fichier des coordonnées de coefficient de pression sur I'extrados
et I'intrados de profil on active Write To File puis on clique Write et on choisit le lieu
d’enregistrement de fichier des coordonnées (x(m), Cp).
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Figure 11.50 - Exportation de fichier des coordonnées (x(m), Cp)

111.3.6.12 Validation du travail réalisé avec ANSYS FLUENT 13

Et pour valider notre travail on compare la courbe de coefficient de pression
obtenue par ANSYS Fluent 13 avec celle de I'expérimental fait aux laboratoires de NASA. On
trouve que les courbes sont presque confondues, alors on peut dire que notre outil est

validé et on peut compte sur notre

ANSYS Fluent 13 installé sur nos matériels
informatique dans les futures calculs.
15 T
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Figure l11.51 - Comparaison entre la simulation numérique avec ANSYS FLUENT 13
du profil NACA0012 avec l'expérimental fait au centre de recherche Ames.

-109 -



Chapitre III Validation de bon fonctionnement des outils de travail

Remarque : On a vérifié que Les deux cas précédents (test avec ANSYS CFX 13 et ANSYS
Fluent 13) sontvalidés par l'utilisation de maillage 2D de profil NACA généré par le logiciel
de maillage ANSYS ICEM CFD 13, d’ou on peut dire aussi que notre manilleur ANSYS ICEM
CFD 13 est en bon fonctionnement sur notre matériel informatique.

II.2 Validation de bon fonctionnement des outils CSM (MD Patran et
MD Nastran)

Pour valider les outils de travail de calcules des charges structurales, on a choisi le
probleme de 'RDM suivant :

Probleme:

Calculer le déplacement d'une poutre a section rectangulaire soumis a une force de
10 livres a son extrémité libre. Ces dimensions du faisceau de 12 "x 1" x 0,1 ". La poutre est
construite d’'un matériau isotrope avec un module d'élasticité de 30 x 106 psi et un
coefficient de Poisson de 0,3.

Matériau : Steel (Acier)

E = 30ehk
v=1073

L2 ————— T

Figure I11.52 - La poutre soumise a une force de flexion

Etape 1 - Création d’'une nouvelle base des données Patran (database) :

- OnClique sur New de menu File.

- Onnomme la nouvelle base des données comme : Poutre_Flexion, puis on clique
OK.
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) ) 2 5 )| e o) ) o ) ) ) 4 ) 0 ) |Tﬁ|‘
(B[ 8] o TR LR [ | e | o ol el (gLl om ] —

Defaults N New Database

DE AR
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Change Template ..

Modify Preferences...

Set Working Dirzctory to Database Location

T 3 cf B8

Nom Moadifié le

_
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1
Mom du fichier : | |puulreﬂamundh I oK

Types de fichiers [ Database Fies &db} | Cancel
WD masoan enabled
I

]

For Help, press F1

Figure 1153 - Création d’'une nouvelle base des données Patran

Etape 2 - Création de la géométrie de poutre a partir des données de probléeme

Sous l'onglet Geometry , on clique sur Surface et on sélectionne XYZ.
Maintenant on entre les cotes de la surface rectangulaire <12 1 0> sous l'option
Vector Cordinate List, puis on clique Apply

B Patran 2010.2.3 (Student Edition)

i File Group Viewport Viewing Display Preferences Tools Help Utilities

LD= 84K
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Home Properties  loads/BCs  Meshing  Analysis  Results

_ 4 I | I | (-‘ | | & | *T5 = # #
@ —~ | = ||~ = | o ¢[wal ) o
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- D o =]
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Figure l11.54 - Création de la géométrie de la poutre

-111-




Chapitre III Validation de bon fonctionnement des outils de travail

Etape 3 - Création du matériau isotrope (Elastic Modulus = 30x10¢ et Poisson Ratio =
0.3):

- Sous l'onglet Properties, on sélectionne Isotropic.
- Onentre le nom du matériau (Acier), puis on sélectionne Input Properties
- Onentre le module d’Young (30x10¢ ) et le coefficient de Poisson ( 0.3 ), on clique

sur OK, puis sur Apply..
i File Group Viewport Viewing Display Preferences Tools Help Utilities New Model Preference | Materias | *\
0 -~ M
Home  Geometry | Properties | loads/BCs  Meshing  Analysis  Results T
SE= B8 Input Options Obit  [ssiope ]
@ | m N CEDD | ol [ leorope_~
. . =< r= - Constitutive Mode Linear Elastic - Nethod: Manual Input -
oY £l || Fluid ||| (22| [ds ]| 20| %] |67 (8| ||| |||
Isotropic ||Qrthotropic/|Anisotropic/ | Fluid Compasite (0D Properties 1D Pre
p p p p p Property Name Value e &
3 ~
DEMLF - Elastic Modulus = 30e6 D
Shear Modulus = a
Density =
+
Thermal Expan. Coeff =
Structural Damping Coeff = |:
Reference Temperature = A=
0 n
[
Material Name )
Acier s
Current Constiutive hodels Description
Dafe: 28-Jun-11  Time:
062152
cea ] [cees | | @D
Apply [v]
For Help, press F1

Figure 111.55 - Création du matériau isotrope

Etape 4 - Création de propriétés du surface 2D et application du matériau isotrope au
modeéle

- Onclique sur Shell sous la section 2D Properties.

- Onentre un nom de propriété comme : Plaque_2D sous la section Property Set
Name, puis on clique sur Input Properties.

- Onclique sur Select Material et on sélectionne sur Acier. On entre I'épaisseur de la
plaque (Thickness ) comme 0.1, puis on clique OK.

- Onclique sur Select Application Region, puis dans Select Members. On sélectionne
le bord gauche de la plaque par le curseur de la souris, puis on clique Add puis OK,
et en fin Apply.
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S
i Flle Group Viewport Viewing Display Preferences Tools Help Utilities
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E =
For Help, press FI * } NUM il |
. o s s
Figure II11.56 - Création de propriétés de la surface 2D
I Patran 2010.2.3 (Student Edition) :EE
| File Group Viewport Viewing Display Preferences Tools Help Utilities y
Home  Geomety | FProperties | Loads/BCs  Meshing  Analysis  Results
% | |8 L] A (==E2E LIPS I TR O |98 3|5 |18 | e | fem |
Lsotropic | |ghg| L] L e R 211 1 1 e e W 3|5 | T - I
Isotropic |[Orthotrapic| |Anisotropic||_Fluid Composite 0D Properties 1D Properties 2D Properties | 30 Properties| [Property Actions] | Fields
ISR A N
> o o ojx
N poutre-flexion.db - default_viewport - default_group - Entity B
Sekect Application Region <>
G
+
- Application Region
[=] Select Members
Surface 1 @
m
=]
. || Aepicaton Region
o Surface 1
8
s 5
= 5
or Help, press FL NUM i

Figure 111.57 - Application du matériau isotrope (Acier) au modele
Etape 5 - Création des conditions aux limites : Annulation tous les degrés de liberté de

translation et de rotation a l'extrémité gauche de la poutre.

- Sousl'onglet Load/BCs, on sélectionne Displacement Constraint.
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On entre le nom : Encastrement dans New Set Name, puis on clique sur Input
Properties ....

On entre <0.0.0> pour Translations et < 0. 0. 0> pour Rotations, puis on clique
sur OK.

On clique sur Select Application Region , et dans Select Geometry Entries, et par
I'option Curve or Edge. On sélectionne le bord gauche de la plaque par le curseur
la souris, on clique sur Add puis OK et en fin Apply.

de

B Patran 2010.2.3 (Student Edition) Load/Boundary Conditions

! File Group Viewport Viewing Display Preferences Tools Help Utilities Load/Boundary Conditions y
7 ~
Home Geometry Properties Loads/BCs Meshing Analysis Results Type [a]
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) a
Displacement | Force | Temperature | Velodty | Acceleration || Displacement | Pressure | Temperature | Inertial | Distributed | CID Distributed | Total -+ | Deformable | Rigid | Coldg
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—— Nodal Element Uniform Element Variable Contact Bodies Dol E Fields)
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o}
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encastrement|
Input Data.. )
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L " i
For Help, press F1 1 =

T

Figure 111.58 - Création des conditions aux limites

B Patran 2010.2.3 (Student Edition) Input Data
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For Help, press F1 L 1

Figure 111.59 - Les coordonnées de déplacements et de rotations
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B Patran 2010.2.3 (Student Edition)

! File Group Viewport Viewing Display Preferences Tools Help Uilities }‘
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For Help, press F1

Figure 111.60 - Sélection de la région d’application de I'encastrement

Etape 6 - Création d’une force de 10 Ib.

- Onclique sur Distributed Load sous 'option Element Uniform.

- Onentre la Force_Z comme New Set Name et on choisit 'option Target Element
Type 2D.

- Onclique sur Input Data, et on entre la force <0,0,-10> ala section Edge Distr
Load, puis on clique sur OK.

- Onclique sur Select Application Region, .On sélectionne le bord droite de la plaque
par le curseur de la souris, on clique sur Add puis OK et en fin Apply.

X Patran 2010.2.3 (Student Edition) Load/Boundary Conditions |5
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For Help, press FI

Figure 111.61 - Création d’une force
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Bl Patran 2010.2.3(Student Edition)
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Figure 111.62 - La valeur de la force

B Patran 2070.2.3 (Student Edition)
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Figure I11.63 - Sélection de la région d’application de la force

Etape 7- Génération de maillage :

- Sousl'onglet Meshing, on clique sur Surface Meshers.
- Dans Select Surface List. On sélectionne la surface de la poutre par le curseur de la
souris, puis on clique sur Apply.
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B Patran 2070.2.3 GLadent Edtton)
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Figure l11.64 - Génération de maillage

Etape 8 - Analyse de probleme en utilisant MD Nastran 2010.

- Sousl'onglet Analysis, on sélectionne Entire Model. On vérifie que la case Job
Name contient le nom de projet, puis on clique sur Apply.

B Patran 2010.2.3 (Student Edition)
! File Group Viewport Viewing Display Preferences Tools Help Utilities
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Figure 111.65 - Exécution de fichier des résultats (*xdb)
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Etape 9 - Attachement du fichier des résultats génére par MD Nastran (*.xdb) pour la
lecture dans MD Patran

- Onclique sur XDB sous le menu Access Results.

- On vérifie que la case Job Name contient le nom de projet, puis on clique sur Apply.
- Sousl'onglet Results, on sélectionne Fringe/Deformation.

- On choisit les graphes de Stress Tensor et Displacements, Translational, puis on

clique Apply.

B Patran 2010.2.3 (Student Edition) X
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Figure ll1.66 - Attachement du fichier de résultats XDB

Patran 2010.2.3 (Student Edition) 03-Jul-11 10:39:49
Fringe: Default, A2:Static Subcase, Displacements, Translational, Magnitude, (NON-LAYERED)

Deform: Default, A2:Static Su Displacements, Translational,
*

Figure l11.67 - Visualisation des résultats de déplacement.
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e Solution analytique : Vérification les résultats en calculant la solution

analytique.
Formule de déflexion de poutre
Type de poutre | La déflexion maximale
Poutre - La force concentrée P a I'extrémité libre
/ P
:, '.] - 3 = —
B Oux W 3EI
le / -»l +
Les données :
P=101b, L=12in, E=30e6 psi,
;o Lx 0.1)3
12

Donc: O&max=2.304 inches = 5.85 cm

Résultat MD Nastran = 2.29 E+00 inches = 5.816 cm

5.85—-5.816

L’erreur =
erred | 5.85

| x100 = 0.58 %

Remarque :

Puisque l'erreur n’est pas important (0.5%) on a peut atteindre notre cible que les
logiciels MD Patran et MD Nastran sont en bon fonctionnement dans notre matériel
informatique.

-119-



Chapitre -1V-

Calcul des charges aérodynamiques

d’une hélice aérienne

L’aérodynamique est une branche de la dynamique des fluides qui porte
sur la compréhension et Il'analyse des écoulements d’air, ainsi
qu’éventuellement sur leurs effets sur des éléments solides qu’ils environnent.

De par sa complexité (Equations de Navier-Stokes non linéaires), depuis
I'apparition de cette science, les aérodynamiciens couplent résolutions exactes,
résolutions numériques, critéres empiriques et expériences en soufflerie pour
étudier de nouveaux profils. Ainsi, ce chapitre pour objectif de calculer les
charges aérodynamiques d’une hélice aérienne dans les deux cas statique et
rotatif, pour nous familiariser aux différentes méthodes de l'aérodynamique
moderne (CFD).

Aujourd’hui, de gros moyens numériques existent pour ne pas avoir a
calculer un écoulement "a la main". Parmi ces moyens, nous avons choisi
d’utiliser les logiciels ANSYS ICEM CFD 13, ANSYS CFX 13 et ANSYS Fluent 13 de
la société de logiciels de simulation numérique ANSYS.
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IV.1 Conception de la géométrie avec SolidWorks 2010

IV.1.1 Lagéométrie de I'hélice
IV.1.1.1 Lapale

On commence par la création d’'un plan Plan1 parallele au plan de dessus ou on
esquisse un cercle [étape 01], on le fait une extrusion par la fonction Base/Bossage
extrude [étape 02], on crée un nouveau plan Plan2 ou on esquisse le profil NACA0012 on
utilise la fonction [Courbe > Courbe passant par le point XYZ] par I'importation de
fichier des coordonnées [NACA0012.txt] qui est généré par un programme MATLAB (voir
Annexe B) [étape 03], et on convertit cette courbe de profil en esquisse en utilisant 'option
[Convertir les entités ]puis on le pivote 20 deg par l'utilisation de 'option [déplacer les
entités. Faire pivoter les entités on crée un autre plan Plan3 parallele au PlanZ2, et par la
méme méthode on esquisse un autre profil NACA 0012 et on le pivote 16° pour créer le
vrillage de la pale [étape 04], puis par la fonction lissage on lie entre les deux profils et le
bout de cercle déja extrudé, maintenant on est arrivé a dessiner la premiere pale de notre
hélice [étape 05] .

IV.1.1.2 Le capot

Dans le plan de face on esquisse un cercle puis on fait 'extrusion par rapport au
plan milieu [étape 06] aprés on esquisse une forme qui ressemble a un triangle sur ce
dernier et on le met en révolution par l'utilisation de l'option Bossage/Base avec
Révolution, maintenant on est arrivé a dessiner le capot d’hélice [étape 08].

IV.1.1.3 Les autres pales de I'hélice

Pour le dessein des autres pales on fait la répétition de la pale trois fois sur la face
latérale de capot pour cela on utilise la fonction Répétition Circulaire [étape 07],
maintenant on est arrivé a dessiner notre modele d’hélice [étape 09]. Pour les détails de
dimension d’hélice voir ’Annexe C.

-122-



Chapitre IV Calcul des charges aérodynamiques

Etape 01 Etape 02

.’/];x 3

Etape 03 Etape 04

Etape 05

i Direction 1
| Espacement. [360.00deg |
Ocourrences:

Etape06 Etape 07

-123-



Chapitre IV Calcul des charges aérodynamiques

Etape 08 Etape 09

Figure IV.1 - Les étapes a suivre pour la conception géométrique
d’hélice avec SolidWorks 2010

IV.1.2 Le domaine (Far Field)

On choisit un plan qui correspond a I'hélice, dans ce cas c’est le plan de face ou on
esquisse un cercle puis on lui fait une extrusion par rapport au plan milieu, on obtient un
cylindre, ¢a pour le cas d’essai quasi-stationnaire. Pour le cas d’hélice rotative on esquisse
un rectangle puis on lui fait une extrusion par rapport au plan milieu, on obtient un
parallélisme, on enregistre ces derniers sous I'extension (*.SLDPRT) et aussi (*.IGS) pour
qu’on puisse les lire par ANSYS ICEM CFD 13.

; (2 Bossage/Base balayé . Enlév. de matiére balayé 900 ol Nervure (@ Enroulement o U |
@ g @ Congé Répétiti Gé: \'Ir Courb: Q
/B /Base lissé Enlév. de Assistance Enlév. de m Enlév. de matiére lissé il ;?;ir:" Q Dépouille e Déme ‘ d:?%‘:é te COUDeS | InstantaD
extrudé avec ~ matiére  pourle  mat. avec ) R o
révolution T Bossage/Base frontiére  extrudé percage  révolution ) Découpe frontiére - - a Coque @ Symétrie - v

Fonctions | Esquisse | Evaluer | DimXpert | Produits Office

CYE »
Q) FARFILED (Défaut<<Défaut>_Et
(&) Capteurs
{A] Annotations
{E Lumiéres, caméras et scéne
8= Matériau <non spécifié>
&> Plan de face
X Plan de dessus
Q Plan de droite
-, Origine
([ Boss.-Extrul

QA BE-GH- -2 O- -8

¥

Gl wwa|C]6

idWorks Premium 2010

Figure 1V.2 - Conception géométrique Far Field cylindrique avec SolidWorks
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Figure IV.3 - Conception géométrique Far Field parallélisme avec SolidWorks

IV.2 ANSYSICEM CFD 13
IV.2.1 Le maillage de la géométrie pour le cas statique

IV.2.1.1 Nettoyage et classification des familles de la géométrie d’hélice et Far Field

Dans le menu File > Import Geometry > STEP/IGES de ANSYS ICEM CFD13, on
importe la géométrie d’hélice sous 'extension (*.IGS) qui était déja faite par SolidWorks.
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Figure IV.4 - Importation de la géométrie sous 'extension (*1GS)
(Géométrie non nettoyée)
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Apres 'importation de la géométrie on commence notre travail par le nettoyage
des courbes, c'est-a-dire I'enlevement des doubles et triples courbes de notre géométrie
puis par la méme procédure on nettoie les surfaces et on enléve tous les points de la
géométrie.

Une fois notre géométrie est nettoyée, on classifie ces familles par 'utilisation de
I'option Create Parts et on nomme chaque courbe et surface par son nom

convenablement.

On ajoute des points a notre géométrie d’hélice aux sommets des courbes pour
qu’on assure la continuité de maillage entre les déférentes familles (figure IV.5).

ICEM CFD 130
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Figure IV.5 - Classification des familles de la géométrie d’hélice nettoyée

On refait le méme travail pour le Far Field (figure IV.6).
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_CEM CFD130:
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Figure IV.6 - Classification des familles de la géométrie Far Field nettoyée

On enregistre les géométries finales (Hélice + Far Field) sous 'extension (*.tin).

IV.2.1.2 Préparation de la géométrie pour le maillage

Sous ANSYS ICEM CFD 13 on ouvre le fichier d’hélice enregistré sous I’extension
(*.tin), puis on ouvre la géométrie Far Field, une fenétre s’apparait, on clique sur Merge
pour qu’on puisse les mélanger. Maintenant I'hélice est dans son domaine de calcul.

On ajoute un point matériel a I'intérieur du domaine par l'utilisation de I'option

Create Body, puis Material Point se trouvant dans le menu Geometry on le nomme
(Fluid), ce point représente le fluide autour de I'hélice (figure IV.7).
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CEM CFl
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Figure 1V.7 - Géométrie de I'hélice dans son domaine de calcul

Dans le menu Mesh, on choisit I'option Globle Mesh SetUp. Cinq parametres
vont s’afficher (Global Mesh Size, Shell Meeshing Parameters,Volume Meshing
Parameters,Perism Meshing Parameters , SetUp Periodiciy). Dans notre travail on
s’'intéresse qu’aux deux parametres qui sont importants, le premier c’est (Globale Mesh
Size) ; on le laisse par défaut (Scale Factor = 1) qui représente I'échelle des tailles des
éléments de maillage et le deuxiéme on 'utilise pour définir la fonction Thin Cuts qu’il a
un grand intérét pour que le maillage soit contenu et non distorse dans les partie tres
sensible (bord de fuite par exemple) et ¢a par la sélection des deux surfaces qui ont une
courbe intermédiaire (exemple : SURFACE-PALE-EXT et SURFACE-PALE-INT ) (figure

IV.8).
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Figure V.8 - Utilisation de la fonction Thin Cuts
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IV.2.1.2 Le maillage de la géométrie

Pour faciliter la tache du maillage et qu’'on n’a pas besoin de visualiser des
parametres tres sensibles tels que la couche limite ; il suffit d’utiliser un maillage non
structuré de type tétraédrique.

On spécifie les choix des tailles de maillage suivant la sensibilité des zones tels
que les bords d’attaques et les bords des fuites, le controle de ces tailles des familles
dépendent de plusieurs facteurs comme les dimensions de la géométrie et la qualité de
maillage, pour cela on utilise 'option Part Mesh Set Up se trouvant dans le menu Mesh et
on entre les valeurs maximales des tailles des mailles Max Size correspondant a chaque
famille de notre géométrie (figure 1V.9).
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Figure V.9 - Spécification des choix des tailles des mailles des différentes familles

On utilise 'option Compute Mesh de menu Mesh, on spécifie le type de maillage
Tetra/Mixed tétraédrique pour toute notre géométrie, apres on clique sur Compute.
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-CEM CFD 13.0:
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Figure V.10 - Visualisation de maillage sur I’hélice

On a obtenu 65400 éléments tétraédriques et 113695 nceuds.
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Figure V.11 - Maillage de la géométrie totale (Hélice, Far Field)

Pour I'enregistrement de notre maillage on choisit le menu File > Save Project
As, on choisit un nom (ex: Hélice) et un lieu d’enregistrement, le projet contient des
fichiers sous formats (*.tin) et (*.UNS), et pour I'enregistrement sous format (*.msh) pour
qu’on puisse la lire dans ANSYS Fluent 13 et ANSYS CFX 13 ; on utilise le menu Out Put >
Select Solver , puis on choisit FLUENT-V6 comme Out Put Solver , puis on clique sur
Apply, puis OutPut > Write Imput, apres on ouvre le fichier (*.UNS) et on trouve le fichier
enregistré dans le méme lieu que le projet.

V.2.2 Maillage de la géométrie pour le cas d’hélice rotative

Pour le cas de I'hélice rotative , on a simplifié notre géométrie par I'’enlévement de
capot d’hélice et les racines des pales d’hélice et on a modifié la forme de Far Field de
cylindre a un parallélisme a cause de la difficulté qu'on a trouvé pour mobiliser le maillage
dans le solveur ANSYS Fluent 13.

V.2.2.1 Maillage de I'hélice

Dans ANSYS ICEM CFD 13 on ouvre le fichier de la géométrie d’hélice sous
I'extension (*.tin) qu’est déja préparé pour la simulation quasi stationnaire, on enleve le
capot et les racines d’hélice en utilisant Delete Point, Delete Curve et Delete Surface de
menu Geometry , apres la suppression des ces derniers on voit que les bouts des pales
sont ouverts, pour cela on utilise Goemetry > Modify Surface > Simple Surface > From
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Curve, puis on sélectionne sur la courbe de bout de chaque pale pour créer des surfaces
qui ferment les ouvertures des pales.

Figure 1V.12 - L’hélice avant et apres la modification

On ajoute des points matériels pour chaque pale on les nomme (Palel, Pale2,
Pale3) qui représentent les solides (figure IV.13).
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Figure IV.13 - Génération des points matériels dans chaque pale

On enregistre le travail sous I'extension (*.tin) pour qu’on 'utilise plus tard.
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V.2.2.2 Maillage de Far Field

On répete les mémes procédures qui sont déja cités pour le cas de maillage quasi
stationnaire (nettoyage, classification des familles..), puis on génére des point aux
sommets des courbes de Far Field pour assurer la continuité de maillage entre les
différentes surfaces et on génere aussi un point matériel qui représente le fluide on le
nomme (figure 1V.14).
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Figure IV.14 - Préparation de la géométrie de Far Field dans ANSYS ICEM CFD 13

On enregistre le travail sous I'extension (*.tin) pour qu’on I'utilise plus tard.

V.2.2.3 Maillage de la géométrie

Dans ANSYS ICEM CFD 13, on ouvre la géométrie d’hélice modifiée puis le Far
Filed sous l'extension (*.tin) et on clique sur Merge pour que I'hélice soit dans son
domaine de calcul (figure IV.15).
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Figure IV.15 - Le placement de I'hélice dans son domaine de calcul
en utilisant 'option Merge

On spécifie les choix des tailles de maillage suivant la sensibilité des zones tels
que les bords d’attaques et les bords des fuites, le controle de ces tailles des familles
dépendent de plusieurs facteurs comme les dimensions de la géométrie et la qualité de
maillage, pour cela on utilise I'option Part Mesh Set Up qui se trouvant dans le menu
Mesh et on entre les valeurs maximales des tailles des mailles Max Size correspondant a
chaque famille de notre géométrie.
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Figure IV.16 - Spécification des tailles des mailles
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On utilise 'option Compute Mesh de menu Mesh, on spécifie le type de maillage
(Tetra/Mixed) tétraédrique pour toute notre géométrie, apres on clique sur Compute.
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Figure IV.17 - Visualisation de maillage sur I’hélice

On a obtenu 273765 éléments tétraédriques et 44887 nceuds.

Fie Edit View Info  Setings ‘Windows Help s}

=5 ﬂg@‘ ¥) (A | Geometry 1 Mesh ]E\ockmg WEdilMesh ]Properties 1 Canstraints ]Loads 1 Salve Dptions 1 Output WCavtBD 1 Past-processing ]
BORER QR yVETEESEXXBEX

CH Patts ﬂ
& COURBE-DOMAIN-ENTREE
8 COURBE-DOMAIN-LATERALE
& COURBE-DOMAIN-SORTIE

&' COURBE-PALE1-BF_D

COURBE-PALE1BF_2
COURBE-PALET-PROFT_D

-

LUIDE
L1

kakkkakakhk

pol)
s
=h
=
=

8 POINTS_0
& FOINTS 1
& POINTS_2

SURFACE-DOMAIN-LATERALE
SURFACE-DOMAIN-S0RTIE

SURFACE-PALETERT_2
SURFACE-PALETINT_O
SURFACE-PALETINT 1

Total elements : 273765
Total nodes : 44357

SURFACE-PALET-PROFZ_0 —
ﬂ ™ Log Save| Clear

ETf

kdddddadabakn

Figure 1V.18 - Maillage de la géométrie totale (Hélice, Far Field)
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Pour la définition des types des conditions aux limites, on utilise le menu Out
Put > Select Solver ; on choisit FLUENT-V6 comme Out Put Solver, puis on clique sur
Apply, puis Out Put > Boundary Conditions , une fenétre Family Boundary Condition
apparaitra, ensuite on entre les types de conditions aux limites pour les familles
volumiques (les points matériels) et surfaciques de notre géométrie d’ensemble (Hélice ,
Far Filed) en cliquant sur la famille puis sur Create New, enfin on choisit le type des
conditions aux limites convenablement au type de famille (figure IV.19, tableau IV.1).

Les familles Types des conditions aux

limites
FLUIDE Fluid
PALE1 Solid
PALE2 solid
PALE3 solid

SURFACE-DOMAIN-ENTREE

Pressure-inlet

SURFACE-DOMAIN-LATERALE

Interface

SURFACE-DOMAIN-SORTIE

Pressure-outlet

SURFACE-PALE1-EXT-0 Interface
SURFACE-PALE1-EXT-1 Interface
SURFACE-PALE1-EXT-2 Interface
SURFACE-PALE1-INT-0 Interface
SURFACE-PALE1-INT-1 Interface
SURFACE-PALE1-INT-2 Interface
SURFACE-PALE1-PROF1-0 Interface
SURFACE-PALE1-PROF1-1 Interface
SURFACE-PALE1-PROF1-2 Interface
SURFACE-PALE1-PROF2-0 Interface
SURFACE-PALE1-PROF2-1 Interface
SURFACE-PALE1-PROF2-2 Interface

Tableau 1V.1 - Les condition aux limites
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Figure 1V.19 - Spécification des conditions aux limites dans ANSYS ICEM CFD 13

Pour 'enregistrement de maillage sous I'extension (*.msh), on utilise I'option
Write Imput trouvant dans le menu Output, une fenétre Save apparait, on clique sur Yes
puis on ouvre le fichier (*.UNS), une autre fenétre apparait on clique sur Done, le nom de
fichier qui s’enregistre par défaut sous le nom (Fluent.msh) on le trouve enregistré dans
le méme lieu que le projet.
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Figure 1V.20 - Enregistrement de maillage sous l'extension (*.msh)
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IV.3 Simulation numérique de I'’écoulement autour de notre modele d’hélice
IV.3.1 Lecas d’hélice statique
IV.3.1.1 Simulation avec ANSYS CFX 13

1V.3.1.1.1 Lancement de Workbench et importation de la géométrie

1) On lance le Workbench de ANSYS 13, puis on sauvegarde le projet sous un nom (par
exemple : sstatique.wbpj).
2) Dans la boite d’outil on choisit le menu systéme de composants apres on double
clique sur CFX pour qu’il s'ouvre au schéma de projet, 3 choix vont apparaitre :
a- Configuration : concernant le CFX-pre qui est le lieu ou on entre toute les
données de projet
b- Solution
c- Résultats
3) Onlance le CFX-pre, on double cliquant sur configuration.
4) On clique par le bouton droit de la souris sur Mesh, puis on sélectionne Import
Mesh > FLUENT.
5) On appelle au fichier du maillage apres on clique OK.

. M\ quasi - Workben

Fichier ~ Afficher Outils Unités  Aide
_] Nouveau [£5F ouwrir. .. |&l Enreqistrer lﬂ Enregistrer sous. .. | dj Importer... Reconnecter
:

Systémes d'analyse

B Systémes de composants
@ AuTODYN
BladeGen

i

CPX ¢2 @ configuraton
3
4

Connexion externe Solution v’
P

Données matériaw | CFX
@ Résultats v .

Dynamigue Explicite [Export LS-DYMA)
External Data CFX
FEModeler
FLUENT

Géométrie

CHRBES

Icepak

Maillage

Mechanical APDL

Microsoft Office Excel

Modéle Mechanical

POLYFLOW

POLYFLOW - Extrusion

POLYFLOW - Moulage par soufflage
Résultats

OEEER i) e

Systémes personnalisés

Exploration de la conception

| T Tout afficher [ Personnaliser. .. |

I! e Prét [ Afficher la progression || Afficher 2 messages !
Figure 1V.21 - Ouverture de ANSYS CFX 13 dans le Workbench
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S A2 : CFX - CFX-Pre
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Figure 1V.22 - Importation de maillage dans ANSYS CFX 13

1V.3.1.1.2 Modification des propriétés du fluide

On ouvre Materials de I'arbre d’ensemble Qutline Tree , puis on double clique sur
Air at 25 C, puis sur 'onglet Material Proprietes on change la densité a 1.225 [kg/m?3],
la viscosité dynamique a 1.7894 [Kg/m s] et la température de référence a 15 C, aprés on
clique OK.
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Outiine Qutine | Material: Air at 25 C )
4 [g] Mesh Jetails of Air at 25 C
> (@] quasi-stat.msh Material Properties
% Connectivity
-
4 (&3] Simulation Density [1225 kg m~-3] |
> [ Flow Analysis 1 - :
)\ Coordinate Frames Spedific Heat Capadty =
4 (] Materials Option [\u‘alue - ]
&5 Air Ideal Gas . ) 287 11 ket KA1
TG Spedific Heat Capacity [3 kg™-1K~-1] | _
Aluminium Specific Heat Type [Consmnt Pressure - ]
Copper
Soot Reference State =]
Steel Option | spedified point -
Water | I |
Water Ideal Gas Ref. Temperature <
[&] Reactions Reference Pressure 0 [atm]
> Expressions, Functions and Variables Reference Specific Enthalpy g
> & Simulation Control
> Case Options Ref. Spec. Enthalpy 0. [Ifka] -
Reference Specdific Entropy =
Ref. Spec. Entropy 0. [Ifkagi]
Transport Properties =
Dynamic Viscosity =
Option [\u’alue - ]
Dynamic Viscosity I 1.789e-05 [kg m-1s-1] I
] Thermal Conductivity | &
Radiation Properties
[ Binvemnsy Dronarfiac e} S
l CK I [ Apply ] Close

Figure 1V.23 - Modification des propriétés du fluide

On double clique sur Default Fluid.
On fixe la pression de référence (Reference Pressure ) a 0 [Pa]. On clique sur I'onglet

Fluid Models, puis on fixe la température a 288.16 K et 'écoulement a None(Laminar ) et
on clique OK.
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| Cutline | Domain: Default Domain

Outline ‘ Cutline | Domain: Default Domain
) Hesh Details of Default Domain in Flow Analysis 1 setails of Default Domain in Flow Analysis 1
4 es|
. | quasi-stat.msh Basic Settngs | Flid Models | Ir jon | | Basicsettings || FiidModels | mitalization |
B Connectivity Location and Type “  Heat Transfer B
Fl @ Simulation ioelren FLUID - E] Option [Ismharmal - I
4 [ Flow Analysis 1
(T) Apalvsis Tvpe Domain Type Fluid Domain - Fluid Temperature 288. 16 [K]
£ Default Domain Defavlt
it inlet Fluid and Particle Definitions... = Option None (Laminar) D
+ -
Iz Fluid 1 Combustion B
P outet
4 Interfaces Option Shear Stress Transpart
P Solver BSL Reynolds Stress
f ) Thermal Radiation 55G Reynolds Stress =]
&% Solution Units
I Solver Control Fluid 1 B /|| Opticn fons, s
Output Control Option Material Library - [ Blectromagnetic Model
& Coordinate Frames
» [B] Materials Material Airat25C - E]
@ Reactions Marphalogy =]
> Expressions, Functions and Variables - -
@] Simulation Control Option Continuous Fluid -
> Case Options [] Minimum Volume Fraction
Domain Models
Pressure =]
Reference Pressure [0 [atm] £l

Apply

I OK I [ ] Close

Figure 1V.24 - Modification des propriétés de fluide

I1V.3.1.1.3 Conditions aux limites

1V.3.1.1.3.1 Condition d’entrée (Inlet)

On insert une condition aux limites (Boundary Condition) appelée (Inlet).

Dans l'option Basic Settings, on choisit le type de condition a limite Inlet et on

sélectionne dans l'option Location la partie SURFACE FARFILED ENTREE de notre

géométrie.
On choisit 'onglet Boundary Details.
On spécifie Mass and Momentum a Normal Speed a 40 [m/s]

On clique sur OK
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Figure 1V.25 - Spécification de la condition d’entrée

1V.3.1.1.3.2 Condition de sortie (Outlet)

On insert une condition aux limites (Boundary Condition) appelée (Outlet).

Dans l'option Basic Settings, on choisit le type de condition a limite Outlet, on
sélectionne dans l'option Location la partie SURFACE FARFILED SORTIE de notre

géométrie.
On choisit 'onglet Boundary Details.
On spécifie Mass and Momentum a Normal Speed a 40 [m/s]

On clique sur OK.

1V.3.1.1.3.3 La condition de la face latérale
On insert une condition aux limites (Boundary Condition) appelée( Inlet).

Dans 'option Basic Settings, on choisit le type de condition aux limites Inlet on
sélectionne dans l'option Location la partie SURFACE FARFILED LATERAL de notre
géométrie.

On choisit'onglet Boundary Details

On spécifie Mass and Momentum a Cart. Vel. Compemonts (les composantes de
vitesse dans le repere cartésien) a (U=o, V=0, W=-40 [m/s]).

Les surfaces d’hélice sont définies par défaut comme des parois (Wall).
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IV.3.1.1.4 Solver control

1. On double clique sur Solver Control se trouvant dans l’arbre d’ensemble Qutline
Tree.

2. On fixe Residual Target a 1e-4.

3. Onclique sur OK.

File Edit Session Insert Tools Help

HE Z% moe F s8¢ xEdmis 08 alraadpfdl,, bARB

Outline e @@ F O =
4 (88 Mesh Outline | Solver Control ‘
» &8 quasi-stat.msh [Detais of Solver Controlin Flow Analysis 1
@ Comnectivity Basicsettings | Equation Class Setings | Advanced Options |
4 [@ Simulation
4 @ Flow Analysis 1 Advection Scheme
@ anslysis Type Opton Resobion =
a & Default Domain
[# P+ Defauit Domain Default Gt
Min, Iterations 1
:: ‘E‘ﬁ Max. Iterations 100
1Pt outet
p Fluid Timescale Control =]
Timescale Contral Auto Timescale =
e —
Salver Contral
Qutput Control Timescale Factor 10
i Coordinate Frames Maximum Tmescale
> Materials
[3] Reactions Convergence Criteria
4 [%] Expressions, Functions and Variables Residual Type
(%] Additional Variables -7
1E-4
padonel Resdage [ 1Es ]
User Functions Conservation Target
User Routines Elapsed Wall Clock Time Control
4 [@ Simulation Control Interrupt Control
[$) Configurations
» Case Options.
ok N v [ awme |

Figure IV.26 - Réglage des commandes des résidus

V.3.1.1.5 Solver Manager

1. Onferme CFX-Pre et on passe a la fenétre de projet Workbench

2. On sauvegarde le projet.

3. Maintenant on double clique sur Solution dans le schéma de projet pour démarrer
le Solver Manager.

4. Une fois le Solver Manager s’ouvre, on clique sur Start Run

5. Quand la solution converge, on ferme le Solver Manager et on retourne a la fenétre
de projet.

6. On enregistre le projet.
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Figure IV.27 - L’évolution des résidus

Apres 62 itérations, la convergence des résidus est satisfaite.

V.3.1.1.6 CFD-Post

On visualise les résultats en CFD-Post par le double cliquage sur Resultats
trouvé dans le schéma de projet dans le Workbensh.

(7
1. pourinsérer le contour de pression statique on clique sur © ot on le nomme
Contourl.

2. onclique sur [Z] , apres on sélectionne Default Domain Default.
on fixe Variable a Pressure.
4. onclique sur Apply.

w
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Figure 1V.28 - Insertion de contour de pression statique
Et pour visualiser les lignes de courant (Streamline ) on clique sur et on le

nomme Streamlinel.

On choisit Start From > Inlet, c'est-a-dire les lignes de courant commence depuis la
surface d’entrée du domaine, on change le nombre maximal des lignes de courant (Max

Points) a 500, puis on clique Apply.

A4 CFX - CFD-Post
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Figure IV.29 - Insertion des lignes de courant (streamline)
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Et pour visualiser le mouvement des molécules d’aire on clique sur Animation

i

puis on sélectionne Sreamlinel puis sur Play.

A4 CFX - CFD-Post =

File- Edit Session Insert Tools Help
FHELD@ 90 Puen - SBERSF e sHIPO xEEERRE Omle s A0gsE
Outine | Variables | Expressions | Calculators | Turbo | w ([Hd QR E
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§ Default Legend Vig |
& Streamine 1
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ceenery i | soea|

Definition |
oonors [Defmitoonon
O i (m——
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Figure 1V.30 - Visualisation de mouvement des molécules d’air

Et pour I'enregistrement de vidéo d’animation on clique sur puis sur Save
Movie on choisit un lieu d’enregistrement puis un Format MPEG.
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Outine | Variables | Expressions | Calauators | Turbo | |*m
4 [3) cases o
‘CFX (et

4 (@ Default Domain
P& Default Domain Default
P inlet

1

Pe et @) Animation
P outiet
[3 Mesh Regions e - S
© QuickAnimaton () Ke Animation
4 (@] User Locations and Plaf | ® + © Keyrane
Contour 1 . .
4 Default Transform Select one or more objects to animate:
[F3 Default Legend
& streamine 1
(D Wireframe
4 (5] Report
Details of Streamline 1 @ E Fast ™ slow

G Vs A

TRt T L0 1] | 50

A
[ Table Viewer | chartviener |

Stcanine —
i

Figure IV.31 - Enregistrement de vidéo qui montre le mouvement des molécules d’air
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IV.3.1.2 ANSYS FLUENT 13
1V.3.1.2.1 Workbench:

1) Onlance le Workbench de ANSYS 13 on sauvegarde le projet sous un nom
2) Dans la boite d’outil on choisit le menu systéme de composants apres on double
clique sur FLUENT pour qu'il s’ouvre au schéma de projet, deux choix vont
apparaitre :
a- Configuration
b- Solution
3) Onlance le FLUENT on double clique sur configuration.

4) On choisit 3D sous Dimension et on clique OK.

Fichier ~ Afficher Outls Unités  Aide

Nouveau (55 Ouvrir... [Hl Enregistrer [l Enregistrer sous... Importer... Reconnecter Raffaichir le projet  Mettre & jour le projet Projet @) Mode compact
R chéma de projet - R X
[ B Systémes d'analyse |
Eiystémes de composarts | [E¥ FLUENT Launcher (Setting Edit Only) o S

@ auTODYN —
WANSYS FLUENT Launcher

&4 BladeGen
Dimensian Optiors

@ ox
FLURNT D 20} [ Doubls Precision

+ Connexion externe
& Données matériawx
[ Dynamique Explicite (Export LS-DYNA) [] UseJob Schedulst
Bxtzral Data

G FEModeler Display Options Processing Optiorrs
T Display Mesh Atter Reading @ Serial

Géometrie Embed Giraphics Windows ) Parallel
Bl Icepak Workbench Color Scheme
@ maillage [] Do not show this panel again
@3 Mechanical APDL.
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i POLYFLOW
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= POLYFLOW -Moulage par soufflage | oK | [ Cancel | [ Hep +]
@ Résultats
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B vistaRTD
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‘ Exploration de |a conception |

| T Tout afficher / Personnaliser. ..

® Démarrage deFLUENT =1 Afficher la progression ||, Afficher 1 messages
e —————————

Figure V.32 — Lancement d’ANSYS FLUENT13 dans le Workbensh

1V.3.1.2.2 Importation du maillage
1. Sous le menu file de fluent on sélectionne Import > Mesh
2. Onappelle au fichier de maillage et on clique OK.

Apres la lecture de maillage, on le contréle par Mesh > Check Option ou par
l'utilisation de Check sous Problem Setup > General. Ceci permet de vérifier si le maillage
importé ne contient pas d’erreurs ou de volumes négatifs.

3. Onsélectionne Pressure Based (incompressible) et Steady (permanent) trouvant
dans Problem Setup > General > Solver.
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Figure IV.33 - Importation de maillage dans ANSYS FLUENT 13
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Figure 1V.34 - Spécification de l'écoulement et contréle de maillage
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1V.3.1.2.3 Réglage de Models

On spécifie le model d’écoulement laminaire utilisant Problem Setup > Models >
Viscous . On double clique sur la derniere et on sélectionne Laminar.

£ A:FLUENT FLUENT [3d, pb
File Mesh Define Solve

Adapt Surface Display Report Parallel View Help

iErd-@e|E¢ad e mE-0-

Problem Setup Models
Models
Multiphase - Off
Materials N
Phases
Cell Zone Conditions =
Boundary Conditions Heat Exchanger - Off
Mesh Interfaces SPEUE;’PaW o
Dynamic Mesh e ES&EV;!EIUHQ off Transtion k--omega (3 eqn)
Reference Values Acoustics - OFF Transition S5T (4 ean)
Solution () Reynolds Stress (7 eqn)
() Seale-Adaptive Simulation (SAS)
Solston ethods () Detached Eddy Simulation (DES)
Solution Controls OL Eddy Simulation (.ES)
Moritors ©) Large Eddy Simulation
Solution Initialization
Caleulation Activities E [concel] (e
Run Calculation
Results g
Graphics and Animations
Plots
Reparts

A

Mesh

MAY 19, 2011
ANBYE FLUENT 13.0 (3d, phns, larm)

Domain Extents:
%-coordinate:
y-coordinate:
z-coordinate:

min (m) = -3.000000e+02, max (m) = 3.000000e+02
min (m) = -2.999852e+82, max (m) = 2.999643e+02
min (m) = -1.250000e+02, max (m) = 1.250000e+02

Figure IV.35 - Spécification de I'écoulement laminaire

1V.3.1.2.4 La matiéere (Materials)
On définie la matiere en utilisant Problem Setup > Materials
1. Onclique sur air pour ouvrir la fenétre Create/Edit Materials

2. Onchange la densité (Density) etla viscosité (Viscosity) a 1.225 kg/m3 et
1.7894 e-05 kg/(m-s) respectivement.

3. On clique sur Change/Create
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L] AFLUENT FLUENT [3d, pbns, I2
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Figure 1V.36 - Définition de la nature de fluide

IV.3.1.2.5 La condition de zone (Cell Zone Conditions)

Sous Problem Setup > Cell Zone Conditions on clique sur Operating Conditions...
et on fixe Operating Pressure (Pascal) a 0.

A:FLUENT FLUENT [3d, pb

File Mesh Define Solve Adapt Surface Display Report Parallel View Help
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Figure IV.37 - Operating pressure
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1V.3.1.2.6 Les conditions aux limites (Boundary Conditions)
1V.3.1.2.6.1 La condition d’entrée

Pour surface-farfiled-entree on choisit le type de condition aux limites Inlet-
Velocity on clique Edit et on choisit 40 [m/s] dans Velocity Magnitude.

AFLUENT FLUENT [3d, pbns, la

File Mesh Define Solve Adaspt Surface Display Report Parallel View Help
P ke &
S-H-@9[Eaa e nnEyo-
e 1: Mesh -
Problem Setup Boundary Conditions =
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Models nt_fud
Materials surface-capot-bas
Phases surface-capot-cone
Cell Zone Conditions face_canotla
3oundary Conditions surface-farfiled-eniree
Mesh Interfaces surtace-fartiec-at:
Dynamic Mesh surface farfied-sortie
b ‘ surface-pale-cerd
Reference Values surface pae-cerd ext
Solution curface-pale-cerdint
curface-pale-ext
Sclution Methods et
Solution Controls curface paleprof-ip
Monitors
Solution Initialization
Calaulation Activities
Run Calculation
Results z)\x
Graphics and Animations | Phase Type D
Plots mixture velocity-inlet v a4
Reports = : :
Ceexhaust-fan W = 5 52 Jun 10, 2011
S letvent VelocityInlet — ANSYS FLUENT 13.0 (3d, pbns, lam)
interface S| | ZoneName
Display Mesh... | | P mags-fiow-nfe Sel | [surface farfled-entree
[] Highlight Zone uuaﬂnw Sel
outlet-vent
pressure far-field Se| | Mamentum | Thermal| Radiston | speces| DM | Multphase| ups |
= pressure-irlet sel
fielp pressure sutlet IS Veloty Specfication Method [yagntude, Normel to Boundary 7]
Symmetr Sel
velogty-nlet Sel Reference Frame apsolte -
Se| y ,
Velocity Magnitude (m/s]
3d SEE (mis) constant -
se|
sej| sopersoriclintal Gage presure Gascal) [o—] — .
Se|
se = i
. i N T v

Figure IV.38 - Spécification de la condition d’entrée

IV.3.1.2.6.2 La condition de sortie

Pour surface-farfiled-sortie on choisit le type de condition aux limites Inlet-
velocity on clique Edit et on choisit - 40 [m/s] dans Velocity Magnetude .

~
Velocity Inlet [

Zone Name
l surface-farfiled-sortie I

Momentum |Therma|| Radiat’onl Speciesl DPM I Multiphasel ups |

Velodity Spedification Methad ’Magnimde, Normal to Boundary ']

Reference Frame ’Absoluhe - ]

Veloity Magritude (m/s) =] [constant -
Supersonic/Initial Gauge Pressure (pascal) | 0 [consiant v]

[Lok J| [concel] [ ke |

Figure IV.39 - Spécification de la condition de sortie
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IV.3.1.2.6.3 La condition a la face latérale du domaine

Pour surface-fariled-laterale, on choisit le type de condition aux limites Inlet-
velocity on clique Edit et on change Velocity Magnetude en Compoments et on entre le
vecteur vitesse (0.0,-40) [m/s].

Velocity Inlet =
Zone Name
Isurface—farﬁled—lateral I
Momentum I Thermal I Radiation I Species I DPM I Multiphase I upDs I
velocdty Spedfication Method IComporler‘ltS I ']
Reference Frame [Absolute v]
Supersonic/Initial Gauge Pressure (pascal) | ) [cnnstant —]
Coordinate System [Cartesjan 0, ¥, 2) v]
X-Velocity {m/s) | ] [mnstﬁnt V]
¥-Velocity (m/s) o [constant |
Z-Velocity (m/s) 1 [constant |
I Ok I [Canoel ] [ Help ]

Figure 1V.40 - Spécification de la condition de la face latérale de domaine

1V.3.1.2.7 Commande de la solution (Monitors)

La commande aux résidus en utilisant Solution > Monitors
1. Ondouble clique sur Residuals.
2. Onactive Plot sous Options.

3. On spécifie le critere de convergence absolue (Absolute Criteria )a le-4.

T
il

Options Equations
Print to Console Residual Maonitor Check Convergence Absolute Criteria E
EPIot continuity 0.0001
Window - W 0.0001
- r—— —
y-velocity 0.0001
Tterations to Plot
1000 = z-velocity 0.0001
Residual Values Convergence Criterion
Iterations to Store [ Normalize Tterations ghizidle sl
1000 @ -
& : = |

Scale
[] Compute Local Scale

l QK | [ Plat ] [Renormalize] [ Cancel ] [ Help ]

Figure 1V.41 - Commande des résidus
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1V.3.1.2.8 Initialisation de la solution (Initialization)
On utilise I'option Solution > Monitors > Solution Initialization

1) On sélectionne inlet sous Compute From
2) Onclique sur Initialize pour initialiser la solution.

E AFLUENT FLUENT [3d, pbns, lam]
File Mesh Define Solve Adapt Surface Display Report Parallel View

ErEd-ameEeaa s e E-o-

Problem Setup Solution Initialization
General Initizlization Methods
Models - - —
Materials [ Hybrid Inmal!za.hm.ﬁ
Phases @ Standard Initialization

gell Zgne ((::onr:l::i::ns fram
oundary Conditions

Mesh Interfaces rface-farfiled-entree I v]
Dynamic Mesh Rreference Frame

Reference Values

@ Relative to Cell Zone
Solution () Absolute
Solution Methods

Solution Cantrols LabiaAbies

Monitors Gauge Pressure (pascal) =
Solution Initialization | o
Calculation Activities
Run Calculation * velocity (m/s)
Results | o
Graphics and Animations
Flots ¥ Velocity (m/s)
Reports | a

m

Z Velodty (mjs)

| 40

Figure 1V.42- Initialisation de la solution

1) Pour démarrer la solution on utilise Solution > Run Calculation
2) On entre 1000 pour le nombre maximal d’itérations (Number of Iterations ) et on
clique sur Calculate.
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n AFLUENT FLUE!ﬂ-i_%d, pbns,

File Mesh Define Solve Adapt Surface
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Phases
Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
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Solution
Solution Methods
Solution Contrals
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Solution Initialization

i

Results

Plots
Reparts
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Figure 1V.43 - Lancement de calcul de la solution

Adapt Surface Display Report Parallel View Help
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MAY 19,2011
ANSYS FLUENT 13.0 (3d, pbns, lam)
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Figure 1V.44 - L’évolution des résidus

Apres 393 itérations, la convergence des résidus est satisfaite.
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IV.3.1.2.9 Visualisation des résultats

Pour la visualisation de contour de pression statique de I'hélice on utilise Display >
Graphics and Animations

On double clique sur Contours une nouvelle fenétre s’ouvre ;

On sélectionne Pressure sous Contours of et Static Pressure en suite on
sélectionne Toutes les surfaces de I'hélice sous Surfaces.

Sl -®H H@@/H@l}\ﬂ"lj \

Problem Setup Graphics and Animations

General

Models

Materials

Phases

Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values |

Solution
Solution Methods
Solution Controls
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Solution Initialization
Calculation Activities = a3
Run Calalation
Results

-1.67e+03
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.
-3.54e+03
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Contours of Static Pressure (pascal) May 19, 2011
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surface-pale-prof-tip -

surface-pale-cercl-int
surface-pale-cercl-ext
surface-pale-int 5
surface-pale-ext

int_fluid

< 0 ] [r]

Figure V.45 - Procédure a suivre pour la visualisation de contour de pression
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X
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-3.85e+03

Contours of Static Pressure (pascal) May 19, 2011
ANSYS FLUENT 13.0 (3d, pbns, lam)

Figure 1V.46 - Le contour de pression statique sur l'extrados
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-3.23e403 X
3540403

-3.85e+03

Contours of Static Pressure (pascal) May 19, 2011
ANSYS FLUENT 13.0 (3d, pbns, lam)

Figure IV.47 - Le contour de pression statique sur l'intrados

1V.3.1.2.10 Interprétation des résultats

A partir de la visualisation de contour de pression statique ; il y a une apparition
d’'une zone a haute pression sur la face avant d’hélice (les extrados, le capot d’hélice) et
une zone basse pression dans la face arriere d’hélice (les intrados). Alors des forces de
pression résultent qui agissent sur la face d’hélice suivant la direction du vent (-Z).

IV.3.2 Le cas d’hélice en rotation
IV.3.2.1 ANSYS FLUENT 13
I1vV.3.2.1.1 Workbench:

a. Onlance le Workbench de ANSYS 13 on sauvegarde le projet sous un nom
b. Dans la boite d’outil on choisit le menu systéme de composants apres on double
clique sur FLUENT pour qu’il s’ouvre au schéma de projet 2 choix vont
apparaitre :
1- Configuration
2- Solution

c. Onlancele FLUENT on double clique sur configuration.

d. On choisit 3D sous Options et on clique OK.
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Figure 1V.48 - Lancement de ANSYS Fluent 13 dans le Workbensh

1V.3.2.1.2 Importation du maillage

1- Sous le menu File de Fluent, on sélectionne Import > Mesh
2- On appelle au fichier de maillage et on clique OK.

3- On sélectionne Pressure Based (incompressible) et Transient (instationnaire)
trouvant dans Problem Setup > General > Solver.
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Crank Angle=198.00(deg) ANSYS FLUEMT 13.0 (3d, pbns, dynamesh, transient)

Mesh (Time=1.5375e-02)

Note: zone-surface: cannot create surface from sliding interface zone. 4
Creating empty surface.
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<

Figure 1V.49 - Spécification de type de I'écoulement
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1V.3.2.1.3 Réglage de Models

On spécifie le model d’écoulement laminaire utilisant Problem Setup > Models > Viscous.
On double clique sur la derniere et on sélectionne Inviscid (non visqueux).

0 mobile FLUENT [3d, pbns, dyna rans =TT %
Fie Mesh Define Solve Adapt Surface Display Report Parallel View Help

Erd-me|[Eraa e nE-o-

Problem Setup Models
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Boundary Conditions -~ | B3 |
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Solution Controls 7 keepsion (2 eqn)
Moritors © komega 2eqn)
Solution Initalization 7 Transition k-k-omega (3 eqr)
Caleulation Activities © Transition SST (3 eqn)
Run Calculation ) Reynolds Stress (7 ean)

Results ©) Scale-Adaptive Simuiation (SAS)
Graphics and Animations (©) Detached Eddy Simulation (DES)
Plots ) Large Eddy Simulation (LES)
Reports = S

N

Mesh (Time=1.5375e-02) May 20, 2011_
Crank Angle=198.00(deg) ANSYS FLUENT 13.0 (3d, pbns, dynamesh, transient)

Hote: zone-surface: cannot create surface from sliding interface zone.
Creating empty surface.
Hote: zone-surface: cannot create surface from sliding interface zone. E

< »

Figure IV.50 - Spécification de fluide non visqueux

1V.3.2.1.4 La matiere (Materials)
On définie la matiere en utilisant Problem Setup > Materials

1. Onclique sur Air pour ouvrir la fenétre Create/Edit Materials
2. On fixe la densité a 1.225 kg/m3
3. Onclique sur Change/Create.
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Figure IV.51 - Définition de la matiere

1V.3.2.1.5 Spécification de mouvement de chaque matiére (fluide solide) Cell Zone
Conditions

Dans notre cas le fluide est en repos alors qu’on laisse sa configuration par défaut, et
concernant les pales on les met en rotation, on double clique sur pall, puis on choisit Mesh
Motion, aprés on entre une vitesse de rotation de 70 [rad/s] et on laisse les autres

parametres par défauts (origine de rotation (0,0,0) I'axe de rotation Z), et pour les pales
pal2 et pal3, on refait la méme chose .
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ANSYS FLUENT 13.0 (3d, pbns, dynamesh, transient)

Note: zone-surface: cannot create surface from sliding interface zone. 1
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Note: zone-surface: cannot create surface from sliding interface zone.

u
Creating empty surface.

Figure 1V.52 - Spécification de la vitesse de rotation d’hélice
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On clique sur Operating Condition et on fixe Operating Pressure a 0 [Pa].

Cperating Conditions M

Pressure Gravity

Operating Pressure (pascal) [T eravity

@

Reference Pressure Location
X {m) |0|— @
¥ {m) Ig— g
Z {m) ID— 8

l:_ [ OK ] [Canoel] [Help ]

Figure 1V.53 - Operating Conditions

1V.3.2.1.6 Les conditions aux limites ( Boundary Condition)

1V.3.2.1.6.1 Pour le domaine

Tous les types des conditions aux limites sont définies en ANSYS ICEM CFD13 que
nous avons déja tablé précédemment, sauf qu’'on entre les valeurs des conditions d’entrée
et de sortie de domaine :

On clique sur surface-domain-entree (pressure-inlet) puis sur Edit et on entre
(Pt=101325 [Pa], Ps=101325 [Pa])

r Pressure Inlet ‘ @
Zone Name )
fsurface-domain-entree |
Momentum | Thermal | Radiation | Species| DPM | Multiphase | LDS |

Reference Frame psohute =

Gauge Total Pressure (pascal) 101325 ] |constant -

R s 5 | [constant -

Direction Specification Method [No,m,, to Boundary ,]

Lo | [cancel] [rep

Figure 1V.54 - Condition d’entrée

On clique sur surface-domain-sortie (pressure-Outlet) puis sur Edit on entre
Ps=101325 [Pa].
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Zone Name

Isurface-domainiorﬁe I

Momentum | Thermal | Radiation | Species| DPM | Muitiphase | UDs |

Gauge Pressure {pascal) [ 151375 [oonsmnt v]

Badkflow Direction Spedification Method [Novmal to Boundary v]
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I [~ Target Mass Flow Rate
i

|

Figure 1V.55 - Condition de sortie

IV.3.2.1.7 Mesh Interface

Ici on spécifie la relativité du mouvement entre les différentes conditions aux limites
de type interface qui sont déja définies en ANSYS ICEM CFD 13, dans ce cas : la rotation de
toutes les interfaces par rapport a l'interface (surface-domaine-laterale). Pour cela on
choisit un nom par exemple (interface) puis on spécifie la zone fixe par rapport a laquelle
se fait la rotation dans la premiere zone (Zonel) et les autres interfaces qui constituent
I'hélice, c'est-a-dire: les interfaces mobiles dans la zone (Zone2), ici I'ordre n’est pas
important, puis on clique sur Create.
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Figure IV.56 - Création de la relativité de mouvement entre les interfaces

Maintenant on contréle le maillage par Mesh > Check Option ou par 'utilisation de
Check sous Problem Setup > General , Ceci permet de vérifier si le maillage importé ne
contient pas d’erreurs ou de volumes négatifs dans le cas statique.
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Figure IV.57 - Contréle de maillage

1V.3.2.1.8 Dynamic Mesh

e On sélectionne Dynamic Mesh pour activer 'option de maillage dynamique

e On sélectionne Smoothing et Remeshing sous Mesh Methods puis on clique sur
Settings > Remeshing et on clique On puis OK.

¢ On sélectionne In-Cylinder sous Option puis sur Setting puis sur OK.
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Figure IV.58 - Activation de mouvement dynamique de maillage
et spécifier leurs paramétres
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On spécifie la zone fluide qui va se déformer lors de rotation des pales pour cela on
clique sur Creat/Edit puis sur on choisit fluide sous 'option Zone Names, puis Deforming
sous Type puis sur Create.

= (B %
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Figure 1V.59 - Indication de la déformation de fluide

Et pour la visualisation et le contréle de maillage en mouvement; on clique sur
Preview Mesh Motion, puis on entre un nombre de pas choisi (Number of Time Steps),
apres on clique Preview.

I
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Figure IV.60 - Contréle de maillage en mouvement
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1V.3.2.1.9 Solution

1V.3.2.1.9.1 Commande de la solution (Monitors)
La commande aux résidus en utilisant Solution > Monitors
1. Ondouble clique sur Residuals

2. Onactive Plot sous Options pour que I'évolution des résidus s’affiche au cour de
I'exécution.

3. On spécifie le critere de convergence absolue (Absolute Criteria )a 1le-04 atous les

parameétres .
T
- il
Options Equations
Print to Consale Residual Monitor Check Convergence Absolute Criteria -
EPIut continuity 0.0001
Window -
| 0.0001
] [Curves... ][ Axes... ]
y-velodty ] ] 0.0001
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Iterations to Store = |:| Mormalize Iterations [absulute v]
1000 =
= ? -
Scale
[T compute Local Scale
I QK I [ Flot ] [Renurmalize ] [ Cancel ] [ Help
— =

Figure 1V.61 - Commande des résidus

1V.3.2.1.9.2 Initialisation de la solution (initialization)
On utilise Solution > Monitors > Solution Initialization

1) On sélectionne surface-domain-entree sous Compute From
2) On clique sur Initialize pour initialiser la solution.

-164 -



Chapitre IV

Calcul des charges aérodynamiques
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Figure IV.62 - Initialisation de la solution

1V.3.2.1.10 Activation de l'option d’Animation

Pour l'enregistrement d'un vidéo qui représente la variation des contours en
fonction du temps, on clique sur Calculation Activates, puis sur Solution Animation,
ensuite on clique sur Creat/Edit, apres on entre le nombre des contours qu'on veut
visualiser dans Animation Sequences puis on clique sur Define, une nouvelle fenétre qui
s’ouvre et on clique sur Contours puis sur OK, apres on spécifie le contours qu’on veut
visualiser ( exemple : Pressure, Static Pressure), on clique sur Compute puis on retourne a
Solution Animation et on clique OK .
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Figure 1V.63 - Procédures a suivre pour I’'animation des vidéos
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IV.3.2.1.11 Lancement de calcul

On clique sur Run Calculation, puis on entre 1000 comme un nombre d’itérations
"Number of Time Steps" et aussi 25 comme un nombre d’itérations maximal par un pas
"Max Iterations per Time Step" , enfin sur Calculate pour commencer les calculs.
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Figure IV.64 - Lancement de calcul de la solution

1V.3.2.1.12 L’évolution des résidus
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Figure IV.65 - Evolution des résidus
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On remarque que la convergence est satisfaite périodiquement.

1V.3.2.1.13 Enregistrement de la vidéo

On clique sur Graphics and Animation > Solution Animation Playback on
sélectionne la vidéo qu’on a déja définie a I'étape de 'activation de 'animation, ensuite on
choisit le type de format de vidéo MPEG dans Write/Record Format, enfin on clique sur
Write et on trouve la vidéo enregistrée dans le méme lieu que le maillage

mabile FLUENT [3d, pbns, ), tra
File Mesh Define Solve Adapt Surface Display Report Parallel View Help

Sr-d-me|Eea & i@ N80

2: Contours of Static Pressur

Problem Setup Graphics and Animations
General Eerrm
Madels
Materials Contours
Phases Vectors
Cell Zone Conditions Pathlines
Boundary Conditions Particle Tracks
Mesh Interfaces
Dynamic Mesh
Reference Values

Solutian
Solution Methods
Solution Contrals Animations
Monitors

Solution Initislization
Caleulation Activities
Run Caleulation

e g
reais Plybock u |l e
o i Animation Sequences -4.60e+0
Once -5.93e+0
e TR =
e -7.25e+0
Start Frame  Increment End Frame

= = =
1 1B & [ 1000 S
1 1500055 0AE000E5007 0007 50080088500 1.128+0

-1.26e+0 I;x

lterations

“ Frame
-1.38e+0
o o G o o)
“ =
Sow  ReplaySpeed  Fast 03) Jun 28,2011 | Contours of Static Pressure (pascal) (Time=8.3333e-06) Jun 23, 2011
1 573 FLUENT 12.0 (34, pbns, dynamesh,... | Crank Angle=200 40(94$vS FLUENT 13.0 (3d, pons, dynames, tra
ite/Record Format (vpeg M | Picture Options...
81680136 bits) (381680 bpF) {100.06% of total) “
-15.4979 b
E 10.8306 FEE) ( 7486189 pps) ( 29242 mps)
— - e o
| Total compression:  -1:1 { -15.4981 bpp) -
<1 n S

Figure IV.66 - La méthode de l'enregistrement de la vidéo

1V.3.2.1.14 Visualisation de contour de pression statique
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Figure IV.67 - Contour de pression sur l'extrados
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Figure 1V.68 - Contour de pression sur l'extrados

1V.3.2.1.14 Interprétation des résultats

D’apreés les contours qu’on a obtenus, les remarques suivantes ont été observées :

Apparition d'une zone de suppression sur lintrados et une dépression sur
I'extrados due a la direction de ’écoulement le long de la pale.

- Apparition de deux zones : l'une ou la pression est maximale (en rouge) qui
correspond aux points de vitesse nulle, c'est-a-dire la pression statique égale a la
pression totale .la deuxiéme zone ou la pression atteint sa valeur minimale (en
bleu).
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IV.4 Calcul des charges aérodynamiques
IV.4.1 Le cas d’hélice statique

On commence d’abord par l'exportation des fichiers des résultats des pressions
statiques sur les pales d’hélice a partir de logiciel ANSYS Fluent 13 ; on utilise le menu File >
Export > Solution Data et sous File Type on choisit Tecplot et on sélectionne par exemple
Surface-pale-extrados sous Surface puis on choisit Static Pressure sous Quantities , et

en fin on clique sur Write pour l'enregistrement de fichier des résultats (*.dat) (figure
1V.69).
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Figure 1V.69 - Exportation des données au logiciel Tecplot 360

On ouvre le fichier exporté de ANSYS Fluent 13 en utilisant le logiciel Tecplot 360.
Pour déterminer les pressions en chaque station, on utilise Data > Extract > Points From
Polyline et on spécifie le lieu de la station par le dessin d’'un segment, puis par un double
cliquage sur le vide ; une fenétre Extract Data Point apparaitra ; on précise le nombre des
points a 100 dans la case Number Of Point To Extract ; ensuite on clique sur Extract pour
I'enregistrement de fichier (*.dat) qui contient toutes les données concernant la station.
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Figure IV.70 - Méthode d’utilisation de logiciel Tecplot 360 pour fournir les données de

pression dans une station

Pour simplifier les calculs, on a proposé de composer la pale d’hélice en six (6)
stations et sections partielles, on fait un calcul bidimensionnel (par rapport a I'unité de
largeur) dans chaque station et on le généralise par rapport a toute la section qui contient

la station.
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Figure IV.71 - Représentation des six stations pour une pale d’hélice
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Et pour la représentation des pressions statiques de chaque station on a pris la
variation de la pression statique par rapport a une variable adimensionnelle, relative a la
corde (x/c) pour I'extrados et I'intrados de chaque station.

T
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Figure IV.72 - Distribution des pressions a l'extrados par rapport
a la corde de chaque station
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Figure 1V.73 - Distribution de la pression par rapport a chaque point relatif
a la corde de chaque station
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IV.4.1.1 Laforce de pression

F=[Pds : La force de pression en [N]
F = [SPdx La force de pression par rapport a 'unité de largeur [N/m]

Pour faciliter les calculs on applique ce changement de variable pour rendre notre
variable adimensionnelle

E=x/c
x : Variable suivant la corde en chaque station de la pale d’hélice [m]
¢ : La corde en chaque station de la pale d’hélice [m]
&: Variable adimensionnelle.

Apres I'application de changement de variable on obtient :
F =c[iPd¢
IV.4.1.2 Le moment aérodynamique

On a pris le moment aérodynamique par rapport a l'origine (bord d’attaque pour
chaque station) :

M = [P xds Momentaérodynamique [N m].

M) = [6Pxdx Momentaérodynamique par unité de largeur [N].

Apres I'application de changement de variable on obtient :

Mg =c? [gPEdE
L=M) /F
L : Le bras de levier pour chaque force de pression en chaque station [m].
Et pour généraliser nos calculs des forces de pression et des moments

aérodynamiques selon toute la section partielle de chaque station on multiplie toutes les
forces de pression et les moments aérodynamiques par rapport a l'unité de largeur ([N/m],
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[N]) par la hauteur de chaque section partielle trapézoidale pour nos stations de la pale de
notre hélice h [m].

IV.4.1.3 Calcul numérique de forces de pression et des moments aérodynamiques

Puisque les résultats qu’on a obtenus par Tecplot 360 sont des matrices [xy z P] a
une dimension qui dépend de chaque station [nx4] , et sachant que parmi les meilleurs
logiciels de programmation basés au calcul des matrices, c’est le logiciel MATLAB, d’ou on
I'a utilisé pour créer un programme cité dans I’ Annexe B qui nous a permis de calculer

tous nos besoins (forces de pression, moments aérodynamiques, bras de levier ).

Apres I'exécution de notre code on a obtenu les résultats suivants :

Les La position des points | Les cordes Forces de Moments Les bras de
stations d’application des [m] pressions [N] | aérodynamiques levier
forces de pression [Nm] [m]
[m]
X y
1 0.01195 0.18625 0.1363 5.1971 0.2922 0.0562
2 0.00570 | 0.28875 0.1554 6.9119 0.4979 0.0720
3 0.00420 | 0.39125 0.1370 6.4428 0.4145 0.0643
4 0.00235 0.49375 0.1215 5.8441 0.3416 0.0584
5 0.00305 0.59625 0.1023 5.6600 0.2723 0.0481
6 0.00215 0.69875 0.0859 5.7499 0.2344 0.0408

Tableau IV.2 - Forces de pression et moments aérodynamiques

D’ou la résultante des force de pression appliquée a une pale d’hélice est :

F=Y5,f= 51917 + 6.9119 + 6.4428 + 5.8441 + 5.6600 + 5.7499 = 35.80 [N]

Et la résultante des forces des pressions appliquées sur les trois pales de notre hélice :

R=3F=3 35.80=107.4[N]

IV.4.1.4 Laforce de pression avec ANSYS Fluent 13

Pour afficher les composantes de force de pression agissantes sur les pales de notre
hélice il suffit de cliquer sur Report > Forces puis on choisit Forces sous Option puis on
sélectionne toutes les parties qui constituent les pales d’hélice et en fin on clique sur Print.
Ainsi, 'affichage sera dans la partie inferieure de la fenétre.
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Erd-we [Eeaa s &L E-0-

Prablem Setup Reports 1: Mesh -
General Reports
Models .
Materials
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Cell Zone Conditions surface Integrals Force Reports 52

Boundary Conditions Volume Integrals

Mesh Interfaces D‘SSUEF:E Phase: Direction Vector  wall Zones
ample
Dynamic Mesh frilastiy surfacecapatbas

Reference Values surfacecapat-cone

X[y
curface-capotdat
Yo surtace-pale-cerd

surface-palecercext
z surface-palecerc-nt
o
surface-pale-ext
surface-pale-int
Wal Name Pattern surface-pale-prof-tip

]

SLmmary - Unavaila
Heat Exchanger - Un

Solution
Solution Methads

Solution Controls
Moriitors
Solution Initializgftion

7
== PY
composantes de la
force de pression
Mesh Jun 24,2011
/ AMNSYS FLUENT 12.0 (3, pbns)
Forces B
Forces (n)
Zone Pressure Uiscous
surface-pale-cercl (-0.851596366 0.013558395 —1.1873671) (8 8 8)
surface-pale-cercl-ext (-0.0824115667 -0.014279765 -9.7955017) (88 8)
surface-pale-cercl-int (-0.865806821 -0.036285758 1.8772592) (88 8)
surface-pale-ext (0.068857618 —B.045899175 -83.69786) (88 8)
surface-pale-int (8.85479981 [|.[11I35626!I7 -7.7911634) (88 8)
surface-pale-prof-tip (0.029548038 0.92310263 -3.2899081e-06 {0 0 8)
Net | (0.011686612 -0.016241026 —101.39384) I {0 0 08)

Figure IV.74 - Méthode de calcul de la résultante de la force de
pression par ANSYS Fluent 13

Erreur de calcul :

La force calculée par ANSYS Fluent 13 est:

Rpyent = V0.011686612% + 0.0162416262 + 101.393842 =101.39384 [N]

R -R
E - | Fluent

_ |101.39384—107.4

Toisoser |- 0.0592 =5.92 %

RFent

On voit que l'erreur n’est pas vraiment important, alors l'approximation de notre
code est tres proche de la réalité, donc on peut compter sur notre code dans le calcul
structural du prochain chapitre.

IV.4.2 Le cas d’hélice rotative

Dans le cas d’helice en rotation on refait le méme travail que dans le cas statique,
sauf que la position de la station 1 suivant y change a cause de la modification qu’on a fait
(I'enlévement de la racine d’helice) pour qu’on puisse mobiliser le maillage.
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La position des Les Forces de Moments Les bras de

Les points cordes pressions | aérodynamiqu levier

stations | d’application des [m] [N] es [m]
forces de pression [N m]
m]
X y

1 -0.0128 0.22 0.1498 5.1092 0.4482 0.0877

2 -0.0207 | 0.28875 0.1366 4.6921 04178 0.0890

3 -0.0261 | 0.39125 0.1224 7.0667 0.6171 0.0873

4 -0.0244 | 0.49375 0.1084 9.4229 0.7410 0.0786

5 -0.0275 | 0.59625 0.0952 16.2241 1.2180 0.0751

6 -0.0174 | 0.69875 0.0822 13.4373 0.7859 0.0585

Tableau 1V. 3 - Les charges aerodynalique dans le cas d’hélice rotative

0.8
N o
s 4 i tation-6
ai'_ﬁ e .'
06} A 3 \ Staion-5
— :- : - ( Station-4
> NN
] A
0.4 - ‘ ‘i Station-3
KS
1 — (_ Station-2
! }
— T " Station-1
0.2} 777777 :
1 1 1 L 1
0.2 0 0.2 04
X

Figure 1V.75 - Représentation des six stations pour une pale d’hélice

-175-



Chapitre IV Calcul des charges aérodynamiques

P[Pa]

5 | S —+— P-ext-station 01 [
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8.7 _" """"" —=— P-ext-station 06 “ """""""""""""""""""""""""""""""""""""""""""""""""""""""""""""""" ]
o i i
0 01 02 03 0.4 0.5 06 0.7 0.8 0.9 1
we
Figure 1V.76 - Distribution des pressions a l'extrados par rapport a la
corde de chaque station
x 10
1.045 T T
—#— P-int-station 01 B ; H : H :
T | P-int-station 02 |77} fromrnrree . e froremrmrre P
—— P-int-station 03 | : | : H : H :
—#— P-int-station 04 : : : : : : : :
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—— P-int-station 06 | ! ; : : ' | : ! I
103 e — e e e e s
1.025
£
102
1.015
1.01
1.005

Figure 1V.77 - Distribution de la pression par rapport a chaque point
relatif a la corde de chaque station
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Chapitre -V-

Calcul des charges structurales

d’une hélice aérienne

Le but de chapitre est de déterminer les charges structurales sur la
pale en position 12h00 de notre hélice a partir des charges
aérodynamiques tirées du chapitre précédent et par l'addition des
charges d’inerties qui sont dues au poids et la vitesse de rotation (le poids
et la force centrifuge).

On considere que l'axe de rotation de I'hélice et I'axe d’inertie sont
confondus (absence de ['excentricité qui engendre une absence de
vibration).

-178 -



Chapitre V

Calcul des charges structurales

V.1

charges structurale

Importation des différéerent propriétés de masse utilisées dans le calcul des

On commence notre travail par le calcul de centre de gravité et le volume pour la
pale d’hélice dans la position 12h00, pour cela on peut compter sur le logiciel SolidWorks

on clique sur Outils trouvant dans la barre d’outils, puis sur Propriété de masse, d’ou une

fenétre apparaitra contient toute les propriétés de masse de notre pale d’hélice.

Levolume: V

= 1302004.92 mm? .

Le centre de gravité CG (-6.43, 298.3,2.88) mm (le centre de gravité de la pale est

pris par rapport au repeére lié a I'hélice ).

(5] Capteurs

umigres

%S Plan de
& Plan de
1. Origine

essus
droite

BpiSolidWorks g Feher Ediion Affichage Insertion
— SolidWorks Explorer.
s (@ BossagefBase balay G W DriveWorkspress.
niev. d
extrudé avec matié
révolution
Fonctions [ Esquisse | Evaluer | DimXpert | Produits Office 53 | FloXpre
——— &
Y ==Y ED 2
P ) [ sele:
G propeller (Défaut<Défaut>_Et X [In

G}

Verifier..,
Analyse de la géométrie...
Statistiques de la fonction...
Equations.

Diagnostic d import..

Analyse de

BuEE MPRLDA

~
propeller B Propriétés de masse [ =]
uire balayd 383 i nenure @& enroule | [imprimer.. | [ copier | [ Fermer | [ options.. | [ Recalcuter |
. . Congé Répétition . - N N
tiere lissé lingaire & oe Systéme de coordonnges o -
e ” (B Coque i de sortier
propeller.SLDPRT
@ O <% M 3 Objets sélectionnés:
QO mE T - @R
[¥]Inclure les corps/composants cachés
nées de sortie dal in de la f

Propriétés de mas

se de propeller [ Part Config,

Densité = 000 grammes par millimétre cube

Masse = 130200 grammes

Volume = 1302004 92 millimétres cubes

Superficie = 180829.02 millimétres* 2

Centre de gravité: | millimétres |
X=-543
¥ =298.38
Z=2388

et moments d'inertie

iF

.00, 0.01)
0.02,0.41)
I = (0.41, 0.00, 0.81)

C le sy
Ly = 6165137

Systéme de coordonnées de sortie : - par défaut —

Px = 131454583
Py = 41504471.24
Pz = 42499572.09

Moments d'inertie: [ grammes * millimétres carrés)
Pris au centre de gravité et aligné avec le systéme d

Lo = 41665546.06 0 Lz
Lyx = 616813.70 Lyy = 1325520.52 Lyz = 24600014
Lzx = 378774.22 Lzy = 246000.14 Lz = 42327522.59

uration - Défaut }

m

principau  grammes * millin

ordonnées de sortie.
= 578774.22

Edition: Piece

Figure V.1 - Propriétés de masse de la pale d’hélice

V.2 Les forces appliquées sur la pale a la position 12 h00

V.2.1 Les forces aérodynamiques

Les forces aérodynamiques appliquées sur la pale d’hélice sont les différentes forces
et moments tirés dans le chapitre IV.

Les La position des points Les Forces de Moments Les
stations d’application des cordes | pressions | aérodynamiques | brasde
forces de pression [m] [N] [N m] levier

[m] [m]

X y

1 0.01195 0.18625 | 0.1363 5.1971 0.2922 0.0562
2 0.00570 0.28875 | 0.1554 6.9119 0.4979 0.0720
3 0.00420 0.39125 | 0.1370 6.4428 0.4145 0.0643
4 0.00235 0.49375 | 0.1215 5.8441 0.3416 0.0584
5 0.00305 0.59625 | 0.1023 5.6600 0.2723 0.0481
6 0.00215 0.69875 | 0.0859 5.7499 0.2344 0.0408

Tableau V.1 - Les charges aérodynamiques dans le cas statique d’hélice
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Chapitre V Calcul des charges structurales

La position des Les Forces de Moments Les bras de
Les points cordes pressions | aérodynamiqu levier
statio d’application des [m] [N] es [m]
ns forces de pression [N m]
m]
.S y

1 -0.0128 0.22 0.1498 5.1092 0.4482 0.0877

2 -0.0207 | 0.28875 0.1366 4.6921 04178 0.0890

3 -0.0261 | 0.39125 0.1224 7.0667 0.6171 0.0873

4 -0.0244 | 0.49375 0.1084 9.4229 0.7410 0.0786

5 -0.0275 | 0.59625 0.0952 16.2241 1.2180 0.0751

6 -0.0174 | 0.69875 0.0822 13.4373 0.7859 0.0585

Tableau V.2 - Les charges aérodynamiques dans le cas de rotation de I'hélice

Figure V.2 - Distribution des forces de pression le long de la pale

Forces d’inerties : sont les forces apparentes qui agissent sur la masse (le poids
dans le cas statique et rotatif d’hélice et la force centrifuge dans le cas rotatif)
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Chapitre V Calcul des charges structurales

Figure V.3 - Les forces d’inerties dans le cas rotatif et statique d’hélice

Fc=m%=mw2R (V.1)
P=mgyg (v.2)
Fc: Laforce centrifuge [N]
P :le poids
m : La masse [Kg]
w : La vitesse angulaire [rad/s]

g :la gravité [m/s?]

V.3 Simulation numérique de la pale d’hélice dans le cas statique avec MD
Nastran/Patran

On ouvre une nouvelle base des données sur laquelle on nomme notre projet (helice
statique.db)

-181-



Chapitre V Calcul des charges structurales

i File Help
Home
N EE I E e e R R = R \le\ﬁH!“Hﬁxl\h\H\f,HﬁHSDHﬂ'I a
I,I‘
(S Py WY P S E T TSN N et o PP e P o O
—
Defal [Transtorms| | Viewport PYPTN | & New Database =8%

D@ 6L R

Template Database Name
CAMSC Software\MD_Nastran_Student_Edition\20102\Patran/md_template.db

Change Tempiate .

Modify Preferences...

Set Working Direcory to Database Location
Regander dans | Nouveau dossier (3) -| & & o B S
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Aucun élément ne correspond & votre recherche.

=

o i ’

Nom du fichier [elice htatique.db | OK |
Types de fichiers Database Files {~db} - Cancel
| ' S e abled

Figure V.4 - Ouverture d’une base des données dans MD Patran 2010

On importe notre géométrie de la pale sous I'extension (*.igs) qui est déja fait par
SolidWorks

— .
Pl Patran 2010.2:3 (Student Edition) O mport [wlfmifro -5
File | Group Viewport Viewing Display Preferences Toals R
ogarder \ - - g (tocer 7]
New... Properties Loads/BCs M| e s pae =y = ——
open... Nom Modifié le Type Source: ACIS
| Open Recent.. EsaELE 2 e 3 G propeilerics 0370772011 1540 Fichier 165 Parasolid xmt
Current Grot
| Close CATIA
defaut_or
Save 1-DEAS
Save 2 Copy.. Pro/ENGINEER
2 Utilities 3 ; = T y [Eimportto Unigraphics o5
Ewport - default_group - Entity )
Nom du fichier propeler IG5 I Express Neutral New Model Preference
Export...
1655
SimManager Typesdefichiers :  [IGES Fles *igs} ~] & Ly ees ] Model Preference for
MD Nastran Input PALE db
= MSCPatran DB R,
Cante= Neutral (3 Based on Model
Images... STEP O Defautt
Report...

Quit

Approximate Maximum
Wodel Dimension:

10.0

Analysis Code:
D Nastran ¥

Analysis Type:

Structural ¥
(——

For Help, press F1

CAP NUM

Figure V.5 - Importation de la géométrie de la pale

On controle est ce qui-il ya des courbes supplémentaire dans notre pale pour les
supprimer (nettoyage de la géométrie).

On crée les points sur lesquels on applique les forces

Exemple : L e point d’application de la force F1 est (0.18625, 0.01195)
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Chapitre V Calcul des charges structurales

Sous le menu Geometry > Point > Select > XYZ, on entre les coordonnées de point

File Group Viewport Viewing Display Preferences Tools Help Utilities ~
Home | Geometry | Froperties  Loads/BCs  Meshing  Analysis  Results

~ 2| g Lt LD (== ~ R e &

Select||| Select || Select || Select || Select || Select || Select || Select ||(ggg|[t|[ch|[ 1 ||| Shew | Edit | Verity | Renumber | Delete | Associate | Disassociate

-(es Solids | (Coordinates|| Planes || vectors ||P-Shapes||  Transform Geometry Actions
T | ArcCenter & -

| Exract Bix|
)

/| Interpolate Geometry

Action: o
Object:
Method

Point ID List
38

| Intersect
32| Offset

14| Pierce

nir+ oo

| Project

Refer. Coordinate Frame
Coord 0

s

Auto Execute
Point Coordinates List
[-0.01185 018625 0]

| T

+®AD Y-

Figure V.6 -Création de point d’application de la force F;

Et c’estidem pour tous les points d’application des forces et des moments.

e Le maillage

Pour le maillage on utilise Meshing > Meshers > Solid , on clique sur la case Imput
list puis on sélectionne notre pale apres on spécifie la taille de la maille a 0.02 sous Global
Edge Length.

i File Group Viewport Viewing Display Preferences Tools Help Utilities ™

Home  Geometry  Properties  Loads/BCs Analysis  Results
A2 B m Az=[2] (x)]e)e MiEl el | [i! ][0 e [~ [ [~ || 20 | T | Mg

£ ||| Surface | Auto Hard &/ o | (8 | | ] 1[5 (.|| Edit |SuperElement N 9|[®|(m0||| DOF || Seet |Fastener
Y= [FX oo | i | ool i [ [ e (NS 3

List
| Mesh Seeds || Mesh Contral FEM Actions | Node | Element MPC |DoFList||  cConnecor
DEMhghod-
T ol

Fintte Elements.

Mesher Tethesh  * [
Topology. Tetlo ¥
Tetllesh Parameters.
Node Coordinate Frames.

oyt Lis

Soid23

Giobal Edge Length
[¥] Automstic Calculation

i+ O o

= |G

Value 0.02

Assembly Parameters. ..

Select Existing Frop.
Create New Property.

ZApply-

Figure V.7 - Maillage de la pale
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e Application des charges (Load/BCs)

puisque notre code de calcul MD Patran est basé sur la méthode des éléments finis
alors qu’on est obligé de mettre les différentes charges aux nceud pour cela on proposé
dans notre travail de prendre les nceuds les plus proches par rapport aux points
d’application de chaque charge.

e (réation des forces dans MD Patran

On utilise loads /BCs > Force on nomme cette force (F1), puis on clique sur Imput

Data et on entre les composantes de la force <0 0 -5.1971>, apés on clique sur OK .

Maintenant on définit le noeud d’application de F1, on clique sur Select Application

Region, puis on choisit FEM dans Select et on sélectionne le nceud d’application de la
force, en clique sur Add, ensuite OK et enfin Apply.

i File Group Viewport Viewing Display Preferences Tools Help Utilities

Home  Geometry  Properties | loads/BCs = Meshing  Analysis  Results
X -p‘ 2 5 X @ -»‘ r W j ~ (e a 33 m ol e (=]
—he e A3 oF il & . = 1=
1= = | = | & s | 23 | (e My |y % | Pt (el S
Displacement [[Force e | Velodty | Acceleration || D Pressure | Temperature | Inertial | Distributed | CID Distributed | Total || =g [t Deformable | Rigid | Color Code -, = Create =
Constraint Force | Load Load Load Load || ol | Bodies Ollsle [¥ Load Case ||| 58| | ¥
Nodal Element Uniform Element Variable Contact Bodies Initial Conditi..||LBC Adti..) | Load Cases |[LBC Fields
D&Moo -
8 DA F.ch - defanlt_viewpart - dof Sk = sl
Load/Boundary Conditions.
g ~
+
w | || vew setname
o 1
Input Data A
Select Application Region... B
-Apply-
C

Figure V.8 - Appellation de la force
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B atran 2010.2.3 (5t = =
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Figure V.9 - Insertion des composantes de la force

i File Group Viewpert Viewing Display Preferences Tools Help Utilities
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Figure V.10 - Choix de nceud pour l'application de la force

Et c’est la méme chose pour toutes les charges ( Force, Moment ).
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Figure V.11 - Présentation de toutes les charges sur la pale

e (Création de l'’encastrement

pour I'encastrement on choisit Load/BCs > Displacement Constraint , on choisi
aussi un nom (encastrement), puis on clique sur Imput Data et on annule tout les degrés
de libertés, de translation et de rotation, puis on clique sur OK . Pour sélectionner la
surface d’encastrement on clique sur Select Application Region, puis on choisit Geometry
dans Select, puis on clique sur Surface or Face, apres on sélectionne la surface a encastré,
puis on clique sur OK, ensuite sur Apply .

i File Group Viewport Viewing Display Preferences Tools Help Utilities ™
Home  Geometry  Properties || Loads/BCs | Meshing  Analysis  Results
I i
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-Apply-
x| L
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For Help, press FL NUM

Figure V.12 - Création de l'encastrement
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Patran 2010123 (Student Edition) =
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Figure V.13 - Annulation des degrés de liberté

(X Patran Z010-2- 3 (Student eaion,

File Group Viewport Viewing Display Preferences Tools Help Utilities

Home  Geomelry  Properties Meshing  Analysis  Results
4+ ] A B | e x|
S R M (@) P k| 2 D |e | || % BT s
3 : =1 |len |||

D Foree Velacity Di Pressure Inertial | Distributed | CID Distributed | Total || [+ |(][ %] |[ Deformable | Rigia | Color Code || (5|[<4/(E | Create ks
Constraint load | Load Load Load Bodies | %] Load Case ||| 58|
— Nodal Element Uniform Element Variable Contact Bodies Initial Conditt..|LBC Adti.J | Load Cases| [LBC Field:

AE LR

PALE-UD = default viewport - default_group - Entity

=T
Select Appication Region [«
~

Application Region

Select Geometry Entities
olid 2.1

Application Region

Soid 2.1

or Help, press F

Figure V.15 - Visualisation de I'encastrement
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e Définition des propriétés des matériaux

Dans ce projet on a choisi I’Aluminium comme le matériau de fabrication d’hélice et
on I'a considéré comme un matériau isotrope (conservation des propriétés suivant toutes
les directions) ces caractéristiques sont ( le module de Young E= 69 GPa et coefficient de
poisson = 0.33 et la densité :

p =2700 kg/m3)

Pour créer le matériau dans MD Patran on utilise Propreties >Isotropic puis on le
nomme Aluminium on entre les propriétés en cliquant sur Imput Data (Elastic Modulus
69 e9 et Poisson Ratio 0.33) puis on clique sur OK et en fin sur Apply maintenant on
définit le matériau de notre pale d’hélice en utilisant 3DPropreties (Solid) on le nomme
pale puis on clique sur Imput Propreties >I'icone Mat Prop Name on sélectionne
Aluminium puis on clique sur OK

i File Group Viewport Viewing Display Preferences Tools Help Utilities

Home Geometry Loads/BCs Meshing Analysis Results [ 2
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Figure V.16 - Définir le module d’Young et le coefficient de Poisson

Maintenant on définit le solide en cliquant sur Select Application Region on
sélectionne le corps de la pale puis on clique sur Ok
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i File Group Viewport Viewing Display Preferences Tools Help Utilities ™
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Figure V.17 - Sélection du matériau

e L’Analyse
On utilise I'onglet Analysis > Analyze > Entire Model puis on clique sur OK.

Nastran commence son calcul, les résultats sont enregistrés dans le lieu
d’enregistrement de la base des données.

B Patran 2010 udent Editio MD Nastran V2010.1 (pale)
i File Group Viewport Viewing Display PrefelETIEIO0EEY
N SUsers\TEHP\Desktop“\PALE PATRAN
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N N Hode1Suf fix
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— | — - IterSolyer
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WaitFlag o
Analyze Create || _Existing Deck Job cubpicted to local it
IC:\HSC.50f tuare\MD_Nastr _Edition\2@162\Nastran\bin\ndnast28181.exe PAL
[Ehdf prog=edu auth=edu arc hat=no
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Figure V.18 - L’analyse des données de calcul par Nastran
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Pour visualiser les résultats en MD Patran, on clique sur XDB puis on sélectionne

Result File, apres le fichier de I’extension (*.xdb) et ensuite sur Apply.

i File Group Viewport Viewing Display Preferences Tools Help Utilities

Home  Geomety  Properties  Loads/BCs  Meshing Results

J| =

opi a i
- “u £

lect File o =

Entire | Selected
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Analyze Create || Existing Deck || Optimize Access Results =
B Nom Modifié le Type
D& o= -
| palexdb 04/07/2011 08:04 _ Fichier XDB |
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Available Jobs
PALE
« i
Nom du fichier |pale | 0K
Types de fichiers [Files {“xdb) | Cancel
Job Name
PALE

1l

jo i raby

I Select Resuits File.
Transiation Parameters.

Figure V.19 - Importation de fichier (*.xdb)

e Résultats:
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Figure V.20 - Distribution des contraintes sur la pale d’hélice
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File Group “iewport \iewing Display Preferences Tools Help UHilities
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Figure V.21 - Distribution des déplacements le long de la pale

V.4 Simulation numérique de la pale d’hélice dans le cas rotatif avec MD
Nastran/Patran

On refait les mémes procédures comme précédemment avec les charges
aérodynamiques dans le cas d’hélice rotatif sauf qu'on a une force d’inertie en plus c’estla
force centrifuge qui est due a la rotation ( vitesse angulaire w =70 rad/s).

Calcul de la force centrifuge :

my?

Fc= = mw?R = 3.5154 702 0.29838 = 5139.73 [N]
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e Lesrésultats obtenus :

Figure V.22 - Distribution des contraintes le long de la pale.

£.1-no
el

Figure V.23 - Distribution des déplacements le long de la pale

V.5 Interprétation des résultats

V.5.1 Dans le cas statique d’hélice :

A partir de contour des contraintes on remarque que la concentration des
contraintes est autour de centre de gravité (zone rouge), la valeur maximale de la
contrainte atteint 1.14 10® [Pa] et la valeur minimale qui se trouve aux bords de la pale
atteint 9.82 10? [Pa].
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On voit que le déplacement maximal est en bout de la pale 2.43 107* [m]
J’évolutions des déplacements est croissante le long de la pale (de racine jusqu’au bout de

la pale ).

V.5.2 Dans le cas rotatif d’hélice :

A partir de contour des contraintes on remarque qu'une petite zone concentration
des contraint élevées apparait aux environs de centre de gravité qu’est due a la présence
de la force centrifuge, la valeur maximale de la contrainte est 5.25107 [Pa] et

2.19 103[Pal].

On voit que le déplacement maximal est en bout de la pale 2.25 10™4[m] .
L’évolution des déplacements est croissante le long de la pale (de racine jusqu’au bout de la

pale).
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Conclusion

La conception et le développement d'une hélice est une activité complexe qui fait
intervenir un grand nombre de disciplines complémentaires les unes des autres. Le
choix d'une architecture ou d’'un concept fonctionnel est toujours le fruit d’'une réflexion
qui vise a satisfaire une multitude d’impératifs souvent contradictoires. C’est la
qu’intervient l'essentiel du savoir-faire de I'hélicier qui saura proposer la solution
optimale.

Ainsi, en plus des applications destinées a I'aviation générale ou elle regne sans
partage en tant que mode de propulsion, I'hélice offre des perspectives d’évolutions
prometteuses. Celles-ci en font un équipement moderne qui aura toujours sa place dans
I'aéronautique.

Ce travail est fait d'une maniere comme étant un tutorial détaillé pour les futurs
promotions, et les enseignants peuvent 'utiliser comme un support de cours de la CAO,
CFD etla CSM, d'une part, et d’autre part ce projet été trop bénéfique pour nous de nous
avoir acquis une bonne connaissance concernant la simulation et la modélisation
numérique des fluides (CFD) et des structures (CSM), et aussi des compétences
d’utilisation des logiciels de CAO, de CFD et de CSM, qui nous pousser a réfléchir de
créer un bureau d’étude d’engineering ou un start-up au futur, si Dieu le veut !

Concernant les difficultés rencontrées au cours de notre projet, on n’a pas pu
obtenir une géométrie d’hélice concrete, malgré les dizaines de contacts avec les
héliciers (DUC Hélices, France Hélices, WOODCOMP), les chercheurs, les laboratoires et
les départements de I'ONERA, qui ne peuvent pas nous aider a cause de la
confidentialité. Et méme notre compagnie aérienne Air Algérie, qui ne dispose pas
d’'une géométrie détaillée d’hélice, aussi a cause de la confidentialité des constructeurs
d’avions. On a trouvé aussi des difficultés dans le maillage mobile qui nécessite un
matériel informatique puissant en CPU et en RAM pour mobiliser le maillage
facilement, pour cela on a simplifié notre géométrie a cause de la limitation de notre
matériel informatique.

Pour notre perspective, on propose aux futurs étudiants en fin de cycle de faire
une conception d’'une hélice aérienne ou d’éolienne et méme la réaliser, et notre projet
est une simple contribution qui peut I'aider dans leurs PFE.
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ANNEXE -A-

Présentation des logiciels de travail

Cette annexe présente les logiciels et les codes de calcul utilisés dans la
présente mémoire. Il s’agit de logiciel de CAO (SolidWorks 2010) plus un code
de génération de maillage (ANSYS ICEM CFD 13) et deux codes de simulation
numérique bien adaptés pour les études aérodynamique (ANSYS Fluent 13 et
ANSYS CFX 13) et deux codes de calcul de structures (MD Patran 2010 et MD
Nastran 2010 Student Editions).
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A.1 Logiciel de CAO (CAD : Computer Aided Design) : SolidWorks 2010

En 1993, Jon Hirschtick, fondateur de SolidWorks, a engagé une équipe d'ingénieurs
avec pour objectif de rendre la technologie CAO 3D plus accessible. Cette équipe a
développé la premiere technologie de CAO 3D capable de fonctionner sur une plate-forme
Windows qui n'impliquait pas d'utiliser des matériels et des logiciels coliteux a manipuler.
La premiere version de SolidWorks a été commercialisée en 1995. Au bout de deux mois, le
logiciel était reconnu par l'ensemble du secteur pour sa simplicité d'utilisation qui
permettait a un nombre toujours plus grand d'ingénieurs de tirer parti de la CAO 3D pour
donner vie a leurs conceptions.

En 1997, le géant mondial des technologies de cycle de vie des produits Dassault
Systemes a pris acte et acheté SolidWorks.

SolidWorks génére 3 types de fichiers relatifs a trois concepts de base : la piéece,
I'assemblage et 1a mise en plan. Ces fichiers sont en relation. Toute modification a quelque
niveau que ce soit est répercutée vers tous les fichiers concernés. Un dossier complet
contenant 1'ensemble des relatifs a un méme systeme constitue une maquette numérique.
De nombreux logiciels viennent compléter 1'éditeur SolidWorks.

Des utilitaires orientés métiers (tdlerie, bois, BTP...), mais aussi des applications de
simulation mécanique ou d'image de synthése travaillent a partir des éléments de la
maquette virtuelle.

A.1.1 Fonctionnement

A.1.1.1 Les piéces

La piece est I'objet 3D monobloc. La modélisation d'une telle entité dépendra de la
culture de l'utilisateur. Comme de nombreux logiciels conviviaux, SolidWorks permet
d'aboutir a un méme résultat apparent par des voies souvent différentes. C'est lors de la
retouche de ces fichiers ou de leur exploitation qu'on appréciera la bonne méthode. Une
piece est la réunion d'un ensemble de fonctions volumiques avec des relations
d'antériorité, des géométriques, des relations booléennes (ajout retrait).. Cette
organisation est rappelée sur l'arbre de construction. Chaque ligne est associée a une
fonction qu'on peut renommer a sa guise.
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Figure A.1 - Interface de SolidWorks 2010
Parmi les fonctions génératrices on trouve:

L’extrusion : déplacement d'une section droite dans une direction perpendiculaire
a la section. La section est définie dans une esquisse (qui apparait alors dans l'arbre de
création comme élément générateur de la fonction). Cette esquisse contient I'ensemble des
spécifications géométriques (cotation) nécessaires a la complete définition de la section.
Cet ensemble de cotes auquel il faut ajouter la (ou les) longueur d'extrusion constitue
I'ensemble des parametres de la fonction; il est possible de les modifier une fois la fonction

validée.

La révolution : déplacement d'une section droite autour d'un axe, ou extrusion

suivant un cercle ou un arc de cercle.

D'autres fonctions, plutdt orientées métier integrent des notions qu'il serait

fastidieux de modéliser :

Congés : Congé/Arrondi crée une face interne ou externe arrondie sur la piece. Vous

b

pouvez ajouter des congés a

sélectionnées, a des arétes sélectionnées ou a des boucles d'arétes.

toutes les arétes d'une face, d'un ensemble de faces

Coque : l'outil Coque creuse une piece, laisse les faces que vous sélectionnez

ouvertes et crée des fonctions parois minces sur les faces restantes. Si vous ne sélectionnez
aucune face sur le modele, vous pouvez transformer une piece volumique en coque, en
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créant un modele creux, fermé. Vous avez aussi la possibilité de créer une coque en
utilisant différente épaisseurs.

Des fonctions d'ordre logiciel comme :

La répétition linéaire : La Répétition linéaire apparait lorsque vous répétez une ou
plusieurs fonctions sur une ou deux trajectoires linéaires.

La répétition circulaire : La Répétition circulaire apparait lorsque vous créez une
répétition d'une ou de plusieurs fonctions autour d'un axe.

Avec tous ces outils, la méthode de conception d'une piéce trés proche du métier du
concepteur qui ne soucis plus de savoir ou placer les traits du dessin mais les formes de la
piece. Les possibilités d'éditions sont complétées par un ensemble d'outils de mesures
géométriques. Ainsi il est possible de connaitre le volume de la piece, son poids, la position
de centre de masse, sa matrice d'inertie, la surface...

II1.1.1.2 Les assemblages

Les assemblages sont obtenus par la juxtaposition de pieces. La mise en position de
pieces est définie par un ensemble de contraintes d'assemblage associant, deux entités
respectives par une relation géométrique.

Dans une certaine mesure, ces associations de contraintes s'apparentent aux
liaisons mécaniques entre les pieces. Le mécanisme monté, s'il possede encore des
mobilités, peut étre manipulé virtuellement. On peut alors aisément procéder a des
réglages a l'aide des différents outils disponibles (déplacement composants, détection de
collision, mesure des jeux, etc.).

Comme pour les pieces, la gestion de I'ensemble est portée par un arbre de création
qui donne acces a I'arbre de création de chaque piéce. Il est d'ailleurs possible d'assembler
des assemblages, donc de former des sous-groupes de piéces. Cette opération étant
préalable ou en cours d'édition.

L'intérét de cet outil, c'est qu'il rend possible la création d'une piece dans
I'assemblage, c’est qu'il propose la méme méthode au concepteur que celle qu'il appliquait
sur la table a dessin : tout concevoir en méme temps. En effet, a part sur les petits
ensembles simples (ou déja définis), il n'est pas raisonnable de concevoir chaque piece
dans son coin pour corriger ensuite, lors de l'assemblage, les problemes éventuels
d'interférence, ou de coincidence. La conception intégrée lie automatiquement les
géométries des pieces entre elles, si bien qu'une modification sur une, est
automatiquement répercutée sur les autres. Alors 1'édition de piece est la conséquence de
I'édition de I'ensemble.
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A.1.1.3 Les mises en plan

Les mises en plan concernent a la fois les pieces (dessin de définition) ou les
assemblages (dessin d'ensemble). Pour aboutir a un plan fini d'une piece on peut estimer
mettre 2 fois moins de temps qu'avec un outil DAO (temps de conception et exécution du
dessin). En effet, en DAO, chaque trait est indépendant, et c'est au dessinateur de savoir
quelles entités graphiques sont concernées par une modification. Le logiciel 3D ne fait
qu'une projection de I'objet.

Les modifications éventuelles sont opérées sur l'objet représenté, et ne concernent
pas directement le plan.

.
’/{/ \\\'\\
il L

LA ) 1A __
¥ ! ',-\\-. |
- | -

L) \ |
o j ,

\\\\\H_ 7_/_.///( A

Ll s —

Yizimes

A-A

Figure A.2 - Dessin de définition établi avec SolidWorks

e Vues : La projection sur plan du modele ne pose aucun probleme. Aujourd'hui il est
tres facile d'obtenir un plan, forcément juste (avec un logiciel de DAO il est possible d'éditer
un plan faux!). Les vues en coupes, les vues partielles, perspectives, sont exécutées d'un
simple clic. Les seuls problemes encore rencontrés concernent la représentation des
filetages et taraudages dans les assemblages.

De plus, chaque vue peut étre exécutée avec un habillage différent, filaire, conventionnel ou
ombré rendant encore plus accessible la lecture de plans aux non initiés.

e Cotation : La cotation regroupe l'ensemble des spécifications géométriques
définissant la piece. Bien sir, les parametres déclarés des esquisses en font partie. Ils
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peuvent étre automatiquement intégrés, de maniére équilibrée, a la mise en plan. A ce
niveau il est encore possible de modifier la piece en changeant la valeur des cotes.
L'indépendance de ces parametres, se rapproche du principe dit d'indépendance (cotation
GPS). Cependant, la mise en forme définitive de la cotation demande encore un peu de
travail (avec un éditeur DAO ou sur le calque aussi!).

¢ Fond de plan : SolidWorks par défaut propose ses propres fonds de plan. Mais il est
possible de les faire soi-méme ; Il existe deux types de fond de plan:

- Lefond de plan statique, ou il faut remplir a la main chacun des champs.

- Le fond de plan dynamique, ou il se remplit automatiquement suivant les
parametres mis dans 1'assemblage ou dans la piece.

- Des modeles sont proposés (équivalent du .dot de WORD).

e Nomenclature : Le fichier assemblage contient chacune des pieces qui composent
I'assemblage, on peut donc sortir de fagcon automatique la nomenclature appartenant a la
maquette 3D.

A.1.1.4 Les extensions des fichiers:

La simple ouverture d'un fichier dans une version ultérieure le rend inutilisable
pour toutes versions antérieures.

Vu leur tres faible interopérabilité et le fait que leur contenu soit sauvé sans que 1'on
utilise la commande de sauvegarde, ces fichiers SolidWorks ne doivent pas étre considérés
comme des sauvegardes a long terme d'un contenu, mais comme une simple extension de
la mémoire physique ayant la propriété de rémanence.

Chaque type de fichier possede une extension qui lui est propre. On retrouve :
.sldprt, pour les fichiers piece.

.sldasm, pour les fichiers assemblage.

.slddrw, pour les fichiers plans.

.slddrt, pour les fichiers de fond de plan.

Certains formats proposés par le logiciel permettent d'envisager une sauvegarde a long
terme.
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A.2 Logiciels de génération de maillage
A.2.1 ANSYSICEMCFD 13

C'est un logiciel de génération de maillage dédié a la mécanique des fluides, mais
également aux applications de mécanique de structures.

Dans le domaine de la mécanique des fluides, ANSYS ICEM CFD 13 s'est imposé
comme le module de pré-processing le plus utilisé, que ce soit dans I'industrie automobile,
aéronautique, aérospatiale, chimique, des turbomachines, électrotechnique ou médicale. Ce
module est également de plus en plus employé comme pré-processeur dans le calcul de
structures.

ANSYS ICEM CFD 13 représente un pont entre la construction et le calcul, le systéme
est ouvert, permettant de lire aussi bien des formats CAD, STL ou simplement des points et
de créer un maillage destiné a la plupart des codes CFD/CAE du marché.

ANSYS ICEM CFD 13 offre des interfaces directes CAO (notamment CATIA, Cadds5,
ICEM surf, Pro/ E, Ideas, SolidWorks, Solid Edge...) permettant un transfert de la géométrie
de I'un a I'autre des systéemes CAO.

Elle comprend plus de 100 interfaces exportation du maillage vers les principaux
codes CFD et FEA (ANSYS, Abaqus, Fluent, Star-CD, CFX, Flotran...) ou d’autres codes CAE
(codes d’électromagnétisme...), ainsi que des formats de sorties standard dont CGNS.

A.2.1.1 Ouverture du programme, emplacement disque de travail et sauvegarde

On démarre /Tous les programmes/ANSYS 13.0/Meshing/ICEM CFD

A.2.1.1.1 Choix dul'emplacement de travail
Afin d’éviter des erreurs lors des sauvegardes ou lors de la création du ficher pour le

maillage, il faut s’assurer que le logiciel stock ses fichiers sur un disque ot I'on posséde les
droits d’acces et de modification.
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Figure A.3 — Change Working Directory

A.2.1.1.2 Sauvegarde du projet

Afin d’éviter la perte du travail, il est conseillé de choisir des le début le chemin pour
sauvegarder le projet. Le projet est enregistré sous le format .prj

B ICEM CFD 13.0: -‘l
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Mew Project... L,,) o

Open Project. .
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Figure A.4 — Save Project As...
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Il n’est pas rare que le programme plante lors de la réalisation du maillage, de sa
modification et plus rarement lors de la modification de la géométrie (lignes ou surfaces
complexes).

A.2.1.2 Lazone de travail et les onglets d’options

A.2.1.2.1 Zone de visualisation/travail

Fie Edit View Info Setings Windaws Help |

=& [g[g@\ #) O | Geomety ]Mesh | Blocking | Editesh | Propetties | Constiaints | Loads | olve Options | Ouiput | Can3D | Pastpracessing |

BOMKE Q@ #\ gHENSERXENX |

Ei Model
i Geomstry \
id Mesh e |8

il Parts

v ~n e ane
[~ Log Save| Clear

Figure A.5 — Zone de visualisation/travail

C’est dans cette zone que sera affiché le résultat du travail, la navigation s’y fait au
moyen de la souris.

- Clic gauche maintenu = rotation libre de I'image

- Clic droit maintenu +haut/bas = zoom centré

- Clic droit maintenu +gauche/droite = rotation suivant I'axe sortant
- Molette haut/bas = zoom

- Clic central/molette = déplacement dans le plan

Pour revenir a une vue normée il suffit de cliquer sur un des axes :
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Figure A.6 — Axes X,Y,Z

A.2.1.2.2 Boite de dialogue - fichier log

Zone de texte ou seront affichées des informations comme le nombre de mailles, la
création de droites ou des informations les erreurs et leurs raisons.

Lo Save] Co

Figure A.7 — Boite de dialogue

A.2.1.2.3 Fonctions courantes

Icones des outils utilisés le plus souvent, personnalisable.

&l

L’icone permet de recentrer la vue et ) (X permet le retour en arriere/avant.

= BB
BEOREE QR

Figure A.8 — Fonctions courantes

A.2.1.2.4 Onglets de travail

L’ordre des onglets est I'ordre normal de progression pour la réalisation du
maillage.

Un suivi pas a pas permet d’éviter des oublis de choix d’options, etc. ...
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Geometry IMesh |Block|ng | Edit Mesh | Dutput |

Figure A.9 — Onglets de travail

A.2.1.3 Création du maillage

Afin de réaliser le maillage il faut changer d’onglet :

Gecorgtry  Mach | Blocking ]EdtMcsh ]

BaEL LT ®

——Global Mash Sebupf

| I
A.2.1.3.1 Définitions globales
m": Ouvre la boite de dialogue suivante :
— Global Mezh Parameters =
e s
BeeaS
— Global Element Scale Factor
Scale factor |1
[ Display
— Global Element Seed Size
Max element |0
[ Display
— Curvature/Proximity Bazed Hefinement
[ Enabled e
Mir size fimit |1
™ Display
Elementz in gap I'I ﬁ

Figure A.10 - Les parameters de maillage

Les deux premieres options permettent une adaptation globale des parametres du
maillage. (Résolution et nombre de d’éléments)
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L’icone suivante permet de choisir le type de maillage :

— Global Mesh Parameters

Bees%

teszh tppe |Guad Dominant

Al Tri
[Quad wione Tr

tesh method

Sechan |Patin LSRG G

—1
General
|gnare zize |EI.I]2
[~ Respect ine elements
Figure A.11 - Choisir le type de maillage
A.2.1.4 Choix de solveur et exportation de maillage
. NI Dutput
Ce choix se fait vial'onglet T
Solver Setup &
Clukput Sakes INastran x|
Comman Shuziural Sober [ANSYS =
[T Set kg Defaak

Figure A.12 - Choix de solveur

.. Qutput Saobes |FI | WE
Il faut choisir: — oo TRE

) . ]
EtI'option [# Setds Dofault

méme manipulation lors du prochain maillage.
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Les icones [ﬂ[ﬂl ne sont pas traitées ici, ces fonctions étant disponibles sous fluent.

Ouverture de la fenétre de dialogue via B

Si le solveur a bien été sélectionné, il doit apparaitre :

(4 Fluent ¥6 x|
Pleaze adit the folloving Fluent_iE
ophicez.

Gnd dimengiore % 300 2D

Scaing ez O Mo
1.1
110
I

Wite bnay i € Yes & Mo

lgnore coudlings & 'fes & Mo

Boco fig |Tu||:n-i[:ern.fh|:
Olukput fie |'1"..-’f|u:nt.l'tull:l icem/fhient

Cione | Carcel I

Figure A.13 - Grid dimension : 2D

A.3 Logiciels de CFD

L'augmentation rapide de la puissance des calculateurs a rendu possible le
développement de codes commerciaux traitant les problemes de transport dans les fluides.
Il existe un certain nombre de codes tridimensionnels industriels, aux meilleurs
performants, permettant la prédiction d’écoulements de fluides (FLUENT, CFX, PHOENICS,
STAR-CD, TRIO, FEMLAB ...).

La résolution des équations gouvernant ces écoulements (équations de Navier-
Stokes) est faite par le biais des méthodes des volumes finis, des différences finies ou des
éléments finis.
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A.3.1 ANSYS CFX 13

Afin d’anticiper I'importance croissante des applications CFD dans le département
R&D des entreprises, ANSYS Inc. a étendu en 2003 sa palette de produits avec le code CFX.

CFX fait partie depuis 20 ans parmi les solutions dominantes dans le domaine de la
simulation de fluides. ANSYS propose ANSYS CFX 13 aussi bien comme solution

indépendante dédiée au calcul fluide, que comme application intégrée dans les solutions de
mécanique des structures pour des utilisations couplées.

Fie Edt Sesson Insert Tools Help

HB % m 0c % 5302 EMA OH OkE@adl bd%E]
Outine h SEARKE O n
4 [8] Mesh View1 ~
b (8] fluent.msh
@ Connectivity
4 [&] Simulation

4 (@] Flow Analysis 1
(@© Analysis Type
4 [ 6 fud

Pt symetrie2
¥ Interfaces
a Solver
& Solution Units
o Solver Control
& Output Control
L Coordinate Frames
b [&] Materials
(@] Reactions
4 (3] Expressions, Functions|
(&) Additional Variable|
Expressions
User Functions
User Routines
4 [g Simulation Control
(&) Configurations
3 Case Options

Ty
b

Figure A.14 — Interface de ANSYS CEX-Pre

Le logiciel de calcul ANSYS CFX 13 est utilisé dans le développement de produits ou

'analyse de processus de fabrication quand un écoulement, un transfert de chaleur ou une
réaction chimique joue un réle important.
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File Edit Session Insert Tools

BHEELD@ 9| Bean - SEEST

Help.

S HpHFALO *x EEE RS OMmM# 7 A8 b

Outine | variables | Expressions

| calcuiators | Turba |

4 [3) Cases
4 (@] oFx

4 (5 Default Domain
F e

h
4 [g8] User Locations and Plots
Contour 1
¥ Default Transform
[F# Default Legend view 1
&F Streamiine 1
) wireframe
4 [E] Report
& Titke Page
» [#] g File Report
b [#] g MeshReport
3 &> Physics Report
3 &> Solution Report
User Data

fm Eeaae & O- %

Viewl ~

Deta

s of Streamline 1

Geometry | Color | symbol | Limits | Render | view |

Reducton |Max Number af Faints -] i
Max Points 200 =]

A
variable [veloaty ) ()

CFX est un outil de simulation 3D efficace permettant de répondre rapidement a des
problémes d'écoulements et de trouver des solutions adéquates. Il en découle un nombre

Figure A.15 — Interface de ANSYS CFX-Post

plus restreint de prototypes et donc un gain de productivité.

Modélisation et Maillage

ANSYS/PREPT

ANSYS CFX-CAD2Mesh
Design Modeler
CFX-Mesh

ICEM TetraPrism

Add on: ICEM Hexa

-~ Caleul et traitement des
résultats

CFX-Pre
Read in mesh, appl'f
loads & boundary
condiions

CFX-Solve

9
L
=

Figure A.16 - Les étapes de simulation avec ANSYS CFX
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Geometry Generation
Software

Y

Mesh Generation
Software

Y ANSYS CFX

ANSYS CFX-Pre Components
{Physics Pre-processor)

¥
ANSYS CFX-Solver . o | ANSYS CFX-Solver Manager
{Sohver) o 7 | {CFD Job Manager)

¥

ANSYS CFD-Post
{Post-processor)

Figure A.17 - Etapes de simulation sous ANSYS CFX

A.3.2 ANSYS Fluent 13

A.3.2.1 Présentation

Le code de calcul ANSYS Fluent 13 utilisé dans notre mémoire est commercialisé par
le groupe ANSYS. Ce groupe est actuellement I'un des pdles de compétence en mécanique
des fluides numérique et en calcul de structures les plus importants. Il développe et
commercialise une solution complete sous forme de logiciels de CFD (Computational Fluid
Dynamics) et de calcul de structures généralistes qui simulent tous les écoulements fluides,
compressibles ou incompressibles, impliquant des phénomeénes physiques complexes tels
que la turbulence, le transfert thermique, les réactions chimiques, les écoulements
multiphasiques et aussi les solutions de mécanique de structures pour toute I'industrie.
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File Mesh Define Solve Adapt Sutface Display Report Parallel View Help

BEr-d-ae[Bra Qs

Problem Setup
General
Models
Materials
Phases
Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values
Solution
Solution Methods
Solution Controls
Monitors
Solution Initialization
Calculation Activities
Results
Graphics and Animations
Plots
Reports

e

6585 triangular wall faces, zone 41, binary.
309 triangular wall faces, zone 42, binary.
9108 triangular velocity-inlet faces, zone 43, binary.

4 el s

Figure A.18 — Interface du solveur ANSYS Fluent 13

Les produits et services proposés par ANSYS Fluent 13 aident les ingénieurs a
développer leurs produits, a optimiser leur conception et a réduire leurs risques. Ce code
est largement utilisé dans l'industrie aéronautique, automobile et offre une interface
sophistiquée qui facilite son utilisation. Le logiciel ANSYS Fluent 13 modélise par la
méthode des volumes finis des écoulements tres variés dans des configurations plus ou
moins complexes. Il est composé, comme tout logiciel de type CFD, de trois éléments clés
qui sont: le pré-processeur, le solveur et le post processeur. Nous détaillons ci-dessous ces
trois éléments :

a. Le pré-processeur ANSYS ICEM CFD 13

IIs permettent a I'utilisateur de construire la géométrie du domaine de calcul et de
subdiviser ce dernier en petits volumes de contrdle ou cellules de calcul. L’ensemble de ces
volumes élémentaires constitue le maillage. La définition des conditions aux limites
appropriées, au niveau des cellules qui coincident ou touchent la frontiere du domaine de
calcul, se fait également a ce niveau. Il permet de créer plusieurs types de maillage suivant
la géométrie et de spécifier le type de matériau (fluide ou solide).

b. Le solveur ANSYS Fluent 13

Permet de définir numériquement les conditions opératoires (gravité pression...)
dans lesquelles, est effectuée la simulation, ainsi que la spécification des conditions aux
limites, il permet de choisir le processus itératif, en proposant plusieurs schémas
numériques pour la discrétisation spatiale et temporelle, et pour le couplage de vitesse et
de pression.
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Les équations discrétisées y sont résolues et sont décrites sous forme : Convection -
Diffusion = Sources - Pertes. Pour des fluides incompressibles, les calculs se font en
pression relative. La méthode utilisée est la méthode des volumes finis. Cette méthode a
I'avantage d’étre conservatrice, c’est a dire que tout le flux sortant d’'un volume de contréle
entre dans les volumes voisins. Les étapes de calcul sont les suivantes :

e Intégration des équations continues sur chaque volume de contrdle. Le théoréme
d’Ostrogradski est utilisé pour transformer certaines intégrales de volume en
intégrales de surface,

e Discrétisation en espace et en temps (pour les écoulements non permanents) des
équations : substitution des dérivées partielles par des approximations en
différences finies ; transformation du systeme d’équations en systeme algébrique,

e Résolution du systeme algébrique par un processus itératif ; utilisation d'un
algorithme pour corriger la pression et les composantes de la vitesse afin
d’assurer la conservation de la masse.

c. Le post-processeur

Le Post-processeur permet de visualiser la géométrie et le maillage du domaine
mais surtout d’afficher les résultats obtenus, Il est ainsi possible de visualiser les champs
(pression, vitesse, température ...) ainsi que toutes les grandeurs calculées .1l offre aussi la
possibilité de tracer et visualiser les lignes de courants.

AUENT FLUENT 50 pors o AT ORI R
File Mesh Define Solve Adapt Surface Display Report Parallel View Help

BEr-Ed-me|Bra i@ nEy-o-

1: Contours of Static Pressur v |

Problem Setup
General
Models
Materials
Phases
Cel Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values
Solution
Solution Methods
Solution Controls
Moritors
Solution Initialization
Calaulation Activities
Run Calculation
Results
Plots
Reports

-3.85e+03

Contours of Static Pressure (pascal) May 20, 2011
ANSYS FLUENT 13.0 (3d, pbns, lam)

int_fluid
surface-farfiled-entree
surface-farfiled-sortie
surface-farfiled-lateral

=]

Figure A.19 — Visualisation de contour de pression statique dans ANSYS Fluent 13
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A.3.2.2 Principales étapes de simulation sous ANSYS Fluent 13

e Importation du fichier (*.msh).

e Vérification Du Maillage Importe.

e Lissage Du Maillage (Smooth and Swap the Grid).
e Vérification De I'échelle.

e Choix Du Solveur.

o Affichage de la grille.

e Choix du modele de turbulence.

e Définition des caractéristiques du fluide.

e Operating conditions.

¢ Conditions aux limites usuelles.

A.3.2.3 Conditions Aux Limites

e Spécification du domaine fluide.

e Spécification des volumes "solid" tournantes.
e Définitions des interfaces fixes et mobiles.

e Choix des criteres de convergence.

e Initialisation Des Calculs.

e Sauvegarde du fichier "*.cas".

e Lancement de la simulation.

e Post-traitement numérique de la solution.

A.4 Logiciels de modélisation structurale

L'utilisation du calcul par éléments finis pour l'analyse de structures est devenue
tellement courante que seuls les criteres de prix d’achat sont considérés par certains
décideurs comme prépondérants. Mais pour beaucoup de spécialistes, qu’ils soient
ingénieurs calcul, ingénieurs de développement ou responsables de bureau d’étude, prix et
colit ne sont pas synonymes. Choisir une solution d'analyse de structures qui puisse
évoluer en fonction de vos besoins, plutot que de devenir rapidement obsoléte, vous
conduira a réduire le cofit global de possession et vous permettra de réaliser des produits
performants.

MD Nastran 2010 et MD Patran 2010 proposent un ensemble de solutions pour
I'analyse de structures qui répond a la fois aux besoins des ingénieurs, des concepteurs et
des experts calcul expérimentés. Ces solutions aident les entreprises a relever leurs défis
industriels en permettant aux ingénieurs d’avoir une meilleure compréhension du
comportement de leurs produits grace aux tests virtuels. Les ingénieurs qui utilisent les
solutions d'analyse de structures de Nastran et Patran sont a méme d'évaluer de
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nombreuses variantes de conception, ce qui confortera leur choix de conception pour
répondre aux exigences définies, avant méme que le produit physique ne soit construit. De
la piéce unique aux grands systemes complexes, de la statique linéaire aux problemes
dynamiques non-linéaires, les solutions d'analyse de structures de Nastran et Patran sont
congues pour évoluer avec le besoin, optimiser le colit de possession, et accompagner les
entreprises dans la réalisation de leurs objectifs.

Les solutions MD Nastran et MD Patran pour I’Aéronautique et la Défense :

e Vibration test au sol (GVT)

e Chargements internes et externes

e Impactetingestion d’oiseau

¢ Contraintes sur composants et ensembles

e Atterrissage/amerrissage

e Statique aéroelastique, simulation des oscillations (effet flutter) et de rafale
e Simulation de balistique et des armements

e Modélisation de grands assemblages

e Modélisation dynamique des rotors

e Simulation cinématique de trains d’atterrissage et de déploiement de volets
e Analyse vibratoire aléatoire

e Rayonnement orbital

e Modélisation des composites et analyse a la rupture

e Gestion des matériau

A.4.1 MD Patran 2010 (Student Edition)
L’environnement de modélisation par éléments finis multidisciplinaire

Patran est un environnement complet de pré- et post-traitement dédié a I'analyse
par éléments finis, qui permet aux ingénieurs de développer et tester virtuellement des
conceptions de produits. Utilisé par les leaders mondiaux comme standard pour la
création et I'analyse de modeles de simulation, Patran associe conception, analyse et
évaluation des résultats au sein d’'un environnement unique.
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Figure A.20 — Page d’accueil de Patran 2010 (Student Edition)

Patran constitue une excellente solution de modélisation par éléments finis et de
visualisation et de traitement des résultats pour les entreprises désireuses d'utiliser
I'analyse par éléments finis, dans le but de réduire la durée et le colit des processus de
développement de produits grace a un recours accru a la simulation. En donnant acces aux
ingénieurs a la solution leader d’analyse de MSC Software, Patran aide les entreprises a
réduire les colits et les contraintes liées a la maintenance de plusieurs outils de pré- et
post-traitement dans différents services de l'entreprise, ainsi qu’a mettre sur le marché
plus rapidement des produits de meilleure qualité.

Grace a l'intégration transparente de la géométrie CAO, de fonctionnalités de pré- et
post-traitement et de la capacité a effectuer des simulations perfectionnées sur des pieces,
des structures et des assemblages virtuels, Patran joue un rdle clé dans le processus de
conception de nombreuses entreprises pour accélérer la commercialisation et accroitre la
qualité de leurs produits.
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Pl Patran 2010.2.3 (Student Edition) = W
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Figure A.21 — Géométrie préparée pour la modélisation sous MD Patran 2010

Patran permet aux ingénieurs d'importer directement des géométries depuis
n'importe quel logiciel de CAO, puis de définir les charges, les conditions limites et les
propriétés des matériaux, afin de procéder a diverses simulations dans des conditions
différentes, de visualiser les résultats et, enfin, de mieux comprendre le lien entre les
décisions de conception et les caractéristiques de performances des produits, telles que les
contraintes, les déformations, les vibrations, le transfert thermique et bien d’autres.

Par ailleurs, linterface graphique intuitive de Patran est congue pour étre
totalement personnalisable en fonction des processus d’'ingénierie spécifiques a
I'entreprise. Grace au langage de commande Patran PCL (Patran Command Language), les
ingénieurs peuvent compléter les puissantes fonctionnalités de modélisation et d’analyse
par leurs propres applications, commandes et menus personnalisés. Les utilisateurs de
Patran peuvent facilement et efficacement réitérer et évaluer différentes options de
conception, ou réutiliser des conceptions et des résultats existants, sans perdre de temps a
effectuer un nettoyage manuel ou a recréer les données.
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MD Patran I
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Figure A.22 - Fonctionnement et fichier de MD Patran-MD Nastran

A.4.1.1 Acces direct aux géométries de CAO

Patran permet I'accés direct aux géométries des principaux systémes de CAO pour la
création de modeles par éléments finis. Grace a cet acces direct, le format d’origine des
géométries reste intact et celles-ci sont importées dans la base de données Patran sans la
moindre conversion ou modification. De nombreux formats standards d’échange de
géométrie sont également pris en charge. Une option permet I'import direct au format
Parasolid de nombreux systémes de CAO et formats d’échange. Tous types d’éléments finis,
charges, conditions limites et propriétés de matériaux peuvent étre associés a la géométrie.

A.4.1.2 Création et modification de géométries

Outre les fonctionnalités d’acces direct aux composants de CAO pour I'élaboration
de géométries de modeles par éléments finis, Patran contient un ensemble élaboré d’outils
de création de géométrie. Patran possede également une fonction sophistiquée de
reconnaissance de formes fonctionnelles, permettant aux utilisateurs de supprimer ou de
modifier alésages, raccords et chanfreins. Pour les géométries solides en 3D, les maillages
et charges existants sont automatiquement réappliqués au modele apres qu’'un
changement a été apporté a la géométrie.
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A.4.1.3 Intégration avec MSC Nastran et MD Nastran

Patran est congu pour prendre en charge aussi bien MSC Nastran que MD Nastran,
afin de permettre l'utilisation de modeles par éléments finis communs et I'exécution
d’analyses d’'ingénierie avancées, ainsi que d’améliorer les conceptions grace aux
fonctionnalités d’optimisation de la conception et de la topologie de Nastran.

A.4.1.4 Interface utilisateur graphique

L’interface utilisateur graphique de Patran consiste en un systeme de menus basé
sur les formes et piloté a la souris, a partir duquel toutes les taches sont accessibles. Il est
spécialement congu pour simplifier la prise en main et I'utilisation.

A.4.1.5 Modélisation par éléments finis

Le systeme de modélisation par éléments finis de Patran permet a l'utilisateur
d’accéder directement a la géométrie d'un modele et de développer rapidement des
maillages par éléments finis. Créez et modifiez simplement votre maillage par éléments
finis a I'aide de générateurs de maillage automatisés et des technologies MSC Software,
telles que les mailleurs Mid-Plane Mesher et Advanced Surface Mesher.

B Patran 2010.2.3 (Student Edition) :E@
! File Group Viewport Viewing Display Preferences Tools Help Utilities B
Home Geometry Properties Loads/BCs Meshing Analysis Results
D)= B| B & || < ||En| a8 4|/ ||| o] m])| B || ]| 2| Be | ke |4 |55/ )| &3]
e A Y - =T e e = Thf
Defaults Wiewport Display Orientation Misc. [Web
DEN LR
T Structure.db - default_viewport - default_group - Entity ol g
Animation Control | Geometry |
Action: A |9
Object: t
Method: ‘:

Point ID List
129

Refer. Coordinate Frame
Coord 0

Auto Execute

Point Coordinates List
000

-]

+ A2 BT AN -

v

i
For Help, press Fi

Figure A.23 — Maillage sous Patran 2010 (Student Edition)

A.4.1.6 Charges et conditions limites

Patran fournit un ensemble complet de charges et de conditions limites, par
exemple de type structurelles et thermiques. Les variations fonctionnelles peuvent étre
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évaluées a 'aide de facteurs mathématiques ou d’autres résultats d’analyse. Les charges et
les conditions limites peuvent étre spécifiées en totalité ou sur une base incrémentielle.

A.4.1.7 Propriétés des matériaux et des éléments

Patran prend en charge un éventail de modeles de matériaux, notamment de type
isotrope, orthotropique, anisotrope, composite, isotrope thermique, orthotropique
thermique et anisotrope thermique pour réaliser les analyses les plus diverses.

A.4.1.8 Evaluation des résultats

Patran peut afficher les résultats d’analyse de facon claire et rapide sur le plan
structurel, thermique, de l'usure, fluide ou magnétique, ainsi qu’en rapport avec toute autre

application, ou les valeurs de résultat sont associées a leurs éléments finis ou noceuds
respectifs.

B Patran 2010-2-3 (Student Edition) e
i File Group Viewport Viewing Display Preferences Tools Help Utilities }{
Home Geometry Properties Loads/BCs Meshing Analysis Results
milr=20 3= = e =R TS A LAl a
i}
B x| | B |2 5% |00 |2 3 |t | e s | )
Defaults Transforms Viewport Display Crientation Misc. \Web

DEf k-
B Structure.db - default_viewport - default_group - Entity

ozl

Rosuts [ Proerences|
[ B | [a]

Select Fringe Result

Stress Invariants, Mean Pressure b]
Stress Invariants, Minor Principal

Stress lvariants, Von Nises

Stress Tensor,

&l m &l

i+ o &

O o

Select Deformation Result
Constraint Forces, Rotational
Constraint Forces, Translational
Digplacements, Rotational

Displacements, Translational

[¥] Animate:

Apply

]
[k

E]

NUM

For Help, press F1 }

Figure A.24 - Exemple de résultat sous MD Patran 2010 Student Edition
(Background Bleu)
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i File Group Viewport Viewing Display Preferences Tools Help  Utilities

Home Geometry Properties Loads/BCs Meshing Analysis Results

D= @S| ¥ 9| (G| e o] i) e | E || 8| 553 5P &
B2 [0 | o R | €2 | [ | R | | B3 | =

Defaults .Transmrms Viewport Display Orientation Misc,

o5 et e ||| )| 1) |

on, Intermed Prinx

jonal,

For Help, press F1

nir + o &

0o -

NUM

Figure A.25 - Exemple de résultat sous MD Patran 2010 Student Edition
(Background Noir)

A.4.1.9 Imagerie

L’'imagerie comprend I'ensemble des fonctionnalités graphiques que comporte le
produit Patran, y compris les fonctions d’ombrage et de vérification visuelle avant analyse.
L’'imagerie comporte un certain nombre d’options tirant profit de fonctionnalités
matérielles spécialisées, notamment le maniement des vues locales, I'ombrage local,

I’éclairage multi-sources et la transparence.

Vous pouvez également exporter des images et des animations dans de nombreux
formats standard, en vue de les inclure dans des documents et des rapports basés sur le

Web.
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Geometry FEM Model Analysis Results
Element Properties Load Cases
Material Properties Loads and Boundary Conditions

Figure A.26 — Mission fonctionnel de Nastran-Patran

A.4.1.10 Langage de commande Patran

PCL est le langage de programmation central de Patran. PCL est un langage a
structure de bloc évolué, offrant de nombreuses fonctions caractéristiques des langages de
programmation traditionnels. Il peut étre utilisé pour écrire des commandes et des menus
spécifiques a une application ou un site, procéder a une modélisation variable et optimiser
'intégration avec des logiciels commerciaux ou maison.

A.4.2 MD NASTRAN

Le solveur Nastran est un logiciel d'analyse par l
éléments finis généraliste, utilisé pour les calculs statiques de
contraintes, déformations, les calculs dynamiques, Fichier ASCII

I'acoustique, et thermiques, pour tout type de structure et
composant mécanique, ainsi que les analyses couplées de
plusieurs disciplines telles que la thermomécanique et
I'interaction fluide-structure.

Flchier binaire [
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A.4.2.1 Solution multidisciplinaire pour une plus grande efficacité

Il est rare qu'une structure ne soit soumise a des criteres de conception ne
concernant qu'une seule discipline. L’obtention d’'un modele performant suppose
généralement la prise en compte de facteurs multiples, voire de disciplines multiples. Il
peut s’agir de problématiques relativement simples telles que I'’étude d’une charge statique
linéaire combinée a une analyse fréquentielle, ou aussi complexe que la prise en compte de
chargements résultant d'une analyse dynamique multi-corps pour une étude de choc (ex.
un véhicule qui dérape et emboutit une barriere), ou encore une étude de précontrainte
par analyse non linéaire implicite suivie d'une étude d’impact utilisant une analyse
explicite, qui elle-méme peut encore étre suivie d’'une analyse implicite des contraintes
résiduelles.

Les analystes sont souvent obligés d’utiliser plusieurs outils incompatibles entre eux
pour traiter les différents aspects d’'un projet. D’ou une difficulté, voire I'impossibilité de
prendre en compte un grand nombre d’interactions. Les analystes ont alors recours a des
approximations, quand ils n'omettent pas tout simplement les effets de certaines
disciplines, ce qui peut conduire a une solution non optimale.

MD Nastran apporte ici plusieurs avantages :

e Une plateforme unique pour une large gamme de disciplines, d’ou une grande
efficacité en termes de création de modeles et de maintenance.

¢ Une communication sans entraves entre les différentes disciplines, dont les études
peuvent s’enchainer successivement pour tenir compte des effets d'un type
d’analyse sur les autres. Par exemple, des résultats de précontrainte peuvent
facilement étre intégrés dans une étude dynamique.

e Une intégration simultanée de disciplines multiples dans un seul modele, ce
couplage permettant d’obtenir une solution plus précise et mieux optimisée.

A.4.2.2 Multi-physique pour une précision accrue

Les équipes de développement de produits ont besoin de valider et d’optimiser leurs
modeles selon plusieurs disciplines, y compris celles qui font intervenir différentes
branches de la physique : thermique, acoustique, mécanique des fluides... Elles ont besoin
de comprendre dans quelle mesure 'historique thermique ou I'état thermique affecte le
comportement mécanique, ou alors comment I’état d’'un véhicule influence I'acoustique de
I’habitacle, ou comment les contraintes et déformations induites par un écoulement
affectent le comportement d’un systéme.

A l'aide d’'une approche découplée dont les différentes étapes s’enchainent et d’'une

méthode de couplage, MD Nastran apporte la souplesse qui permet d’'intégrer I'influence de
phénomeénes physiques multiples dans vos modeles. L’évolutivité de MD Nastran permet
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également de réaliser I'étude compléte d’un véhicule sans sacrifier la précision. Quelques
exemples de problémes qui peuvent étre traités par MD Nastran sont :

e L’acoustique intérieure et extérieure

e L’analyse de crissement des freins

e Des bouteilles remplies de fluides

e L’aquaplaning

e L’échauffement de freins

e Lagénération de chaleur dans une matiére plastique au formage

A.4.2.3 Compatibilité avec I'univers NASTRAN

Nastran est compatible avec les principaux systémes de CAO 3D du marché tels que
SolidWorks, Solid Edge, Inventor, Pro/Engineer, CATIA, UG, One Space, et avec des
modeleurs éléments finis tels que FEMAP, Hypermesh, Ideas, PATRAN, ANSA. La
compatibilité est garantie par le format d'entrée standard Nastran Bulk Data File (BDF) et
par les formats standard de sortie FNO (Femap Neutral Output), OP2 (Nastran Output2) et
XDB (Nastran Access Database).

A.4.3 Fonctionnement du couple PATRAN/NASTRAN

PATRAN :

» Utilisation pré-traitement

e importation / création de géométrie

¢ maillage et modélisation, création de liaisons

e propriétés de matériaux, conditions aux limites

NASTRAN :

> Fichier ASCII
> Fichier binaire

PATRAN :
» Utilisation post-traitement

e Visualisation des résultats (déformées, contraintes,efforts dans les liaisons, ...)
e Création de vidéos et de rapports
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i !

Fichier résultat

ascii (.f06)

Etapes du calcul
fichier ascii (.f04)

\ Fichier log

ascii (.log)

Fichier résultat
binaire (.xdb, .op2)

"
W

== [NASTRAN)
Fichier de
données ascii

.bdf ou .dat

[§

|

Résultats au format ascii.
Indique également les erreurs et les
avertissements, il faut toujours le

regarder (chercher les mots « fatal » et «
warning » dans ce fichier).

Reprend les étapes de la résolution
(assemblage des matrices, élimination

des d.d.l bloqués, ...) avec leur temps
d’exécution.

Récapitule la configuration du calcul
(chemins d’accés des fichiers et des
exécutables, configuration machine, ...)

Fichiers résultats au format binaire.
Les .xdb et .op2 sont lisibles par Patran

mais on peut également créer des op2
lisibles par IDEAS, ...

Figure A.27 - Séquence type d’utilisation de Nastran

Importation d'une
gécmeétrie provenant
d’un logiciel CAQ e @
Geometry

Création d'entités

Mailage, modélisation des =iy

géométriques nécessaires Elements
au maillage
liaisons entre piéces
’ Load Ca...
@
Analysis

Properties
Préparation et lancement

Cas de charge pour le
du calcul NASTRAN

Affectation des propriétés
aux différents éléments du
calcul

maillage
-
“ Rasults

Post-traitement des
résultats

LoadsfBCs

Application des conditions
aux limites

£y J
Msterisls

Création des données
matériaux

Figure A.28 - Séquence type d’utilisation de Patran
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B.1 Programme MATLAB pour le calcul des charges aérodynamiques
(pour la station01 dans le cas statique de simulation de I'hélice)

mll=[ -0.0601696173101 0.187141353501 0.00566970910336 76.0375033943
-0.0562230477809 0.187141353501 0.00598522096517 290.769954968
-0.0522764782517 0.187141353501 0.00582071250916 413.036183126
-0.0483299087224 0.187141353501 0.00549911029264 484.705345732
-0.0443833391932 0.187141353501 0.00492852881796 520.46386295

-0.040436769664 0.187141353501 0.00445185190333 552.093641735
-0.0364902001348 0.187141353501 0.00366254649726 567.293317422
-0.0325436306056 0.187141353501 0.00279672959043 574.115325856
-0.0285970610763 0.187141353501 0.00195999765937 578.222690987
-0.0246504915471 0.187141353501 0.00112326572832 582.330056119
-0.020703%9220179 0.187141353501 0.000223584672589 585.804308266
-0.0167573524887 0.187141353501 -0.00107404113131 579.668874049
-0.0128107829595 0.187141353501 -0.00230087058548 573.338968912

-0.00886421343024 0.187141353501 -0.00352770003965 567.009063775
-0.00491764390102 0.187141353501 -0.00488354007871 558.430712587
-0.000971074371794 0.187141353501 -0.00657045185147 544.082315996
0.00297549515743 0.187141353501 -0.00820941649658 527.145237885
0.00692206468665 0.187141353501 -0.0104428703326 501.518425192

0.0108686342159 0.187141353501 -0.0126744268257 476.299845181

0.0148152037451 0.187141353501 -0.0149459997916 451.778702206

0.0187617732743 0.187141353501 -0.0176065378418 430.030359845

0.0227083428035 0.187141353501 -0.0206321046753 397.170007002

0.0266549123328 0.187141353501 -0.0237631106545 362.293899902

0.030601481862 0.187141353501 -0.0272894762522 327.888140214

0.0345480513912 0.187141353501 -0.0308158418498 293.482380527

0.0384946209204 0.187141353501 -0.0340683763232 266.632940692

0.0424411904496 0.187141353501 -0.0379106517565 242.667372806

0.0463877599789 0.187141353501 -0.0417529271897 218.701804921

0.0503343295081 0.187141353501 -0.045416622729 187.970708484

0.0542808990373 0.187141353501 -0.0492014457727 155.940790365

0.0582274685665 0.187141353501 -0.0528714585059 125.878104568

0.0621740380957 0.187141353501 -0.0564507595161 45.1491247638];

ml2=[-0.0612579438599

0.186186703333

-0.00305176695546

20.2165491801

-0.0581666218561 0.186186703333 -0.00682620292403 26.9760494413
-0.0550752998523 0.186186703333 -0.0101796399047 29.2815120924
-0.0519839778486 0.186186703333 -0.0131138548426 30.5559372611
-0.0488926558448 0.186186703333 -0.015958963018 31.4374053865
-0.045801333841 0.186186703333 -0.0188861075139 32.3571066529
-0.0427100118373 0.186186703333 -0.0214248642657 33.0769018124
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-0.0396186898335
-0.0365273678297
-0.033436045826
-0.0303447238222
-0.0272534018184
-0.0241620798147
-0.0210707578109
-0.0179794358071
-0.0148881138034
-0.0117967917996
-0.00870546979583
-0.00561414779206
-0.00252282578829
0.000568496215471
0.00365981821924
0.006751140223
0.00984246222677
.0129337842305
.0160251062343
.0191164282381
.0222077502418
.0252990722456
.0283903942494
.0314817162531
.0345730382569
.0376643602607
.0407556822644
.0438470042682
0.046938326272
0.0500296482757
0.0531209702795
0.0562122922833
0.059303614287
0.0623949362908

[cNeoNoNoNoNoNoloNoNoNo

1

x11=ml11(1:32,1:1);
x12=ml12(1:41,1:1);
yll=m11(1:32,2:2);
y1l2=ml12(1:41,2:2);
z11=m11(1:32,3:3);
z12=m12(1:41,3:3);
pe=mll(1:32,4:4);
pi=ml2(1:41,4:4);

for i=1:32

[cNeoNoNoNoNoNoloNoNoNoBoloNoNoNoloNoNoNoloBoNoNoNeoNoRoloNoNoNolNolNolNo]

.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333
.186186703333

-0

-0

-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.

-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.
-0.

.0241001340439
0.026649368106
.0287306496545
-0.03098462053
0332385914054
0354925622809
0374982348081
0393537187121
0410188121878
0425501130809
0439697154662
0451589318672
0463481482683
0475373646694
0484596370496
0491976404324
0499356438152
0.050673647198
0514116505808
0521707895711
0526386966938
0531066038166
0535745109393
0540424180621
0544938286852
0548929668469
0552921050085
0556912431701
0561161119333
0565160079414
0569149481387
0573368669954
0577598967866
-0.05823380499

33.7870890962
34.4588645733
34.9637551021
35.4717061975
35.9796572928
36.4876083882
37.0901192501
37.7498266309
38.2144813355
38.5420671677
38.852866564
39.129042762
39.4052189599
39.6813951579
39.6551651438
39.4858870339
39.316608924
39.1473308141
38.9780527042
38.8521758851
38.5568484571
38.2615210292
37.9661936012
37.6708661733
37.2475969141
36.7070894577
36.1665820013
35.6260745449
35.0369851039
34.152712693
33.1461282855
31.989997839
28.8749695264
-23.1126856632

re(i)=sqrt ((x11(i)-x11(1))" 2+ (yl1l(i)-y11(1))"2+(z11(i)-z11(1))"2);

end
remax=max (re) ;
ksie=re/remax;

for j=1:41

ri(Jj)=sqrt ((x12(j)-x12(1))"2+(y12(3)-yl2(1))"2+(z12(3)-212(1))"2);

end
rimax=max (ri) ;
ksii=ri/rimax;

corde= (remax+rimax) /2

h=0.1025; %la hauteur de la section trapezoiadal de chaque station h[m]
fl=(trapz(ksie,pe)-trapz(ksii,pi))*h * corde/2% la force de prssion appliquee a la
% surface partielle de la station [N]

ge=pe.*ksie';
gi=pi.*ksii';

ml O=(trapz(ksie,ge)-trapz(ksii,gi))*h* (corde”2)

[N m]
11=(ml 0/f1)

plot (ksie,pe, 'r*',ksii,pi, 'b.")
legend ('pression-extrados', '"pression-intrados')

grid
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B.2 Programme MATLAB pour le calcul des point du profil

function X=g(t,N)

X=(sqrt (4* (£/N)*2+1)-1)/ (sqrt (5)-1);

function [X,Y,Z,T]=tablenacabis (N)

i=1;

X=[0];

Y=[0];

z=[01;

while i/N <= 1

x=g(i,N);

X=[x,X,x];

Y=[-12/20*%(0.2969*sqgrt (x)-0.126*x-0.3516*x"2+0.2843*x"3-0.1015*x"4),Y,
12/20*(0.2969*sqrt (x)-0.126*x-0.3516*x"2+0.2843*x"3-0.1015*x"4)];
Z:[Or Z, O];

i=i+1;

end;

T=[X",Y",2"];
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